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Documentation Updates
The title page of this document contains the following identifying information:

l Software Version number, which indicates the software version.

l Document Release Date, which changes each time the document is updated.

l Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using themost recent edition of a document, go
to:

http://h20230.www2.hp.com/selfsolve/manuals

This site requires that you register for an HP Passport and sign in. To register for an HP Passport
ID, go to:

http://h20229.www2.hp.com/passport-registration.html

Or click theNew users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support
service. Contact your HP sales representative for details.
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Support
Visit the HP Software Support Online web site at:

http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support
that HP Software offers.

HP Software online support provides customer self-solve capabilities. It provides a fast and
efficient way to access interactive technical support tools needed tomanage your business. As a
valued support customer, you can benefit by using the support web site to:

l Search for knowledge documents of interest

l Submit and track support cases and enhancement requests

l Download software patches

l Manage support contracts

l Look up HP support contacts

l Review information about available services

l Enter into discussions with other software customers

l Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract. To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html

To findmore information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp
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Disclaimer for PDF Version of Online Help
This document is a PDF version of the online help. This PDF file is provided so you can easily print
multiple topics from the help information or read the online help in PDF format.

Note: Some topics do not convert properly to PDF, causing format problems. Some elements of
online help are completely removed from the PDF version. Those problem topics can be
successfully printed from within the online help.
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Welcome to the Network Performance Server
The Network Performance Server (NPS) enhances NNMi's network management capabilities by
introducing a foundation for network performancemanagement.

With the infrastructure provided by the NPS, you can use add-in products like the NNM iSPI
Performance for Metrics (NNM iSPI Performance for Metrics) to view context-specific reports
that help you understand performance bottlenecks in the network.

At the core of the foundation provided by the NPS is the column-based databasemanagement
system (DBMS), which enables you to effectively store, access, and track the network
performance data.

Different extension packs introduced by NNM iSPI products add rules and definitions to the NPS
deployment to generate reports. These rules and definitions, enable the business intelligence
component—theBI Server—to generate rich and elaborate reports.

Related Topics:

Launching Reports

Documentation Conventions

Documentation Conventions
The HP Network NodeManager i Software Smart Plug-in documentation uses the following
conventions:

Symbol Meaning

%nnminstalldir% Windows only. The environment variable for the NNMi application directory.
This variable is automatically created by the NNMi installer. If you install the
NNM iSPI on an NNMi (Windows) management server, all application files
of the iSPI are placed here.

%nnmdatadir% Windows only. The environment variable for the NNMi data directory. This
variable is automatically created by the NNMi installer. If you install the
NNM iSPI on an NNMi (Windows) management server, all the data and
configuration files of the iSPI are placed here.

%NPSInstallDir% Windows only. The NNM iSPI application directory. When you install the
iSPI on the NNMi management server, the iSPI installer uses
%nnminstalldir% as the application directory for the iSPI.

%NPSDataDir% Windows only. The NNM iSPI data directory. This directory contains all the
configuration and data files used by the NNM iSPI. When you install the
iSPI on the NNMi management server, the iSPI installer uses
%nnmdatadir% as the data directory for the iSPI.

On Linux, the NNM iSPI installer directly installs the necessary files into the following directories:

l Application files: /opt/OV

l Data and configuration files: /var/opt/OV
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Administration Overview
The NNMi administrator is also an administrator for the NNM iSPI Performance. The NNM iSPI
Performance accommodates one administrator at a time. This restriction avoids conflicts and
satisfies OEM licensing requirements. Since administrator permissions are broad, and potentially
hazardous in the wrong hands, anyone with administrator access to the HP NNM iSPI Performance
for Metrics BI Server Portal must be familiar with BI Server tutorials and BI Server documentation.

To run a report, or to access the ad hoc query features available from the HP NNM iSPI
Performance for Metrics BI Server Portal, youmust be logged on to NNMi. When you launch NNMi,
use the Fully-Qualified Domain Name (FQDN). This way of launching NNMi enables a security
function known as Single Sign-On (SSO). When SSO is enabled, you need not log on a second time
when youmove from NNMi to a report.

Overview of NPS Operations
This section contains background information, procedures for maintaining the NPS, and information
about tasks that may be necessary from time to time.

BI Server Documentation
To access the BI Server documentation, on the HP NNM iSPI Performance for Metrics BI Server
Portal click Help.

Information About Commands
On the NNMi console, click Help > NNMi Documentation Library :> Reference Pages to open
a list of command links. OnWindows, many of the commands listed on this page are Start menu
options. Click the link to open a reference page. The reference page provides the following
information about each command:

l Name

l Synopsis

l Description

l Author

Location of Program and Runtime Files
Network Performance Server (NPS) consists of static application software files and dynamic
runtime files.

The default path for static application software is:

l Windows: C:\Program Files(x86)\HP\HP BTO Software

l Linux: /opt/OV

The NNMPerformanceSPI directory contains the following folders:

l bin

l config

l Docs
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l extensionpacks

l Installation

l java

l L10N

l lib

The default path for the dynamic runtime files is:

l Windows: C:\ProgramData\HP\HP BTO Software

l Linux:/var/opt/OV

The performance of NPS depends on the I/O performance of the disk subsystem where this
directory resides. We strongly recommend that this data location is hosted on a high-performance
file system, such as a local multi-disk RAID0/5 array.

The NNMPerformanceSPI directory contains the following folders:

l contentstore

l database

l nnmappfailover

l L10N

l logs

l PerfSPI_Diagnostics

l rconfig

l Component_Health: Only if NNM iSPI Performance for Metrics is installed.

l Interface_ Health: Only if NNM iSPI Performance for Metrics is installed.

The above folders are placed by the default NPS installation. Additional folders may be present if
additional extensionPacks (for example, Metrics customPoll, or Traffic extensionPacks) are
present.

Tables and Data Dimensions
NPS uses the following kinds of data tables to store data:

l Aggregate

l Live

l Archive tables

The BI Server automatically picks the appropriate table based on the selected granularity of the
data and its time span.

l If you are looking for data with one hour grain and above, it picks the aggregate table

l If you are looking for data less than one hour grain and within last two days it picks the live table
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l If you are looking for data less than one hour grain andmore than two days ago it picks the
archive table

The retention period for data in the aggregate table and the live table is not configurable; the
retention period for archive data table is configurable. The default retention period for archive data is
14 days. To adjust the default, use the Configuration Utility.

Increasing the retention of detail data enables longer online access to the fine-grained data, which is
useful for forensic network analysis. However, this approach requires more disk space and
computing resource when querying.

Each table is partitioned. Each partition is stored inmultiple files, and the file format is proprietary. A
measure, sometimes referred to as a fact, is a numeric value stored in a table. Every measure is
defined in terms of multiple dimensions. For example, bytesIn is a measure. Without context, for
example, without an interface and a time period, this measure has nomeaning. Each table is
defined by multiple dimensions.

Data Retention Defaults
Data retention varies from table to table. Retention per-table is as follows:

l The live table retains data for 1 day

l The aggregate table retains data for 70 days

l The detail archive table retains data for 14 days

If you want to modify the default detail archive retention, use the Configuration Utility.

Single Sign-On Security (SSO)
Network Performance Server (NPS) enables you to use a security function known as Single Sign-
on (SSO). SSO allows NPS to recognize the same usernames and passwords that the NNMi
Console recognizes. When SSO is enabled, a user who is already logged in to NNMi canmove
from NNMi to a report without having to log in again.

For SSO to operate, the following conditions must bemet:

l The NNM system and the NPS systemmust be configured with fully qualified domain names.

l The user must use the fully-qualified domain (not "localhost" or themachine namewithout the
domain) when launching the NNMi console.

 A fully-qualified domain name (FQDN) has the following format:

http://<fully-qualified-hostname>/nnm

If the user launches NNMi using an unqualified host name, the SSO servlet will open a login
window and force the user to log in again.

Note: If the address, or the domain, of the NNMi management server or the NPS system changes
after you install NPS, you should re-run the enablement script on NNMi. Rerunning the enablement
script configures NNMi with updated location information.

Direct Access to the NPS

You can access NPS directly, without going through NNMi, by pointing your browser at:
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http://<fully-Qualified-serverName>:9300/PerfSpi/login

When the login window opens, enter the same username and password you use to launch NNMi.
After you are authenticated, the NPS Home Page opens.

Monitoring the NPS Processes
NPS includes reports that enable you tomonitor NPS processes.

To view the available reports:

1. Log in to NPS.

2. In the NPS HomePage, click theReports tab.

3. Select Self Monitoring > Self diagnostics > DiagnosticMetrics.

See Self Diagnostics for details

Scheduling Reports
To schedule a report:

1. Log in to the HP NNM iSPI Performance for Metrics BI Server Portal.

2. Open the report folder that contains the report you want to schedule.

3. Under the Actions column, click the Schedule icon.

The Schedule form opens.

4. In the Frequency field, select one of the following options:

a. By Day

b. By Week

c. By Month

d. By Year

e. By Trigger

5. Select a start date and time.

6. Select an end date and time.

7. Click OK.

For more information about each of these actions, see IBM Cognos 8 Administration and Security
Guide.

Tip: To open the IBM Cognos 8 Administration and Security Guide, click Help in the Schedule
form.

Setting Thresholds for Metrics in NNMi
Until you set the thresholds for the extension pack metrics, the reports in that extension pack do not
track exception counts.

NNMi does not set thresholds for performancemetrics for you, automatically. Youmust set the
thresholds for the NNM iSPI Performance for Metrics metrics manually using the Thresholds
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Settings form.in NNMi console. The following list shows some of themetrics for which you can set
the thresholds:

l Discard rate in

l Discard rate out

l Error rate in

l Error rate out

l Utilization in

l Utilization out

l CPU 5 second utilization

l CPU 1minute utilization

l CPU 5minute utilization

l Memory utilization

l Buffer utilization

l Buffer miss rate

l Buffer failure rate

For information about how to set thresholds using the NNMi console see Configure Threshold
Monitoring for Interfaces (HP Network NodeManager iSPI Performance for Metrics Software) in
theHP Network NodeManager i Software Online Help: Help for Administrators.

Although youmay want to see exception counts as soon as possible, setting thresholds right away
may not be feasible. This is because youmay not be ready to set thresholds until you are better
acquainted with the way your network behaves. You need to know what is normal for your network,
and if you set thresholds prematurely, problems may arise. For example, if the thresholds are
wrong, NNMi may detect toomany exceptions, and if you configure NNMi to generate incidents in
response to threshold conditions, NNMi may generate toomany incidents.

Support for Application Failover
Application Failover for NNMi ensures redundancy. Failover allows a secondary NNMi server to
take over immediately following the failure of a primary NNMi server. Failover relies on jboss
clustering technology, ongoing file system synchronization, and a Java keystore file that must be
copied from NNM to the NPS. Copying the keystore file is amanual step.

The NPS supports NNMi Application Failover. From the perspective of anyone using the NPS,
Application Failover is a transparent event, for users as well as for the administrator. Aside from a
minor interruption in service lasting about 15minutes while failover is in progress, users won't be
aware that a failover took place, and the administrator won't be required to perform any special
tasks related to failover.

The ability of the NPS to support application failover depends on files it retrieves from the primary
server in the cluster. The NPS retrieves these files during startup. As soon as the NPS has the
files, it begins monitoring the status of the primary server by checking for status changes every 5
minutes. If the NPS detects a status change, the following events take place automatically:

HP Network NodeManager iSPI Performance for Metrics Software (9.10)Page 17 of 89

Online Help
Administration Overview



l The NPS determines which server is the new primary server

l The NPS redirects data collection to a shared directory on the new primary server

l The NPS begins collecting data (metrics and topology files) from the new primary server in the
cluster

Immediately after these events take place, NPS users will be able to link from the NPS to NNMi
views on the new primary server, just as they were able to do before failover.

Messages Related to Failover
The following table provides a list of INFO, WARN, and ERROR messages that pertain to
Application Failover.

Condition Message Comments

Failover not
enabled

DEBUG: NNM
Application Failover is
not enabled.\n

Logged every 5minutes if the DEBUG logging is enabled

Failover
enabled

INFO: NNM
Application Failover is
enabled. Checking if
active node has
changed.\n

Logged every 5minutes

Failover
enabled

INFO: NNM
Hostname currently
used by NPS is:
$nnm_current\n

Logged every 5minutes. Displays current NNM hostname
being used by the NPS.

Failover
enabled

INFO:
$getNNMActiveScript
reports active nnm
node is: $nnm_
active\n

Logged every 5minutes. Displays NNM hostname reported
as the active node in the cluster.

Failover
enabled but
the active
host has not
changed.

INFO: Active NNM
host is unchanged.\n

Logged every 5minutes.

Failover
enabled

INFO: Changing NPS
configuration to use
$nnm_active\n

A configuration update is imminent. This message is logged
only when the active node is different from the node
currently used by the NPS.

Failover
enabled and
config files
successfully
updated

INFO: Configuration
updated. Path to
NNM is now
$newpath\n

Logged after the configuration file is successfully updated in
response to an application failover.
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Condition Message Comments

Failover
enabled but
the NNM
hostname is
not in the
path syntax

WARN: NNM
Application Failover is
not supported on
same-system
NNM/NPS
installations\n

If the NPS is running on the samemachine as NNN, the
path does not contain the hostname.

Failover
enabled but
the NNM
hostname is
not in the
path syntax

WARN: Cannot
extract remote nnm
hostname from value
of PRSPI_NNMDIR
($cfg{PRSPI_
NNMDIR})..\n

The user may have specified the path in a non-conventional
way (for example, by using a hardmount or drivemapping).
If the path does not contain the remote NNM hostname, the
NPS will not be able to detect application failover.

Failover
enabled but
the NNM
hostname is
not in the
path syntax

WARN: Expected
PRSPI_NNMDIR of
form
/net/hostname/var...
or
//hostname/PerfSpi\n

The user may have specified the path in a non-conventional
way (for example, by using a hardmount or drivemapping).
If the path does not contain the remote NNM hostname, the
NPS will not be able to detect application failover.

Failover
enabled but
the nnm_
details.xml
file is not
available.

ERROR: nnm_
details.xml not found
in $newpath

This message is logged is there is no copy of nnm_
details.xml on the remote NNMmachine. This condition will
occur if the nnmenableperfspi script was not run on that
machine, since running the script is what creates the nnm_
details.xml file. This condition could also occur if the
machine configurations are not identical. For example, if the
pathnames to the shared drive are not identical, the new
path will be incorrect when the NPS substitutes the new
hostname into the path. The configurationsmust be
identical.

Failover
enabled but
there is a file
permissions
error

ERROR: Unable to
modify timestamp of
$newpath/nnm_
details.xml: $!.

The NPS configuration will not change; a file permissions
error is preventing the nnm_detail.xml file from being
modified on the NNM server.

Failover
enabled but
unable to
update the
config file.

ERROR: Unable to
write changes to
config file. Will try
again next time.\n

Failure to update the config file could be caused by another
process that is locking the config file.

Prerequisites for Successful Application Failover

Application Failover support will not succeed unless the following prerequisites aremet:

1. Every installation of NNMi is set up and configured the sameway.

2. You ran the NPS enablement script on every server in the cluster.
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3. You responded to enablement script prompts exactly the sameway each time you ran the
enablement script.

4. On each server, you established the same path to the datafiles folder.

5. You copied a certificate (a java keystore file) from NNM to the NPS.

Copying the Keystore File from NNMi to the NPS

To copy the shared certificate file—cluster.keystore—from NNMi to the NPS:

1. Navigate to the cluster.keystore file on NNMi:

n Windows: NnmDataDir%\shared\nnm\conf\nnmcluster\cluster.keystore

n Linux: /var/opt/OV/shared/nnm/conf/nnmcluster/cluster.keystore

2. Copy cluster.keystore to the following directory:

n Windows: %NnmDataDir%\NNMPerformanceSPI\nnmappfailover\keystore

n Linux: /var/opt/OV/NNMPerformanceSPI/nnmappfailover/keystore

The keystore is used to enable access to the NNMi cluster. We recommend using a secure copy
mechanism, for example, SCP or USB key.

Backup and Restore
The NPS provides you with command-line tools to back up and restore all the NPS data.

To Back Up the NPS Data:

1. Log on to the NPS system with the same account that was used to install the NPS.

2. Run the following command:
OnWindows: %NPSInstallDir%\NNMPerformanceSPI\bin\backup.ovpl -b <dir>

[-c] [-d] [-f] [-v]

On Linux: %NPSInstallDir%/NNMPerformanceSPI/bin/backup.ovpl -b <dir> [-

c] [-d] [-f] [-v]

In this instance, <dir> is the location where you want to place the backed-up data. Do not use
%NPSInstallDir% or%NPSDataDir% with this option.

Options

l Use the -c option to back up contentstore.

l Use the -d option to backup the database.

l Use the -f option to backup all NPS files.

l Use the -v option for verbose output.

Youmust specify a valid directory location as an argument of the -b option. If you do not specify
any other options, the backup script by default backs up contentstore and the database.

The duration of the backup process depends on the size of the database you want to back up.
Before you start the backup process, verify the disk space used by the data that you want to back

HP Network NodeManager iSPI Performance for Metrics Software (9.10)Page 20 of 89

Online Help
Administration Overview



up, and thenmake sure the system has as much available free disk space. Although the script
produces compressed output, the backup process requires sufficient temporary disk space.

To Restore the NPS Data:

1. Log on to the NPS system with the same account that was used to install the NPS.

2. Run the following command:
OnWindows: %NPSInstallDir%\NNMPerformanceSPI\bin\restore.ovpl -b

<file> [-v]

On Linux: %NPSInstallDir%/NNMPerformanceSPI/bin/restore.ovpl -b <file>

[-v]

In this instance, <file> is the backup file that you want to restore. You can use the -v option for
verbose output. The restore operation overwrites all the preceding NPS data.

Note: If you change the password of the database after a backup operation, you have to change it
again after restoring the backed-up database.

Configuring the Network Performance Server (NPS)
If you install NPS on the NNMi management server, NPS configuration takes place automatically
during the installation.

If you install NPS on a dedicated server, youmust use the Configuration Utility to specify
configuration details. During installation, the Configuration Utility opens and asks you necessary
configuration details. After installation, you can anytime launch the utility to change the
configuration data.

Launching the Configuration Utility

Windows

Select Start > All Programs > HP > NNM iSPI Performance > Configuration Utility

Linux

1. Navigate to the following directory:
/opt/OV/NNMPerformanceSPI/bin

2. Type the following command:
./runConfigurationGUI.ovpl

Using the Configuration Utility

Specify the following configuration details:

User Account Details

Not required when you install the NPS on an Linux system and NNMi is installed on a UNIX or
Linux system.

The Configuration Utility enables you to specify the details of the system user account that enables
the NPS to run necessary services.
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l If you install the NPS on the NNMi management server (Windows), youmust set this to the
Local System account.

l If you install the NPS on a dedicatedWindows system, youmust select the NamedUser
account option.

Make sure you specify exactly the same account information that was used with the enablement
script on the NNMi management server.

Path to the NNM iSPI Performance for Metrics datafiles folder

Specify the location of the NPS data files on the NNMi management server.

l If you install the NPS on the NNMi management server, a local path is displayed in this field,
which youmust not change.

l If you install the NPS on a dedicated server, the enablement script creates a shared space on
the NNMi server.

In this field, youmust specify the location of shared space in the correct format.

Hourly Data Retention Period (days)

Specify the aggregate table retention period.

l The default retention period is 70 days

l Themaximum retention period is 400 days

.

Detailed Data Retention Period (days)

Specify the archive table retention period.

l The default retention period is 14 days

l Themaximum retention period is 400 days

Use the Stop and Start buttons to stop and start necessary NPS processes.

Tomake any of these changes to configuration parameters:

1. Click Stop.

2. Make your change.

3. Click Apply.

4. Click Start.

5. Click Exit.

Master Configuration File: NNMPerformanceSPI.cfg

Themaster runtime configuration file, NNMPerformanceSPI.cfg, controls the operation of the NNM
iSPI Performance for Metrics. The path to this file is:
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Windows

%NnmDataDir%\NNMPerformanceSPI\rconfig

Linux

/var/opt/OV/NNMPerformanceSPI/rconfig

Configuration Item Setting

The following table indicates the default setting for each parameter in the file.

Configuration Item Setting

Log level DEBUG

Location of NNM staging area C:\ProgramData\HP\HP BTO
Software\shared\perfSpi\datafiles

Location of PRSPI_INSTALLDIR C:\Program Files\HP\HP BTO
Software\NNMPerformanceSPI

Location of PRSPI_DATADIR C:\ProgramData\HP\HP BTO
Software\NNMPerformanceSPI

Location of PRSPI_BIN C:\Program Files\HP\HP BTO
Software\NNMPerformanceSPI\bin

Location of PRSPI_JAVA C:\Program Files\HP\HP BTO
Software\NNMPerformanceSPI\java

Location of PRSPI_SAMPLES C:\Program Files\HP\HP BTO
Software\NNMPerformanceSPI\samples

Location of PRSPI_LIB C:\Program Files\HP\HP BTO
Software\NNMPerformanceSPI\lib

Location of PRSPI_CONFIG C:\Program Files\HP\HP BTO
Software\NNMPerformanceSPI\config

Location of PRSPI_LOGS C:\ProgramData\HP\HP BTO
Software\NNMPerformanceSPI\logs

Place hourly data in the delivery area for
consumption by the HP PI Datapipe.

True

PRSPI_HTTP_PORT 9300

Check poller records and suppress if
invalid.

Enabled

Number of copies of deployed cubes to
keep before deleting.

3

Retention period for old datasource fact
files.

96 hours
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Configuration Item Setting

Retention period for archived logfiles. 336 hours (2 weeks)

Retention period for archived NNM files. 336 hours (2 weeks)

Retention period for archived topology files. 96 hours

Retention period for near real time data 6 hours

Retention period for summary data 70 days

Retention period for HP PI Datapipe data 5 days

Buffer for late arriving facts (hours after
midnight).

2 hours

Number of NNMmetrics files to process in
one batch.

12

Location of cognostr_bin_dir C:\Program Files\HP\HP BTO
Software\nonOV\cognos\cer5\bin

Location of cognosbi_bin_dir C:\Program Files\HP\HP BTO
Software\nonOV\cognos\c8\bin

Location of cognos_dispatcher_host localhost

Location of cognos_dispatcher_port 9300

Location of cognos_dispatcher_dir \p2pd\servlet\dispatch

Location of perl_dir C:\Program Files\HP\HP BTO
Software\nonOV\perl\a\bin

Location of java_dir C:\Program Files\HP\HP BTO
Software\nonOV\cognos\c8\bin\jre\1.4.2\bin

Location of test data PRSPI_TESTBIN C:\Program Files\HP\HP BTO
Software\NNMPerformanceSPI\TESTBIN

Location of test data PRSPI_TESTDATA C:\Program Files\HP/HP BTO
Software\NNMPerformanceSPI\TESTDATA

Location of PRSPI_TESTSTAGING C:\Program Files\HP\HP BTO
Software\NNMPerformanceSPI\TESTSTAGING

Location of PRSPI_TESTDATA_
BASEFILES

C:\Program Files\HP\HP BTO
Software\NNMPerformanceSPI\TESTDATA_
BASEFILES

PerfSPI Extension Packs InterfaceHealth

ComponentHealth

PerfSPIDiagnostics
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Note:

l The behavior of the InterfaceHealth extension pack is controlled by: InterfaceHealth.cfg

l The behavior of the ComponentHealth extension pack is controlled by: ComponentHealth.cfg
file

Checking the Validity of NNM iSPI Performance for Metrics
Configurations

You can verify proper configuration of the NPS by launching the Configuration Checker. The
Configuration Checker verifies the validity of the configuration file entries and displays the following
message if all the entries are valid:

INFO: Configuration File Validated OK

Launching the Configuration Checker
Windows

Select Start > All Programs > HP > NNM iSPI Performance > Configuration Checker

Linux

1. Navigate to the following directory:

/opt/OV/NNMPerformanceSPI/bin

2. Type the following command:

./checkConfig.ovpl

Collecting Diagnostics for Support
If you want to collect diagnostic data for Support, run the Diagnostics Collector utility. Support will
use the data you supply to diagnose the problem.

Launching the Diagnostics Collector

Windows

Start > All Programs > HP > NNM iSPI Performance > Diagnostics Collector

Linux

1. Navigate to the following directory:
/opt/OV/NNMPerformanceSPI/bin

2. Type the following command:
./collectDiagnostics.ovpl

After collecting data, the Diagnostics Collector saves the output in the form of a compressed
tar.gz file in the following location:

Windows:

%NPSDataDir%\HPNNMPerformanceSPI\collectDiag

Linux:
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/var/opt/OV/HPNNMPerformanceSPI/collectDiag

Forward the tar.gz file from the collectDiag folder to Support.

Resetting the NPS
The reset utility enables you to do the following:

l Delete all data from database and keep all archived data.

l Delete all data from database and restore archived data for re-processing.

l Delete all data from database and delete all archivedmetrics/topology.

l Delete all data from database, delete all archived data and log files, and then restart all services.

Launching the NPS Reset Utility

Windows

Select Start > All Programs > HP > NNM iSPI Performance > Reset Utility

Linux

1. Navigate to the following directory:

/opt/OV/NNMPerformanceSPI/bin

2. Type the following command:

./resetSPI.ovpl

The Reset Utility window opens displaying the following options. Select an option.
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Retrieving Last Logon Information for a User
Network Performance Server (NPS) enable you to find out the user logon information by using the
following log file:

Windows

%NPSDataDir%\NNMPerformanceSPI\logs\perfspiAudit.log

Linux

/var/opt/OV/NNMPerformanceSPI/logs/perfspiAudit.log

Whenever a user logs in to NPS, the following information gets recorded in this log file:

l User name

l Logon date

l Logon time

Analyzing Log Files
Use the Log File Analyzer to view:

l A daily summary of errors, warnings, and other notifications produced by each process within
each extension pack

l Timing data for selected processes belonging to each extension pack

l Timing data for generating reports for different extension packs

The Log File Analyzer tool analyzes the prspi.log and PerfSPI_Diagnostic_
Metrics.log files.

Launching the Log File Analyzer

Windows

Select Start > All Programs > HP > NNM iSPI Performance > Log File Analyzer

Linux

1. Go to the following directory:
/opt/OV/NNMPerformanceSPI/bin

2. Type the following command:
./log_analyzer.ovpl

Warnings, Errors, and Other Notifications in NNM iSPI Performance for
Metrics Log Files

The summary data for warnings, errors, and other notifications covers the previous two weeks. The
last summary covers today. Today's summary will be incomplete until midnight. Summary data
indicates:

l Date

l Number of errors per process, if any
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l Number of warnings per process, if any

l Number of processes with fatal errors, if any

For example:

prspi.20080729.log:

WARN - 240 in ETL.Component_Health

WARN - 268 in ETL.Interface_Health

WARN - 285 in MainServiceLoop

ERROR - 2 in MainServiceLoop

prspi.20090915.log:

WARN - 27 in ETL.Interface_Health

WARN - 714 in MainServiceLoop

FATAL - 1 in Utility.startBI

FATAL - 152 in ETL.Interface_Health

FATAL - 1 in Utility.installExtensionPack

A warning normally indicates a transient condition, usually a temporary mismatch, that will self-
correct. If you see a warningmessage or a fatal error message, youmay want to examine it in more
detail by viewing the associated logfile in a text editor.

The last log in the list of logs is today's partially complete log. Today's partially complete log does
not have a date attached to it. The file name for today's log is just this: prspi.log

Viewing Timing Data

Under the summary of all warnings and errors, if you press Enter, you can continue to see the
timing data.

The timing data shows:

l Total number of times a process executed over the previous two weeks

l Average execution time per process over the previous two weeks and standard deviation

l Maximum execution time per process over the previous two weeks

l Average number of records processed per execution

l Average number of records processed per second

Monitoring Log Files
The log file viewer is Chainsaw 2.0. With Chainsaw, you canmonitor DEBUG, INFO, WARN,
ERROR, and FATALmessages as they reach the prspi.log file. The perfspi.log file
contains every message generated since the last night at midnight. The path to prspi.log is:

Windows

%NPSDataDir%\NNMPerformanceSPI\logs

Linux

/var/opt/OV/NNMPerformanceSPI/logs

Launching the Log File Monitor

Follow these steps to launch the log file monitor:
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Windows

To open the log file monitor, select Start > All Programs > HP > NNM iSPI Performance > Log
File Monitor

Linux

1. Navigate to the following directory:

/opt/OV/NNMPerformanceSPI/bin

2. Type the following command:

./runChainsaw.ovpl

Using the ChainsawMessage Interface for NNM iSPI Performance for Metrics

The welcome page includes several tabs. To open themessage interface, click this tab:

NNMPerformanceSPI/logs/prspi.log

The Chainsaw message interface opens, showing the following panes:

l Event pane

l Detail event pane

l Tree logger pane

The event pane changes constantly, displaying themost recent message, as it arrives in prspi.log.
This pane also displays additional information about that message in the detail event pane. The
detail event pane indicates the following:

l Level

l Logger

l Time

l Thread

l Message

l NDC [null]

l Class [not used]

l Method [not used]

l Line

l File

l Properties

l Throwable [not used]

If you select an older message in the event pane, the detail event pane will refresh with additional
information about themessage you just selected. The logger tree pane shows the following folder:

Root Logger
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The ETL folder, which belongs under the Root Logger folder, contains three loggers folders; one for
each standard extension pack. If additional extension packs are installed (such as custom poll
packages), additional loggers appears (one additional logger for each new package).

New messages generated by the loggers appear once in every few seconds in the event pane. If
you want to seemessages for one logger only, type that logger name in the Refine focus on

field. For example:

Refine focus on: Interface_Health

Youmay expand the event pane by closing the logger tree pane and the detail event pane.
Following is a partial list of Chainsaw version 2.0 features:

l Fully customize each tab the way you want it

l Control the frequency of updates

l Specify your own rules for color-coding events (the defaults are yellow forWARN, red for
ERROR)

l Apply simple filters, or advanced expression-based filters

l Savememory by setting a cyclic-based view that looks at X events only

For more information about Chainsaw, run the tutorial under the Helpmenu or visit:

http://logging.apache.org/chainsaw/quicktour.html

Enabling Demo Data
The demo database is part of NPS. The NPS installation places the demo database on the system.
If you want to view reports using the demo data, youmust enable the demo database.

Enabling the demo database does not disrupt any the ongoing data collection process of the NPS.
When you disable the demo database, NPS begins building reports using the real network data.

Launching Demo Data Enable Utility

Windows

Select Start > All Programs > HP > NNM iSPI Performance > Demo Data Enable.

To disable the demo database, select Start > All Programs > HP > NNM iSPI Performance >
Demo Data Disable.

Linux

To enable the demo database:

1. Navigate to the following directory:

/opt/OV/NNMPerformanceSPI/bin

2. Run the following command:

./demoData.ovpl enable

To disable the demo database:
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1. Navigate to the following directory:

/opt/OV/NNMPerformanceSPI/bin

2. Run the following command:

./demoData.ovpl disable

HP NNM iSPI Performance for Metrics BI Server Portal
Use the HP NNM iSPI Performance for Metrics BI Server Portal to perform the following tasks:

l OpenPublic Folders and access reports from BI Server Connection.

l OpenMy Reports and view reports with various filter preferences that you saved.

l Set up the following preferences:
n Set up the display parameters for the reports.

n Select the report format

n Set up a schedule for running summary reports.

n Set up email report delivery.

n Modify BI Server tuning parameters for largemulti-user installations.

n Select language and time zone for your reports

l Create custom reports using Query Studio.

Launching the HP NNM iSPI Performance for Metrics BI Server
Portal

To launch BI Portal:

1. Log on to Network Performance Server (NPS). Youmust have administrator privileges to
access the HP NNM iSPI Performance for Metrics BI Server Portal.

2. On the navigation panel on NPS Home Page, click BI Server.

The BI Server LogOn page opens.

3. Log in using the ErsAdmin username and password. The default password is
rooDkcaBnimdAsrE.

We recommend you to change this password after you log in to BI Portal for the first time. For
information about how to change this password, see IBM Cognos 8 Administration and
Security Guide.

Optionally you can start the HP NNM iSPI Performance for Metrics BI Server Portal using the
followingmethod:

Web Access: 1

1Point your browser at:
http://<localhost>:9300/p2pd/NPS

When the login page opens, type your ErsAdmin username and password
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Logging in to the HP NNM iSPI Performance for Metrics BI Server
Portal as ErsAdmin

If you are unable to launch NNMi, you can still reach the HP NNM iSPI Performance for Metrics BI
Server Portal by pointing your browser at this address:

http://<localhost>:9300/p2pd

When the login page opens, type your ErsAdmin username and password. The default password for
the this user account is rooDkcaBnimdAsrE.

We recommend changing this password once you log on to BI portal for the first time using the
ErsAdmin username. Restart BI portal with the new password after you change the default
password. For information about how to change passwords in BI Portal, see IBM Cognos 8
Administration and Security Guide.

If you face problem launching NNMi, you need to contact support.

If you can open the HP NNM iSPI Performance for Metrics BI Server Portal, you can confirm that
BI Server is running.

Change Report Format Using HP NNM iSPI Performance for Metrics
BI Server Portal

The default report format used by the Network Performance Server (NPS) and BI Server is the web-
based HTML format.

You can set the HP NNM iSPI Performance for Metrics BI Server Portal Preferences and enable
NPS to generate reports in any of the following formats:

l Adobe PDF

l Microsoft Excel 2007

l Microsoft Excel 2002

l Microsoft Excel 2000 Single Sheet

l CommaSeparated Value (CSV) Files1

l
XML

To change the format of the reports generated by NPS:

1. Log in to NPS Home Page. Youmust have administrator privileges to perform this task.

2. On the navigation panel, click theBI Server tab.

3. Select theBI Portal link.

4. In the HP NNM iSPI Performance BI Portal form, click My Area.

5. SelectMy Preferences.

1Displayed as Delimited Text (CSV) in NNM iSPI Performance for Metrics BI Server Portal
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6. In the General tab, select a Report Format. The default format is HTML.

7. Click OK.

The new report format becomes the default report format for your user account. BI Portal applies the
new report format to all the reports generated from your user account.

Schedule Report Delivery
From the HP NNM iSPI Performance for Metrics BI Server Portal, you can schedule the generation
and delivery of reports. You can create schedules to email or print a report, or you can save the
report on the NPS system once in every interval. You canmodify the default settings of reports
when you create schedules.

NNM iSPI Performance for Metrics enables only the administrators and level2 users to schedule
the reports. Only those NNMi users, who are part of administrators or level2 user groups can
schedule the reports using HP NNM iSPI Performance for Metrics BI Server.

Users who belong to level1 user group can not schedule reports. NPS does not allow the level1
users to schedule reports using HP NNM iSPI Performance for Metrics BI Server.

Follow these steps to allow the level1 users to schedule reports:

1. Log in to HP NNM iSPI Performance for Metrics BI Server using the BI administrator or
ErsAdmin privileges.

2. On the HP NNM iSPI Performance for Metrics BI Server page, click onSecurity and then
select Capabilities.

3. Select Scheduling.

4. Use the Permissions tab to change the user group permissions.

Use one of the following procedures to create a schedule:

Use the Report Templates suitable for scheduling

1. Log in to NPS Home Page.

2. On the navigation panel, click theBI Server tab.

3. Select theBI Portal link.

4. On the HP NNM iSPI Performance for Metrics BI Server Portal, select an extension pack. The
list of reports provided by the extension pack appears.

5. Select theReport Templates suitable for scheduling link.

The Report Templates suitable for scheduling form opens displaying the list of report templates
that you can use to create scheduled reports.

6. Select a report template.

7. Select the TimeControls for your report.

8. Select eitherConfirm Selection orNext.

9. Select the required Topology Filter for your report.
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10. Select eitherConfirm Selection orNext.

11. Select the required Report Options.

12. Select eitherConfirm Selection or Finish.

Use the Schedule icon on BI Portal
1. Log in to NPS Home Page.

2. On the navigation panel, click theBI Server tab.

3. Select theBI Portal link.

4. On the HP NNM iSPI Performance for Metrics BI Server Portal, select an extension pack. The
list of reports provided by the extension pack appears.

5. Select a report, and then click Copyon the toolbar.

6. Select Scheduled folder, and then click Paste on the toolbar.

Copy the reports in My Folders, if you want the scheduled output to be restricted only to your
account. If you want the scheduled output to be available to all users, create a new folder (for
example, Public Scheduled Reports) under Public Folders, and then copy the reports there
before scheduling. Youmust have administrative privileges to create andmodify the Public
Folder content.

Follow these steps to create a folder in HP NNM iSPI PerformanceBI Portal.

7. Under Actions column click Set properties .

8. Specify a name for the report, and then click OK.

9. Click Schedule to open the schedule page.

10. On the Schedule page, make the following selections:
n Frequency:Select a frequency of your choice. The report generation will be scheduled with

the frequency specified in this section.

n Start:Specify the start time and date of the schedule.

n End:Specify the end start and date of the schedule.

11. In the Options section, select theOverride the default values option, and then specify the
following details:
n Formats:You can choose one or more formats from the HTML, PDF, andMicrosoft Excel

formats. The CSV and XML formats are not supported.

n Delivery:You can print the report, email the report, or save the report on the NPS system. If
you select email as the delivery mechanism, youmust configure the BI Server with an email
server.

12. In the Prompt values section, select theOverride the default values option, and then click
Set.

13. Click OK.

HP Network NodeManager iSPI Performance for Metrics Software (9.10)Page 34 of 89

Online Help
Administration Overview

../../../../../Content/Report_Controls/PerfiSPI_CreateFolderBI.htm
../../../../../Content/Report_Controls/PerfiSPI_CreateFolderBI.htm
../../../../../Content/Report_Controls/PerfiSPI_CreateFolderBI.htm
../../../../../Content/Report_Controls/PerfiSPI_CreateFolderBI.htm
../../../../../Content/Report_Controls/PerfiSPI_CreateFolderBI.htm
../../../../../Content/Report_Controls/PerfiSPI_CreateFolderBI.htm
../../../../../Content/Report_Controls/PerfiSPI_CreateFolderBI.htm
../../../../../Content/Report_Controls/PerfiSPI_CreateFolderBI.htm
../../../../../Content/Report_Controls/PerfiSPI_CreateFolderBI.htm
../../../../../Content/Report_Controls/PerfiSPI_CreateFolderBI.htm
../../../../../Content/Report_Controls/PerfiSPI_CreateFolderBI.htm
../../../../../Content/Report_Controls/PerfiSPI_CreateFolderBI.htm
../../../../../Content/Report_Controls/PerfiSPI_CreateFolderBI.htm


If you want to use the NPS to email reports, youmust configure the BI Server to use an SMTP
email server.

To configure the BI Server to send emails:

1. Launch the BI Server Configuration GUI.

OnWindows:
%NPSInstallDir%\NNMPerformanceSPI\bin\runBIConfigGUI.ovpl

On Linux:
/opt/OV/NNMPerformanceSPI/bin/runBIConfigGUI.ovpl

2. In the Explorer pane, select Notification.

3. Specify appropriate values for the following fields:
n SMTP Mail server

n Account and password

n Default Sender

4. To test the connection, right-click Notification in the left pane, and then click Test.

5. Click File > Save.

6. Select Yeswhen prompted to restart the service NNM iSPI Performance BIServer.

Setting the Same Schedule for Multiple Reports
You can set the same schedule for multiple reports by creating a job. A job identifies a collection of
reports, report views, or queries that are scheduled together and share the same settings.

To set the same schedule for multiple reports:

1. Click the New Job icon on the toolbar.

The New Job wizard opens.

2. Specify a name and location for the job.

3. In the Select the steps - New Job wizard form, click Add... to add the job steps.

You can submit the steps in sequence or all at once. Tomodify the sequence of steps, click
Modify the sequence... and then rearrange the sequence of steps.

4. In the Select an action - job form, specify whether you want to save and run, schedule, or only
save the new job.

5. Click Finish.

Create Custom Reports with Query Studio
With the Query Studio feature of the HP NNM iSPI Performance for Metrics BI Server Portal, you
can create custom reports with themetrics from all available extension packs. You can combine
metrics from all available extension packs while creating a custom report.

Note:HP does not offer any support for custom reports.

To create new reports usingmultiple extension packs:
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1. Log in to Network Performance Server (NPS).

2. On the NPS Home page, click BI Server tab in the left navigation panel.

3. Select Query Studio.

4. Select an extension pack. For example, All ExtensionPacks.

5. Select time zone for your report. (Optional)

6. To enable Query Studio reports display data in a time zone different from the server time zone,
specify your time zone using the Set Preferences form.

7. Select time granularities for your report.

8. Select a topology group for your report.

9. Add topology context to your report.

NPS displays all topology attributes from all installed extension packs. However, not all
topology attributes are applicable tometrics from all extension packs. If you point themouse
arrow over a topology attribute, a tool tip appears and shows the extension packs that support
that attribute.

10. Select ametric for your report.

11. To display data retrieved from NNMi, select the field you require from the nnmdetails_
Extesion Pack Name (Example: nnmdetails_Interface_Health) query item.

12. Format the report with the toolbar in the work area.

13. Save the report.

Make sure that you save the report in theMy Folder or any other customized location. Do not
save the reports made via Query Studio in any of the extension pack folders.

14. You can view the report when you log on to the HP NNM iSPI Performance for Metrics BI
Server Portal.

Avoid using IBM Cognos 8 BI Report Studio to create or customize NNM iSPI Performance
reports. HP does not provide support for reports made or customized using IBM Cognos 8 BI
Report Studio

Note: Formore information on how to useQuery Studio, you can use the following BI Server
documents:

l Query Studio Quick Tour

l Query Studio User Guide

Overview of Custom Poller Configuration
Available only with the NNM iSPI Performance for Metrics.

After the 30-day evaluation period, you can view reports based on Custom Poller collections only if
you obtain a license for the NNM iSPI Performance for Metrics.

NNMi's Custom Polling feature enables the NNMi administrator to take a proactive approach to
network management by gathering additional device information using SNMP MIB variables.
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For example, an NNMi administrator might want NNMi tomonitor the Status of COM
(communication) ports on all of yourWindows servers.

Using Custom Poller, the NNMi administrator can also configure NNMi to do the following:

l Send incidents when certain MIB values are detected

l Map returnedMIB values to States and include these States as part of node Status calculations.

The NNMi Custom Poller feature enables network operators to:

l View the list of topology nodes for which additional information is being polled as well as the
name of the associated Policy.

l View the polling results. The first time the results for a specifiedMIB variable are discovered, the
results appear in a Polled Instance object. The Polled Instance object is updated whenever a
change in State is detected and includes themost current polled value that caused the State to
change.

l View incidents that are generated by Custom Poller for aMIB Poll Variable.

You can use the data collected by Custom Poller collections to construct and view reports if you
use the NNM iSPI Performance for Metrics.

Overview of Custom Poller Collections and Their Associated Policies

Note: SeeNNMi online help for more information on Custom Poller.

Reports for Custom Poller Collections
If you use the Custom Poller feature of NNMi, you can configure the NNM iSPI Performance to
create reports based on the data collected by NNMi's Custom Poller. The Report Groups tab in the
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Custom Poller Configuration form enables you to generate reports from themetrics obtained from
Custom Poller collections.

The NNM iSPI Performance creates new extension packs to display reports generated from the
data collected by Custom Poller collections.

Mechanism of Creating Additional Extension Packs

When you add a report group to the Report Groups tab, NNMi creates an extension pack for each
SNMP MIB table referenced in the Custom Poller collection. On the NPS HomePage, the
extension pack reflects the name of the SNMP MIB table. Multiple Custom Poller collections are
combined into a single extension pack if the collections useOIDs from the sameMIB table.

Custom Poller Report Controls
You can use the standard report control links to access Time Controls, Topology Filter, Report
Options andAdjust Time Range filters. You can search using any of the available attributes and
set filters to create a report based on themodification.

Time Control

On the navigation panel of NPS Home Page, click the TimeControl tab to change the default time
filters for a report.

Filter Usage

Click the drop-down calendar box and select the appropriate date.

By default, the date is automatically set to the current date when you select the Time
Range.

To set the timemanually, select the Hour/Minutes/Meridian options separately, and
then select the value by clicking the arrow.

By default, the time is automatically set to the current time when you select the Time
Range.

Time
Range

Click the drop-downmenu to display the list of time ranges, and then select the
appropriate time.

If you select a time range that is beyond theStart Date and Time, the following
message appears:

Your start date/time is out of range. It will be adjusted.

Click OK to adjust accordingly.

Auto
Refresh

Click the drop-downmenu, and then select the desired time to recreate the reports
based on the set interval.

By default, the Auto refresh is OFF.

The Auto Refresh option appears on the TimeControls page only after the first report
is generated.

Time Control Filters
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Topology Filters

On the navigation panel of NPS Home Page, click the Topology Filters tab to launch the Topology
Selector.

The Topology Filter enables you to quickly find or select an element from the topology table using
selectionmechanisms appropriate for the attribute type.

Attribute
Parameter

Node
Group
Name

Contains the list of the available Node groups in the network.

Node
Name

Contains the list of the available Node name in the network.

Node
Contact

Contains the list of the available Node Contact in the network.

Node
Location

Contains the list of the available Node Location in the network

Node
Family

Contains the list of the available Node Families in the network.

Node
Vendor

Contains the list of the available Vendors in the network.

Node ID Contains the list of the available Nodes ID in the network.

Node
UUID

Contains the list of the available Node UUID in the network.

Index Contains the list of the available Index in the network. This field contains the SNMP
index OID values that identify specific MIB table instances polled by Custom Poller
policies; if you want, you can use these SNMP index OID values to filter Custom
Poller reports to show only specific instances from theMIB table (use in conjunction
with the NodeName filter).

Attributes and Related Parameters Available for the Topology Filters

Report Options

On the report, click on theOptions link to access the Report Options panel.

Report options provide a list of primary and secondary metrics for the selected Custom Poller
extension pack.

Note: Themetrics drop-down list differs according to the selected extension pack.
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Create Extension Packs for Custom Poller Collections
To create an extension pack for a Custom Poller Collection, youmust create a report group for a
Custom Poller Collection from the NNMi console.

Prerequisite:Youmust log on to the NNMi console with the administrative privilege.

Task 1: Create a Custom Poller Collection

Create a Custom Poller Collection in the Custom Poller Configuration form by following the
instructions inNNMi Help for Administrators.

Task 2: Create a Custom Poller policy

Create a Custom Poller policy in the Custom Poller Configuration form by following the instructions
inNNMi Help for Administrators.

Task 3: Create an extension pack for a Custom Poller Collection

1. Navigate to the Custom Poller Configuration form.

a. From the workspaces navigation pane, select the Configuration workspace.

b. Select Custom Poller Configuration.

2. In the Custom Poller Configuration form, go to the Report Groups tab.

3. Click New. The Report Group form opens.

4. In the Report Group form, specify a name for the extension pack in the Basics section. Do not
use spaces in the name.

5. In the Report Collections tab, click New. The Report Collections form opens.

6. To add a Custom Poller Collection to the report group, click (the Lookup icon):
n To specify a Custom Poller Collection, click Quick Find.

n To create a new Custom Poller Collection, click New.

7. Set the Report Data Type to one of the following values:
n Gauge:Represents single non-cumulative values. Examples of Gauge data types include

Response Time, Bit Rate, and Temperature. During aggregation, the NNM iSPI
Performance for Metrics calculates theminimum, maximum, and average values of gauge
metrics.

n Percent:Represents single non-cumulative values that are formatted with a percent sign
(%) and two decimal places. Examples of Percent data types include Utilization and
Discard Rate. During aggregation, the NNM iSPI Performance for Metrics calculates the
minimum, maximum, and average values of percent metrics.

n Counter:Represents incremental values. Examples of Counter data types include byte
counts, packet counts, and flow counts.

8. In the Report Collections form, click Save and Close.

9. In the Report Group form, click Save and Close. The NNM iSPI Performance for Metrics
creates a new extension pack and adds a new tab on the Report Menu page.
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Guidelines to Create Custom Poller Extension Pack

l You can associate a Custom Poller Collection to only one report group.

l If you associate more than one Custom Poller Collection with the sameReport Group, make
sure the combination of Collections generates ameaningful report. As a general guideline, select
Collections whoseMIB Variables represent the same index value across Custom Poller
Collections.

l Avoid using keyboard symbols while naming the Custom Poller collection and customPoll OID.
If you still use the following symbols <,>,”,’,&,\, they are replaced by a ! character in the
report.

l Reports are not created if the # symbol is used in a customPoll name.

Remove Custom Poller Extension Packs
If you want, you can remove the extension packs. The NNM iSPI Performance provides you with
command line tools to remove Custom Poller extension packs.

To remove Custom Poller extension packs:

1. Log on with the administrative or root privileges to the system where the NNM iSPI
Performance is installed.

2. Go to the following directory:
n OnWindows: %NPSInstallDir%\NNMPerformanceSPI\bin

n OnUNIX or Linux: /opt/OV/NNMPerformanceSPI/bin

3. Run the following command to view the list of extension packs:
uninstallExtensionPack.ovpl

4. Run the following command:
uninstallExtensionPack.ovpl -p <extension_pack_name>

Note:You cannot recover the data associated with an extension pack if you inadvertently delete it.
Make sure to type the correct extension pack namewith the command. Do not delete the
following default NNM iSPI Performance for Metrics extension packs unless you want to
remove NNM iSPI Performance for Metrics reports: Interface_Health, Component_
Health. If you delete the PerfSPI_Diagnostics.extension pack, you will not be able
tomonitor the health of the NPS processes.

Modifying Topology Attribute Values and Group Memberships from
NNMi

The topology attributes and groups help you filter the data and build the report with the data polled
from nodes and interfaces of your interest. The NPS retrieves the topology attribute details from
NNMi and other iSPIs. If youmakemodifications to topology attributes and groupmemberships
from NNMi, the changes are reflected in the NPS within about an hour.
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Changes are not applied retroactively to the existing data. Changes are always forward-looking; the
NPS preserves the historical accuracy of the data ‘as it was’ when it was collected.

For example:

l If a new node is added to a group, it is only added for the new data collected going forward. The
NPS cannot assume that the node was amember of the group in the past.

l If an interface attribute changes—for example, ifSpeed is changed from old to new value, it is
only applied going forward. The NPS does not assume that the new speed applies to the
historical data.

If you delete or change amember of a topology attribute, the oldmember continues to appear in the
list of topology filters in NPS. The old attributemember continues to appear in the list of topology
filters. If you select the oldmember, the data that was collected beforemaking the change gets
sampled in the report.

Example

If youmodify the node group name A to B in the NNMi console, the new node name gets reflected in
NPS after at least an hour. Later on, the old node group name continues to appear in the list of Node
Groups in the Topology Filters section. However, when you select A, you cannot retrieved data
samples associated with A that are polled after changing the NodeGroup name to B.

For example, youmight have an interface group called “Oracle Server Ports” identifying switch
interfaces assigned to your Oracle Server cluster, but now you have a new server cluster available
online, and you want to transfer your Oracle applications to the new one, and re-purpose the old
servers to host theMicrosoft Exchange Server.

Therefore, you rename “Oracle Server Ports” to “Exchange Server ports” and create a new interface
group for “Oracle Server Ports” identifying the ports associated with the new servers. If you want to
run a report at the end of themonth to see the health of your “Oracle Server Ports” and your new
“Exchange Server Ports” over themonth, the NPS will define “Oracle Server ports" group to include
the data collected for the original ports up until the point youmade the change, and for the new ports
after that point.

Similarly, the NPS will define the “Exchange Server ports” group to only include the ports from the
point the group was renamed—it does not include the ports while they were still being used for
Oracle.

Location of Program and Runtime Files
Network Performance Server (NPS) consists of static application software files and dynamic
runtime files.

The default path for static application software is:

l Windows: C:\Program Files(x86)\HP\HP BTO Software

l Linux: /opt/OV

The NNMPerformanceSPI directory contains the following folders:

l bin

l config

l Docs
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l extensionpacks

l Installation

l java

l L10N

l lib

The default path for the dynamic runtime files is:

l Windows: C:\ProgramData\HP\HP BTO Software

l Linux:/var/opt/OV

The performance of NPS depends on the I/O performance of the disk subsystem where this
directory resides. We strongly recommend that this data location is hosted on a high-performance
file system, such as a local multi-disk RAID0/5 array.

The NNMPerformanceSPI directory contains the following folders:

l contentstore

l database

l nnmappfailover

l L10N

l logs

l PerfSPI_Diagnostics

l rconfig

l Component_Health: Only if NNM iSPI Performance for Metrics is installed.

l Interface_ Health: Only if NNM iSPI Performance for Metrics is installed.

The above folders are placed by the default NPS installation. Additional folders may be present if
additional extensionPacks (for example, Metrics customPoll, or Traffic extensionPacks) are
present.

Setting Polling Characteristics in NNMi
Performance polling has an impact on NNMi and it also has an impact on your network. If you
enable additional performance polling, NNMi needs to allocate a portion of its resources to handle
the additional polling. Also, your network needs to accommodate an increase in SNMP traffic. To
use the system and network resources wisely, it is important to limit performance polling to the
devices you require themost.

By default, NNMi enables performance polling for the following NodeGroup:

l Routers

The following are some of the ways you canmodify the performance polling defaults that will be in
place right after the iSPI is installed: 
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l Set thresholds for a node group that you are already polling for performance data (no thresholds
are set by default).

l Modify the frequency of performance polling.

l Add nodes to the Important Nodes group, and enable performance polling for this group.

l Enable performance polling for theMicrosoft Windows Systems group.

All these processes involvemonitoring configuration tasks. Monitoring configuration tasks are
related to polling.

For information about any of these processes, seeHP Network NodeManager i Software Online
Help: Help for Administrators.

Setting Thresholds for Metrics in NNMi
Until you set the thresholds for the extension pack metrics, the reports in that extension pack do not
track exception counts.

NNMi does not set thresholds for performancemetrics for you, automatically. Youmust set the
thresholds for the NNM iSPI Performance for Metrics metrics manually using the Thresholds
Settings form.in NNMi console. The following list shows some of themetrics for which you can set
the thresholds:

l Discard rate in

l Discard rate out

l Error rate in

l Error rate out

l Utilization in

l Utilization out

l CPU 5 second utilization

l CPU 1minute utilization

l CPU 5minute utilization

l Memory utilization

l Buffer utilization

l Buffer miss rate

l Buffer failure rate

For information about how to set thresholds using the NNMi console see Configure Threshold
Monitoring for Interfaces (HP Network NodeManager iSPI Performance for Metrics Software) in
theHP Network NodeManager i Software Online Help: Help for Administrators.

Although youmay want to see exception counts as soon as possible, setting thresholds right away
may not be feasible. This is because youmay not be ready to set thresholds until you are better
acquainted with the way your network behaves. You need to know what is normal for your network,
and if you set thresholds prematurely, problems may arise. For example, if the thresholds are
wrong, NNMi may detect toomany exceptions, and if you configure NNMi to generate incidents in
response to threshold conditions, NNMi may generate toomany incidents.
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Threshold Terminologies
l High Value (HV):1

l High Value Rearm (HVR):2

l High Trigger Count (HTC):3

l Low Value (LV):4

l Low Value Rearm (LVR):5

l Low Trigger Count (LTC):6

l Duration:7

l DurationWindow 8

1Any value above this value is in the high range; any value in the high range triggers a High status.
2Any value below High Value; indicates that the High status has ended.
3The number of consecutive polls a high valuemust remain the same before the status changes to
High. A trigger count of 1 is usually appropriate.
4Any value below this value is in the low range; any value in the low range triggers a Low status.
5Any value above Low Value;indicates that the Low status has ended.
6The number of consecutive polls a low valuemust remain the same before the status changes to
Low. A trigger count of 1 is usually appropriate.
7The time limit before which the baselinemetric state cannot change to Abnormal Range or
generate an incident. This time period specifies theminimum time within which themetric value
must remain out of the configured Baseline Range.
8The window of time in which the Upper Baseline Limt or Lower Baseline Limit criteria must bemet.
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Integrating NNM iSPI Performance with Other iSPIs
The NNM iSPI Performance suite extends the capabilities of HP Network NodeManager i
Software (NNMi) by monitoring and analyzing the performance of your network. The NNM iSPI
Performance suite includes the following products:

l NNM iSPI Performance for Metrics

l HP Network NodeManager iSPI Performance for Quality Assurance Software

l HP Network NodeManager iSPI Performance for Traffic Software

Network Performance Server (NPS) provides you with the infrastructure and resources for the
NNM iSPI Performance products to generate network performance reports.

Baseline Metrics
The Network Performance Server (NPS) provides you the baselinemetrics to define the normal
(expected) range of values for any givenmetric.

The baselines metrics enable you to forecast the future value for a givenmetric based on the
historical data. NPS derives the baseline values based on the following concepts:

l Seasonality1

l Initialization period2

l Adaptation Parameters3

Baseline Metrics Glossary
The baselinemetrics compute the trends, seasonal patterns and time range deviations for all the
HP Network NodeManager i Software Smart Plug-in products. The following table lists the
baselinemetrics:

1Represents a periodic and repetitive pattern in themetrics utilization levels. The repetitive (cyclic)
nature of this pattern enables NPS to predict the future utilization values for themetric. The default
period for seasonality is one week with fiveminutes granularity.
2Represents the period during which NPS collects data required for calculating the baseline
metrics. NPS does not generate any exceptions for this period, considering the data range to be
insufficient to calculate a reasonable normal range. For example, if the initialization period is set as
four weeks, NPS does not calculate any baseline exception for these four weeks. After four weeks,
NPS calculates the normal ranges of metric values based on the data collected during these four
weeks.

The default initialization period for NPS is three weeks or three seasons. The default time range for
each season is one week.
3Represents the technique used to smooth the historical data for a given time range and forecast
themetrics value. NPS uses intercept, trend, and seasonal adaptation formulas to smooth the
historical data and calculate the forecast value.
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Metric Name Description

Baseline Average Average value presenting the normal (expected)
range of utilization for the selected topology filter
based on the historical data

The NNM iSPI can analyze the following using this
metric:

l The actual utilization of the topology filter as
compared to the normal utilization ranges.

l Forecast the topology filter utilization for a
selected time range.

l Identify the over-utilized and under-utilized
topology filters before they violate the thresholds.

Baseline Deviation Deviation of the samples spread over a specific time
range.

Represents the extent of the range of values
normally seen for the selected time range in the
seasonal cycle, based on historical data.

The NNM iSPI can analyze the following using this
metric:

l Analyze the utilization pattern for the selected
topology filters over a selected time range.

l Identify the utilization values that are lower or
higher than themean utilization. This in turn
enables you to identify the over-utilized and
under-utilized topology filters.

Baseline Slope Increase or decrease in the average utilization in one
day. Negative slope indicates a declining trend.

The NNM iSPI can analyze the following using this
metric:

l Identify any unexpected change in the topology
filter utilization.

l Avoid resource bottlenecks by identifying gradual
increase in resource utilization.

l Identify the point in a selected time range when
the resource utilization was the highest or lowest.
This enables you to derive a pattern in the
topology filter utilization.

Upper Normal Upper limit of the normal range for the sample. The
normal range for the samplemay vary for every
NNM iSPI.
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Metric Name Description

NNMi supplies the upper normal value based on
values that you enter in the Threshold Configuration
form. You can disable the upper normal value if you
do not require to set the upper threshold for the
metric.

See HP Network NodeManager i SoftwareOnline
Help for Administrators for information about
Threshold Configuration form.

The value is calculated using the following formula:

Upper Normal = Baseline Average + (N1 * Baseline
Deviation)

Where N1 is the upper sleeve width

Lower Normal Lower limit of the normal range for the sample. The
normal range for the samplemay vary for every
NNM iSPI.

NNMi supplies the lower normal value based on
values that you enter in the Threshold Configuration
form. You can disable the lower normal value if you
do not require to set the lower threshold for the
metric.

See HP Network NodeManager i SoftwareOnline
Help for Administrators for information about
Threshold Configuration form.

The value is calculated using the following formula:

Lower Normal = Baseline Average - (N2 * Baseline
Deviation)

Where N2 is the lower sleeve width

Days to Threshold Forecast for the topology filter utilization to reach the
upper or lower threshold limit.

Represents the number of days left for the utilization
to reach the threshold value.

NPS calculates this metric based on the following:

l Baseline Slope

l The static upper and lower thresholds defined in
NNMi Threshold Configuration form
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Metric Name Description

Exception Count Total number of sample counts that aremarked for
an exception.

NPS raises an exception for themetric if the a
certain number of samples within a sample window
are out of normal range.

For example, NPS raises a baseline exception if 7
samples out of a sample window of 10 samples are
beyond the upper normal range. Youmust configure
NNMi for the upper and lower normal ranges to
enable NPS to raise the exceptions.

If the topology filter utilization is between Upper
Normal and Lower Normal, the exception count is
set to 0 (Zero) for the selected sample.

If you disable the upper or lower normal thresholds in
NNMi, NPS does not raise exceptions for the upper
and lower normal ranges.

The NNM iSPI can analyze the following using this
metric:

l Analyze the performance of the selected topology
filter for a specific time range.

l Identify network performance problem if the
exception count is persistently high for the
selected time range.

Baseline Exception Rate Percentage of samples that has the exception flag
set.

Forecast Baseline (avg)

l 4 week

l 8 week

l 12 week

Average value presenting the normal (expected)
range of utilization for the selected topology filter
based on the forecast data

The NNM iSPI can analyze the following using this
metric:

l The forecast utilization of the topology filter as
compared to the normal utilization ranges.

l Forecast the topology filter utilization for a
selected time range.

l Identify the over-utilized and under-utilized
topology filters before they violate the thresholds.

Forecast Upper Normal (max)

l 4 week

Upper limit of the normal range for the forecast data.
The normal range for the datamay vary for every
NNM iSPI.
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Metric Name Description

l 8 week

l 12 week

Forecast Lower Normal (min)

l 4 week

l 8 week

l 12 week

Lower limit of the normal range for the forecast data.
The normal range for the datamay vary for every
NNM iSPI.

Baseline Exceptions Generated by NNM iSPI Performance
Software

Network Performance Server (NPS) stores the records that aremarked with baseline exceptions.
These records reflect only themost recent fact record for any affected component, interface, node,
or node group. These records reflect the average baseline exceptions for each of themetrics used
by an extension pack.

For individual samples the baseline exception is either represented as 0% or as 100%. The NNM
iSPI Performance software uses this table to perform the following tasks:

l Provide an interface to HP Network NodeManager i Software (NNMi). NNMi in turn creates
incidents for each interface that is marked with a baseline exception.

l Generate ad-hoc reports for the interfaces that are currently having baseline exceptions, thus
having any network health or performance problems.

Baseline Exceptions Used by NNM iSPI Performance for Metrics
Component Health

Baseline exceptions are enabled for the followingmetrics in the Component Health extension pack:

l Memory Utilization

l Buffer Utilization

l Buffer Miss Rate

l Buffer Failure Rate

l Buffer NoMemory Rate

l CPU 1min Utilization

l CPU 5sec Utilization

l CPU 5min Utilization

Interface Health

Baseline exceptions are enabled for the followingmetrics in the Interface Health extension pack:
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l Utilization In

l Utilization Out

l Error Rate In

l Error Rate Out

l Discard Rate In

l Discard Rate Out

Security Groups in Network Performance Server (NPS)
Security groups enable NPS to display topology groups andmetrics based on your user access
level.

Security groups are created by NNMi administrators. They ensure that the reports display only the
data that is related to your user group. Every user group in NNMi is associated with a security
group. Security groups created in NNMi apply to all iSPIs.

Security groups enable NPS to:

l Filter the fact table queries for all report graphs/tables, including reports created using Query
Studio.

l Filter the dimension data queries used in topology filter prompts or in Query Studio.

l Filter groupmember queries used in topology filter prompts or in Query Studio. NPS does not
display data related to the groups, where none of themembers have access to the report data.

NPS contains all performance data saved by NNMi and the iSPIs for various security groups. Only
NNMi administrators can access data saved for all security groups.

Example

This example uses NNMi's security configuration to divide the access to NPS data based on the
following locations:

l Site A

l Site B

Each location includes the following local users:

l Operator 1: This user can access data for only Site A

l Operator 2: This user can access data for only Site B

The following global users can access data from all locations

l Admin: The NNMi and NPS Administrator, handles both locations and can access NPS data
from all locations.

l Backup: The backup user for both Site A and Site B andmust access the NPS data in both the
locations.

The following user groups ensure that the NPS access for each security group is restricted:

User
Account NPS User Group NPS Access Privileges
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Admin NNMi and NPS
 Administrator

l Can access all NPS data irrespective of location

l Can access all user group data in NPS

l Can add, modify, or delete NPS users and user groups
using NNMi console

l Can access NPS using the ErsAdmin user account

l Can access all report templates, schedule reports, and
define global report settings

Backup Level 2 Operator Can generate reports for both Site A and Site B

Operator
1

Level 1 Operator Can generate reports for only Site A

Operator
2

Level 1 Operator Can generate reports for only Site B

Once the administrator (Admin in this example) creates these user groups in NNMi, NPS ensures
that the access to NPS features and data are restricted based on the privileges defined for each
user group.

For more information on user groups and configuring user groups, seeConfiguring Security inHP
Network NodeManager i Software Online Help: Help for Administrators.

Custom Dashboard in NNM iSPI Performance for Metrics
NNM iSPI Performance for Metrics enables you to create dashboards based onmultiple reportlets
from the same or different extension pack1s.

Example

Let us consider a scenario, where you need tomonitor the following:

l Hourly utilization of Interface A on Component X

l Average normal CPU utilization for Component X

l Number of days left for memory utilization to reach threshold

You can create a custom dashboard combining the following reportlets:

1Extension packs provide rules and definitions to generate reports from the data gathered from
different sources. The default, ready-to-use extension pack available with the NPS—the Self
Diagnostics extension pack—helps you view reports indicating the health and performance of
different components and processes of the NPS.
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l Interface Health Heat Chart Report for themetric Utilization (avg)

l Component Health Simple Chart Report for the followingmetrics:
n Primary metric: Memory Utilization - Baseline Average (avg)

n Secondary metric:CPU 5min Utilization - Days to Threshold (min)

Creating Custom Dashboard Using HP NNM iSPI Performance for
Metrics BI Server Portal

To create a custom dashboard:

Step 1

Log in to Network Performance Server (NPS).

Step 2

Copy bookmarks for the reportlets that you need to include in your dashboard

To copy the bookmarks for the reportlets that you need to include in your dashboard:

1. On the NPS Home Page, click Dashboard Reportlets tab.

2. Select an extension pack1. For example, iSPI Metrics > Interface Health > InterfaceMetrics

3. Select a reportlet. For example, Heat Chart reportlet

4. Click Show Bookmark.

5. Copy the bookmark and paste it in a text editor.

Repeat these steps for all the reportlets that you need to include in your dashboard.

Step 3

Create the dashboard using BI Portal

To create the custom dashboard:

1. On the NPS Home Page, click BI Servertab.

2. Select BI Portal.

3. Select a location for your dashboard. For example, My Folders

4. Click New Page.

5. In the Specify a name and description - New page wizard form, specify the required information
about the dashboard.

1Extension packs provide rules and definitions to generate reports from the data gathered from
different sources. The default, ready-to-use extension pack available with the NPS—the Self
Diagnostics extension pack—helps you view reports indicating the health and performance of
different components and processes of the NPS.
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6. In the Set columns and layout - New page wizard form, specify the following:
n Number of columns you require in the dashboard

n Width of the columns. For amulti-column dashboards, the columns must be of samewidth.

7. In the Set columns and layout - New page wizard form, click Add...

8. Select Cognos Utility.

9. In the Available entries column, select a utility. For example, to display multiple reportlets in
the dashboard, select HTML Viewer.

10. Click Add to move the selected utilities in the Selected entries column.

11. Click OK.

12. Click Next.

13. In the Set page style - New page wizard specify the title, style, and any instructions that you
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want the dashboard to display.

Avoid selecting the following options:

n Hide title bars

n Hide Edit buttons on the title bar

You need the Edit button on the title bar to complete creating the dashboard.

14. Click Next.

15. In the Select an action - New page wizard form, select the required options and click Finish.

The new dashboard opens in the Edit mode.

Step 4

Edit the dashboard to display the selected reportlets
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To edit the dashboard:

1. Select any of the following tools:
n Edit in the title bar

n Edit in the Actions column

2. Specify the content for the dashboard using the reportlet bookmark. For example, if you
selected HTMLViewer to view the dashboard reportlets, copy the bookmark you saved in the
text editor and paste it in the HTML content field.

3. Specify the height for the panel where Cognos displays the reportlet.

4. Click OK.
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Using Reports
The NPS generates reports on operational metrics over a selected period of time. The content of
these reports is defined in the core NPS reports, and is extended by installing additional NNM iSPIs
such as the NNM iSPI Performance for Traffic or NNM iSPI Performance for QA.

Some of the tasks that you can perform using NPS are:

l View the operational performance of metrics over a period of time.

l Modify the default settings of a report to view additional attributes related to themonitored
element.

l Customize dashboards with pre-defined reportlets.

l Customize the schedule and format for report delivery.

l Create customized reports using Query Studio.

Avoid using IBM Cognos 8 BI Report Studio to create or customize NNM iSPI Performance
reports. HP does not provide support for reports made or customized using IBM Cognos 8 BI
Report Studio

Launching Reports
You can launch reports created by the NPS or NNM iSPI products either from the NPS Home
Page, the HP NNM iSPI Performance for Metrics BI Server Portal.

To launch a report from the NPS Home Page:

1. Log on to NPS using either the NNMi console or the NPS home page.

2. On the NPS HomePage, select Reports in the navigation panel.

NPS presents the default, ready-to-use Self Diagnostic extension pack (to generate reports on
the performance of the NPS itself). Depending on the number of the NNM iSPI Performance
products or extension packs available on the NPS system, youmay seemany other sets of
reports.

3. Select a report type (for example, Chart Detail or Heat Chart).

4. Modify the default report settings, if required.

Tip: On the NNMi Network Overview workspace, if you select a node, and then click Actions >
Reporting-Report Menu, the Report Menu page presents reports created with the data
collected from the selected node.

Note: If you want to navigate back to the NNMi console:

l In the NPS Home page navigation panel, click theCross Launching tab.

l Click NNMi Links.

l Click NNMi Console.
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The NNMi Console link enables you to go back to NNMi workspaces based on the topology
objects currently selected in the NPS.

Launching Reportlets
You can launch Reportlets created by the NPS or NNM iSPI products either from NPS home page
(introduced by the NPS), or you can use the HP NNM iSPI Performance for Metrics BI Server
Portal.

To launch a reportlet from the NPS home page:

1. Log on to NPS using either the NNMi console or the NPS home page.

2. On the NPS HomePage, select Dashboard Reportlets in the navigation panel.

NPS presents the default, ready-to-use Self Diagnostic extension pack (to generate Reportlets
on the performance of the NPS itself). Depending on the number of the NNM iSPI Performance
products or extension packs available on the NPS system, youmay seemany other sets of
reportlets.

3. Select a reportlet type (for example, Exceptions Pie Chart or Simple Bar and Line Chart).

4. Modify the default reportlet settings, if required.

Tip: On the NNMi Network Overview workspace (available in Topology Maps workspace), if you
select a node, and then click Actions > Reporting-Report Menu, the NPS home page
presents Reportlets created with the data collected from the selected node.

Change Default Settings
NPS generates reports with a set of parameters, which are set when you launch a report from the
NPS home page or the NNMi console. Every NPS report or reportlet is built with the following sets
of parameters:

l Time controls:1

l Topology filters:2

l Report options:3

1The time controls help you set the time range for the report or reportlet that you want to view. The
NPS database stores the data collected from different nodes over a period of time. By using the
time controls parameters, you can view a report or reportlet created for the range of time of your
choice. You can also select the display grain of a report or reportlet. When a report or reportlet is
rendered, the time range is always shown in the Filter Summary section at the top of the report or
reportlet.
2 The topology filters enable you to create a report that is filtered, or constrained in scope, by
specific topology attributes. By default, when you launch a report or reportlet for the first time from
the NPS Home Page, NPS generates the report or reportlet that is not filtered. However, you can
select a specific node or a set of nodes from the NNMi console (from the Topology Maps
workspace), and then launch the NPS Home Page to view reports or reportlets only on the selected
nodes. The topology filters extend this capability by offering a range of filters on the NPS home
page, which help you select the data to be included or excluded prior to viewing the report. When a
report or reportlet is rendered, the selected filters are always shown in the Filter Summary section at
the top of the report or reportlet.
3 Reports and reportlets display graphical and statistical representation of different operational
characteristics of themanaged network. These characteristics are represented with metrics;
parameters that indicate the health and operational performance of the network. While every report
and reportlet opens with the default metric set, the Report Options Panel helps you generate the
report or reportlet with themetrics of your choice.
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Change Time Controls
When you launch a report from the Network Performance Server (NPS) Home Page, the report
shows the data collected over the selected time range; relative to themost recent data sample.

To change time controls:

1. Log on to NPS using either the NNMi console or the NPS home page

2. In the navigation panel, click Reports tab, select the extension pack, and select the report that
you want to view.

Tomodify the time controls for one of themost used reports, click My reports. For information
about how to save a report into My Folders location, see Saving a Report into My Folder.

3. On the navigation panel, click the Time Control tab.

4. You can change the following parameters:

Time Control Function

Relative Start Sets the start date for the reports based on the available data

Changes the Start Date or Time for the Report

Time Range Changes the time range for the report

Display Grain Changes the display grain for the report

Auto Refresh Refreshes report data automatically

Time Zone Enables you to select a preferred time zone

Hour of Day Enables you to:

n Select the appropriate hour of the day from the list.

n Formultiple selections, select the appropriate hour from the list, and then hold downCTRL to select each additional
hour.

Day of week Enables you to:

n Select the appropriate day of the week from the list.

n Formultiple selection, select the appropriate day from the list, and then hold downCTRL to select each additional day.

Select All Enables you to select the available values from the list.

Deselect All Enables you to deselect the available values from the list.

5. Perform one of the following steps:
n On the Re[port Options panel, click Submit

n On the report, Confirm Selection
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If you are viewing the TimeControl pane while launching the report from within BI Server
Connection, youmay see additional navigation buttons at the bottom of the screen. These
additional buttons enable you tomove forward to the Topology Filters screen.

Button Function

Cancel Click to cancel the report generation

Back Click to go back to the previous page of the report generation; if you are in the first
page the option will be disabled.

Next Click to move to the next page of the report generation

Finish Click to display the report for the selected filter.

Time Ranges with Default Display Grains

When you set a time range for a report, a predefined display grain is applied to the report. The
following table shows themapping between the time ranges with the default display grains.

Time Range Display Grain

31 Days 1 Day

7 Days 1 Day

24 Hours 1 Hour

12 Hours 1/2 Hour

2 Hours 5Minutes

1 Hour 5Minutes

30Minutes 1Minute

15Minutes 1Minute

5Minutes As Polled

1Minute As Polled

Until Now Adjusted appropriately based on Start Date/Time

Your choice of display grain defines the data source for the reports.

The following three types of data sources exist within NPS:

l Internal Summary tables (data for up to 70 days)

l Internal Live tables (data for up to 1 day)

l Archive tables (data for up to ‘N’ days as set by the Configuration Utility)
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Using a display grain of 1 hour or above ensures your reports will source their data from the Internal
Summary tables. Using a display grain of less than 1 hour, combined with a Start Date/Time within
the last day, will result in the Live tables being used. Using a display grain of less than 1 hour,
combined with a Start Date Time prior to the last day, will force the NPS to use the Archive tables
to fulfil the query. In this last case, a warningmessage informs you that the report might be
relatively slower, as it must perform more expensive and time-consuming database query to
retrieve the data.

Related Topics

TimeRanges with Default Display Grains

Changing Default Settings

Special Scenarios

l Start Date/Time and TimeRange extend beyond the available data: The Start Date and Time
automatically shift to allow the requested TimeRange to be selected from the available data set.

l Start Date/Time requested is prior to the oldest data: If you request a Start Date/Time that is
prior to the oldest data in the NPS, the Start Date and Time shift to coincide with the oldest data
available. The TimeControls section notifies you of this after youmake the selection.

l Start Date/Time is not on the boundary of the display grain: Graphs and charts always show
data grouped into sample sets—the sample size is defined by the display grain1. If the Start
Date/Time is not on the boundary of a display grain-sized sample, results can look unusual. The
NPS always attempts to round down the Start Date/Time to the beginning of the nearest display
grain-sized sample.

For example: a Start Time of 12.15 am and a TimeRange of 1 Day will have a default TimeGrain of
1 Hour—resulting in 24 samples. However, the samples for the hour representing 12.00 will only
have data from 45minutes and will appear unusually low. To correct this, the TimeControl will
move the Start Date/Time back to begin at 12.00 am automatically.

Related Topics

Changing TimeControls

TimeRanges with Default Display Grains

Changing the Default Date/Time for Reports

To change the default date and time for reports:

1. Log on to NPS using either the NNMi console or the NPS home page.

2. In the navigation panel, click Reports and select the report that you want to view.

1The display grain defines how samples of data are grouped across the time range. For example, a
one hour chart with a display grain of fiveminutes displays 12 samples of data.
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Tomodify the topology filters for one of themost used reports, select a report from theMy
Folders location. For more information on how to save a report into My Folders location, see
Saving a Report into My Folder.

3. In the navigation panel, click Hour / Day Filters.

4. Select the following:
n In the Hour of Day list, select a default time for the reports.

n In the Day of Week list, select a default date for the reports.

5. Click Submit.

Click Reset to cancel the selection.

Selecting Relative Start for Your Report

The Start Date/Time defines the point of origin of the report. The report shows the data collected
from the time and date specified in the Start Date/Time field.

To set relative start for your report:

1. Log on to NPS using either the NNMi console or the NPS home page.

2. In the navigation panel, click Reports and select the report that you want to view.

3. In the navigation panel, select Time Control.

4. In the Relative Start field, select Yes. By default, relative start is set to Yes.

5. In the Last field, select a time range for the report. For example, if you want to generate a report
based on last 31 days data, select 31 days in the Last field.

6. Select a different time grain if required.

7. Click Submit.

If you request a time range that is relative to themost recent sample of data, the NNM iSPI
Performancemoves the Start Date/Time appropriately. In some cases, especially with a very
recent installation, this may result in a Start Date/Time that appears to be older than the start of the
first data collection interval.

Automatically Refreshing the Report Data

The report gets automatically refreshed with the fresh data samples if you select the auto refresh
rate with a relative start date and time.

For example, if you have selected Last 1 Hour as the TimeRange, and 1Minute in the Auto Refresh
field, the report displays the data samples collected in past one hour and refreshes this data every
minute. As a result,if you generated the report at 12 pm, the report shows data from 11 am to 12 pm,
and refreshes the report data at 12.01 pm.

To automatically refresh the report data:

1. Log on to NPS using either the NNMi console or the NPS home page.

2. In the navigation panel, click Reports and select the report that you want to view.

3. In the navigation panel, select Time Control.

4. In the Relative Start field, select Yes. By default, relative start is set to Yes.
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5. Select the check box Auto Refresh.

By default, auto refresh is set to No.

6. Click Submit

Change the Start Date or Time for the Report

The Start Date/Time defines the point of origin of the report. The report shows the data collected
from the time and date specified in the TimeControl section.

To change the start date or time for a report:

1. Log on to NPS using either the NNMi console or the NPS home page
.

2. In the navigation panel, click Reports and select the report that you want to view.

3. In the navigation panel, select Time Control.

4. In the Relative Start field, select No.

5. In the Start Date/Time section, click on theDate box, and select the appropriate date.

6. In the Start Date/Time section, click on the Time box, and select the appropriate time.

7. Click Submit

NNM iSPI Performance adjusts the Start Date/Time automatically under the following
circumstances:

l Start Date/Time and TimeRange extend beyond the available data:1

l Start Date/Time requested is prior to the oldest data: 2

l Start Date/Time is not on the boundary of the TimeGrain: .3

1 The NNM iSPI Performancemoves back the Start Date/Time and selects the requested Time
Range from the currently available data set.
2 If you request for a Start Date/Time that is prior to the oldest data in the system, the NNM iSPI
Performance advances the Start Date/Time to coincide with the oldest data available.

The TimeControl advises you of this when your data set begins.
3 NNM iSPI Performance reports always show data grouped into sample sets. The sample size is
defined by the TimeGrain. If the Start Date/Time is not on the boundary of a TimeGrain sized
sample, results can look unusual when displayed. To prevent this, the TimeControl always
attempts to round down the Start Date/Time to the beginning of the nearest TimeGrain sized
sample.

For example, a Start Time of 12.15 am and an Interval of 24 Hours will have a default TimeGrain of
1 Hour; resulting in 24 samples. However, the samples for the hour representing 12.00 will only
have data from 45minutes and will appear unusually low. To correct this, the TimeControl will
move the Start Date/Time back to begin at 12.00 am automatically
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Change the End Date or Time for the Report

The EndDate/Time defines the endpoint for the displayed data. The report shows the data collected
from the start time till the date specified in the TimeControl tab.

To change the end date or time for a report:

1. Log on to NPS using either the NNMi console or the NPS home page
.

2. In the navigation panel, click Reports and select the report that you want to view.

3. In the navigation panel, select Time Control.

4. In the Relative Start field, select No.

5. In the End Date/Time section, click on theDate box, and select the appropriate date.

6. In the End Date/Time section, click on the Time box, and select the appropriate time.

7. Click Submit to generate the report for the time range ending on the date and time specified in
the End Date/Time.

NNM iSPI Performance adjusts the Start Date/Time automatically under the following
circumstances:

l EndDate/Time and TimeRange extend beyond the available data:1

l TimeRange requested is prior to the oldest data: 2

Changing the Display Grain for the Report

The TimeGrain defines how samples of data are grouped across the TimeRange.

A 1 Hour chart with a TimeGrain of 5Minutes displays 12 samples of data. Adjusting the Time
Range automatically sets the TimeGrain to a default value. However, you can adjust the Time
Grain manually using the navigation panel in NPS Home Page.

To avoid partial samples of data being grouped together, NNM iSPI Performance adjusts the Start
Date/Time value to the boundary of the default Time Range.

To change the default time grain for the reports:

1. Log on to NPS using either the NNMi console or the NPS home page
.

2. In the navigation panel, click Reports and select the report that you want to view.

3. In the navigation panel, select Time Control.

1 The NNM iSPI Performancemoves back the End Date/Time and selects the requested Time
Range from the currently available data set.
2 If you request for a time range (time between the Start Date/Time and End Date/Time) that is prior
to the oldest data in the system, the NNM iSPI Performance advances the Start Date/Time and
End Date/Time to coincide with the oldest data available.

The TimeControl advises you of this when your data set begins.
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4. In the Grain section, select a time grain for your report.

5. Click Submit

Your selection of TimeGrain defines the data source for the reports. NNM iSPI Performance uses
the following types of data source:

l Internal Aggregate tables1

l Internal Live tables2

l Archive tables

Changing the Default Time Zone for the Report

By default the reports are generated based on the NPS server's time zone. You can select a
different time zone while viewing or scheduling a report in the Time Zone field.

The NNM iSPI Performance uses the selected time zone to generate all subsequent reports.

The selected time zone overrides the time zone preferences associated to your user account.
However, if you set the time zone back to the default value, NNM iSPI Performance uses any of
the following time zones:

l The time zone set in your user account preferences. This overrides the NPS server time zone.
Follow any of thesemethods to change your default time zone:

n Using the TimeControl tab in NPS Home Page

n Using the BI Server Portal Preferences page. Youmust have the administrative privileges to
NPS

l The time zone used by the NPS server. If the you have not set any preference for time zone in
your user account, NNM iSPI Performance uses this option.

The Filter Summary (depicted by icon) of each report displays the selected time zone unless
the effective time zone is the default NPS server time zone, known as "Server Time".

Tip:Select the default time zone, in case you generate reports in a large scale environment.
Selecting a different time zone than the "Server Time" (NPS server time zone) requires NPS to
convert the time stamps for the selected time zone while generating the report. This may
consume a lot of time if you have large volume of data.

1Using a course time grain, that is of 1 Hour or above ensures your reports will source their data
from the internal Aggregate tables.
2Using a fine time grain (less than one hour) requires NNM iSPI Performance to analyze the volume
of live data in the database and set the table type accordingly.

If the start time requested is before the earliest live data then NNM iSPI Performance uses the
internal aggregate table as the data source.

Otherwise NNM iSPI Performance uses the internal live table as the data source.
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Set Topology Filters
Network Performance Server (NPS) generates reports created from different metrics that are polled
from different nodes, interfaces, and other network elements. If you want to modify the report to
contain data polled from selected network elements, use the Topology Filters section.

The Topology Filters tab enables you to filter and generate reports on network elements with
specific topology attributes.

All topology attributes shown in the list are obtained from NNMi or the collectors and pollers of
iSPIs in use. You cannot add new attributes or delete existing attributes from this list.

NPS preserves the historical integrity of topology data such that any changes made to topology
attributes (such as Interface Speed, ifAlias values, and so on) are not retroactively applied to the
existing historical data, but only to new data.

To Change Topology Filters:

1. Log on to NPS using either the NNMi console or the NPS home page

2. In the navigation panel, click Reports and select the report that you want to view.

Tomodify the topology filters for one of themost used reports, select a report from theMy
Folders location. For more information on how to save a report into My Folders location, see
Saving a Report into My Folder.

3. Follow one of these steps:

n On the navigation panel, click Topology Filters.

n On the report, click Topology Filters.

4. Do one of the following for the topology attributes that you want to filter:
n If you want to select just one value for a topology attribute, click Single Value Select,

and then select a topology filter..

n If you want to select multiple values, click Multi value select, and then select the
topology filters (by usingCtrl-click orCtrl+Shift).

n If you want to search and select a value from a list of values, click Search and select.

5. To apply different types of topology filters, click Apply, and then repeat step 3.

Clicking the Apply button suppresses the values from the other topology attributes that are
irrelevant in the context of your selection.

To discard your selection, click Reset.

6. Click Confirm Selection. The NPS generates the report with the data specified.

Note:

l Cookies are used to preserve your preferredmethod of selecting each topology filter. For
example, if you open a ‘single value selector’ for an attribute, the next time you run a report, the
single-valued selector will already be opened. Do not openmore selectors than you routinely use
as they do add some overhead (extra time) to running the report.
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l The Self Diagnostic tab displays reports on different NPS processes with the data collected
from the NPS server. Therefore, you cannot see any node or interface-related attributes in the
Topology Filters section of any Self Diagnostic reports.

Tip:You can also select the option as displayed in the following image

if you want to exclude selected objects from the report.

Change Report Options
TheOptions panel enables you to:

l Customize the report with additional options that vary for each report type.

l Select themetrics that are displayed on the report.

To change the report options:

1. Launch the report from the NPS navigation panel.

2. Click Options.

The Report Options panel for the report opens.
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3. You can change the following settings:
n Metrics:Available only with Top N, Top N Chart, andMost Changed reports.A report

displays themetric, performance or utilization associated with themonitored element. Most
reports open with the data for a default set of metrics.

To change these default metrics use the SelectedMetric(s) field.

To display only specific metric values, click Apply Filter.

n Grouping By:Available only with select reports. In the Grouping By box, select an attribute
to define the groupingmechanism for the tabular data on the report.
o To select more than one attribute, click Add New Metric. A new Grouping By box

with the list of attributes appears.

o
To remove a grouping attribute, click Remove Metric.

o To display or hide the start date, start time or display grain for the report data, click
Apply Filter.

n Top/Bottom N:Available only with the Top N andMost Changed reports. The Top/Bottom
N option helps you specify the number and order of data points for use with the Top N and
Most Changed reports.

n Display Time Series Chart:Available only with the Top N report. The Display Time Series
Chart option enables you to view the time series chart at the bottom of the Top N report.

4. Click Confirm Selection. Themodified report appears.

Note:NPS preserves your choice of metrics for a report. When you come back to the report in the
future, themetrics that you selected the last time will be automatically used as the default
metrics.

Reportlet Controls
TheDashboard Reportlet page enables you tomodify the reportlet properties using the following
tools.

Filter Control Description

Displays or hides the reportlet control toolbar

Displays or hides the following information:

l Start date for the data displayed

l Start time for the data displayed

l Display grain for the data displayed

Displays or hides the Report Options panel.

Displays or hides the Add Bookmark panel.
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Contextual Navigation
NPS adds contextual links on the report content to navigate to related reports. By clicking a
hyperlink on the report, you can navigate to related reports with the context of the original report.

The following table displays the different report types and contextual navigation available for each
of them:

Report
Type Contextual Navigation Point

Calendar X-axis; opens report links for reports with the sameDate/time context and the same
primary metric.

Chart
Detail

X-axis; opens report links for reports with the sameDate/time context and the same
primary metric.

Heat Chart l Hour of Day Row Header; opens report links for reports with the sameHour of
Day filter of the selected row.

l Day of Month Header; opens report links for reports with the sameDate/Time
filter of the selected row.

l Data cell value; opens report links for reports with the sameHour of Day filter of
the selected row and the sameDate/Time filter of the selected date.

Headline X-axis; opens report links for reports with the sameDate/Time context and the
samemetric.

Dashboard l Interface name from the Top 10 utilization, Response Time, or Discard charts;
opens report links for reports with the same topology filter to selected interface
and the samemetric.

l Needles of the Exception Count gauges; opens report links for reports with the
samemetric.

Top N Object name (for example, interface name or node name); opens report links for
reports with the same topology filter.

Most
Changed

Object name (for example, interface name or node name); opens report links for
reports with the same topology filter.

Contextual Navigation

Note:You can launch a report from the same extension pack tab, or from a different extension pack
tab. If you launch a report from a different extension pack tab, only the relevant topology filters
are preserved. Sincemetrics typically vary between extension packs, the selectedmetric
cannot be transferred to the target report.

Cross Launching a Report or Reportlet
Where appropriate, the report or reportlet presents links to navigate to another related report or
reportlet. This feature enables you to refine your selection based on time, topology, or metrics that
are displayed on the report.
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To cross launch a report or reportlet:

1. Click on the data point in the report or reportlet that launches another report or reportlet. For
example, you can click on a point of time in the X axis of the Chart Detail report to drill down to
the Heat Chart report displaying themetric performance for the hour selected.

2. Select themetrics for the drill-through report or reportlet.

NNM iSPI Performance saves your selection for the next session.

3. Select a report or reportlet from the navigation panel. The new report or reportlet displays the
selectedmetric.

For more information on the contextual navigation available for each report type, see
Contextual Navigation.

Examples

The following examples explain this behavior for different Interface Health reports:

l The Dashboard report for Interface Health shows a high availability exception count. Clicking on
the needle of the gauge launches the Report Menu with Availability Exceptions as the primary
metric. You can then launch the Top N report to find which set of Nodes is causing the
availability exceptions.

l Looking at the Top N interfaces and their network discard figures, one interface seems more
problematic than usual. Clicking on the interface name launches the Report Menu with that
interface as a topology filter. You can then launch the Chart Detail report to examine discard
figures over the selected time interval for just that interface and determine when the problem
started.

l Using the Heat Chart report for Interface Health shows a peak in traffic on one particular day.
Clicking on the cell with the high value launches the Report Menu with that day already selected.
You can then launch the Interface Health Headline report and get an overview of multiple metrics
for each hour during that day.

Create Bookmarks in Reports
NNM iSPI Performance enables you to create bookmarks for reports in the NPS home page.

These bookmarks encapsulate all the selected settings (Time, filters, Options) and enable you to be
able to quickly visit the report. again from your browser.

Bookmarks are also convenient for emailing and sharing reports.

If you want the bookmark to open the report within the same time range as the original report, make
sure to select a non-relative time range (for example, Start Date/Time with ‘1 Hour’ and not ‘Last 1
hour’ as the time range). Otherwise, the report will show themost recent data.

To create a bookmark for a report:
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1. Launch a report.

2. Click Show Bookmark. A URL appears. Follow any of these steps:
n Only for Microsoft Internet Explorer. Click Add Bookmark. A bookmark to the report is

automatically added to the browser with a new entry to the Favorites list..

n Only for Mozilla Firefox. To create a new bookmark by using the displayed URL, right click
on the URL and then select Bookmark This Link.

The bookmarked URL retains all the properties of the report.

Create Bookmarks in Reportlets
NNM iSPI Performance enables you to create bookmarks for reportlets in the NPS home page.

These bookmarks encapsulate all the selected settings (Time, filters, Options) and enable you to be
able to quickly visit the reportlet. again from your browser.

Bookmarks are also convenient for emailing and sharing reportlets.

If you want the bookmark to open the reportlet within the same time range as the original reportlet,
make sure to select a non-relative time range (for example, Start Date/Time with ‘1 Hour’ and not
‘Last 1 hour’ as the time range). Otherwise, the reportlet will show themost recent data.

To create a bookmark for a reportlet:

1. Launch a reportlet.

2. Click Show Toolbar to display the reportlet toolbar.

3. Click Show Bookmark. A URL appears. Follow any of these steps:
n Only for Microsoft Internet Explorer. Click Add Bookmark. A bookmark to the reportlet is

automatically added to the browser with a new entry to the Favorites list..

n Only for Mozilla Firefox. Create a new bookmark by using the displayed URL.

The bookmarked URL retains all the properties of the reportlet.

Create Bookmarks in Reports
NNM iSPI Performance enables you to create bookmarks for reports in the NPS home page.

These bookmarks encapsulate all the selected settings (Time, filters, Options) and enable you to be
able to quickly visit the report. again from your browser.

Bookmarks are also convenient for emailing and sharing reports.

If you want the bookmark to open the report within the same time range as the original report, make
sure to select a non-relative time range (for example, Start Date/Time with ‘1 Hour’ and not ‘Last 1
hour’ as the time range). Otherwise, the report will show themost recent data.

To create a bookmark for a report:

1. Launch a report.

2. Click Show Bookmark. A URL appears. Follow any of these steps:
n Only for Microsoft Internet Explorer. Click Add Bookmark. A bookmark to the report is

automatically added to the browser with a new entry to the Favorites list..
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n Only for Mozilla Firefox. To create a new bookmark by using the displayed URL, right click
on the URL and then select Bookmark This Link.

The bookmarked URL retains all the properties of the report.

Add URL Actions in the NNMi Console
After you generate a bookmark, you can create a new Actions menu item with the newly generated
bookmark, which enables you to launch the report or the reportlet of your choice directly from the
NNMi console.

To add URL actions in the NNMi console to launch a report or reportlet:

1. Generate the bookmark for the required report. Or, generate the bookmark for the required
reportlet.

2. In the NNMi console, select the Configuration workspace from the workspace navigation
panel.

3. Select User Interface.

4. Select Menu Items.

5. Click (New).

TheMenu Item form opens.

6. In the basics section of theMenu Item form, specify the following details:
n Menu Item Label:1

n Unique Key:2

n Author:3

n Parent Menu:4

n Ordering:5

n Prepend Separator:6

n Enable:7

1The name of the report or reportlet that you want to launch.
2A unique identifier for themenu item. Type an identifier with themaximum of 80 characters.

You can use alpha-numeric and period (.) characters. Do not use spaces and underline characters.
Tomake sure that the value is unique, use the Java name space convention while specifying this
value. Include theMenu Item Label value as part of the unique key as shown in the following
example: com.<company_name>.nnm.menu.item.<menu_item_label>.
3You can specify the default value Customer, or click to add a new author name (for example:
NPS).
4Retain the default value—Actions.
5Specify an integer between 1 and 100. The lowest number appears at the top of the Actions menu.
The highest number appears at the bottom of the Actions menu.
6Select this option to add a horizontal line before the report or reportlet menu item in the Actions
menu.
7Select this option to use the report or reportlet bookmark.
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7. Retain all other default settings in the Basics section.

8. In theMenu Item Context tab, click New.

TheMenu Item Context form opens.

9. In the Basics section, click , and then click New Launch
Action.

The Launch Actions form opens.

10. In the Launch Actions form, specify the following:
n Name in the Name box

n Bookmark URL in the Full URL section

11. Click Save and Close.

12. Click Save and Close in theMenu Item Context form.

13. Click Save and Close in theMenu Item form.

14. Click Save and Close in the User Interface Configuration form.

Now you can launch the report or reportlet from the Actions menu.

View a Report Using Different Report Formats
The default report format used by the Network Performance Server (NPS) and BI Server is the web-
based HTML format.

Using NPS, you can view a report in the following additional formats:

l Adobe PDF

l Microsoft Excel

To view a report in non-HTML format:

1. In the NNMi console, click Actions > Reporting-Report Menu. The NPS Home Page opens.

2. On the navigation panel, select theReports tab. The NPS presents the Self
Diagnosticreports for the default, ready-to-use Self Diagnostic extension pack.
Depending on the number of the NNM iSPI products or extension packs available on the NPS
system, youmay seemany other report folders.

3. Under an extension pack (Example: Component Health, Interface Health, etc), select a report.

4. In the TimeControls tab, select a time range for the report. For information on selecting the
time range for a report, see Change TimeControls.

5. Click View in HTML Format.

6. Select one of the following options:
n For the PDF format, click View in PDF Format. A PDF version of the report appears in the

same browser window.
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n For theMicrosoft Excel format, click View in Excel Options, and then click View in Excel
2007 Format, View in Excel 2002 Format, orView in Excel 2000 Single Sheet Format.
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Troubleshooting Tips
Click the appropriate link from the lists below to display its details :

NNMi console Actionmenu has no link to Reporting – Report menu

Does the BI Server have guidelines for tuning performance?

An error message says that NNMi is not polling one or more objects for performance data. What
went wrong?

If I leave a report, and return later, I see a login screen. Why?

I'm waiting too long for reports to display. What can I do to improve the run-time?

When I leavemy browser open for a while, I losemy connection and I can't get logged in again.

Where can I findmore information about polling?

Why am I being asked to log in again when I navigate from NNMi to a report?

Why are exception counts missing from reports?

Errors and Warnings Glossary

A B C D E F General

Message Type Cause/Suggested Actions

A Top

Attempting to extend allocated space for
DBSPACE {DB_SPACE} using dbsize.ovpl

WARN The database requires additional
disk space; the ETL process will
allocatemore.

Attempting to restart HP BI Server Processes WARN The BI server process has stopped
while ETL is running. ETL will
attempt to restart the process.

Attempting to restart HP DB Server WARN The database server process has
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Message Type Cause/Suggested Actions

stopped while ETL is running. ETL
will attempt to restart the process.

Automatic NNMHA add-on configuration failed:
Exit Code {EXIT_CODE}

ERROR High availability configuration failed.

B Top

BI Processes not running. WARN The BI server process has stopped
while ETL is running.

BI Processes still not running.. restart attempt
failed.

ERROR The BI server process has stopped
while ETL is running. ETL has
attempted to restart the process but
failed to do so, and ETL cannot
continue. Try starting the BI server
process manually using
startBI.ovpl.

C Top

Cannot extract remote nnm hostname from value
of PRSPI_NNMDIR ({PRSPI_NNMDIR})

ERROR On a dedicated server installation,
the configuration entry for the NNMi
shared directory should contain the
name of the NNMi server. Failure to
determine this hostname affects
application failover configurations.

Cannot find the OV Install Dir <{DIR}>. ERROR %nnminstalldir% does not exist.
Check the NNMi installation.

Cannot find the nnm.ports.properties file to
establish port for jboss http server.

ERROR If the jobs port cannot be determined
the iSPI cannot be enabled. Check
the NNMi installation.

Check NNMHA environment then run
nnmenableperfspi.ovpl.

ERROR Enabling iSPI in an HA environment
must be done in a specific order.
See the HA-specific topic in the
NNMi Deployment Guide for more
information.

Check your environment for NNM environment
variables then run nnmenableperfspi.ovpl.

ERROR Some or all required NNMi variables
cannot be determined. Check the
NNMi installation.

Command Failed: {PERL} getNNMActiveScript:
{CHILD_ERROR}

ERROR An application failover specific
script has failed. Check your
application failover environment.
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Message Type Cause/Suggested Actions

Command Failed: {UNZIP} {ZIPFILE}: {CHILD_
ERROR}

ERROR An error occurred unzipping the
identified file. The CHILD_ERROR
may givemore information (corrupt
zip file, permissions issue etc.)

Command:
{OVDIR}/misc/nnm/ha/nnmhaclusterinfo.ovpl -
config NNM -get HA_PERFSPI_ADAPTER_DIR

ERROR A high availability specific script has
failed. Check your high availability
environment.

Command:
{OVDIR}/misc/nnm/ha/nnmhaclusterinfo.ovpl -
config NNM -get NNM_INTERFACE

ERROR A high availability specific script has
failed. Check your high availability
environment.

Command:
{OVDIR}/misc/nnm/ha/nnmhaconfigure.ovpl NNM
-addon PerfSPIHA

ERROR A high availability specific script has
failed. Check your high availability
environment.

Configuration file contains errors. ERROR The iSPI configuration file contains
errors, check the associated error
messages for specifics.

Configuration: Unable to access directory
{PRSPI_METRICS}

ERROR The shared directory for metrics is
inaccessible. Check that NFS or
Samba is operating properly.

Configuration: Unable to access directory
{PRSPI_NNMDIR}

ERROR Themain shared directory is
inaccessible. Check that NFS or
Samba is operating properly.

Configuration: Unable to access directory
{PRSPI_TOPODUMP}

ERROR The shared directory for topology
information is inaccessible. Check
that NFS or Samba is operating
properly.

Configuration: directory {PRSPI_METRICS}must
have write access

ERROR The shared directory for metrics is
not writable. Check your NFS or
samba configuration and file
permissions.

Configuration: directory {PRSPI_TOPODUMP}
must have write access

ERROR The shared directory for topology
information is not writable. Check
your NFS or samba configuration
and file permissions.

Configuration: java not found in 'java_dir' ({java_
dir})

ERROR TheHP Java installation appears to
be corrupted.

Configuration: perl not found in 'perl_dir' ({perl_dir}) ERROR TheHP Perl installation appears to
be corrupted.

Configuration: {NAME} not defined. ERROR A required configuration parameter
is not defined.
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Message Type Cause/Suggested Actions

Configuration: {NAME} valuemust be a valid path.
Invalid value: {VALUE}

ERROR A required configuration parameter
must be a valid path and it is not.

Configuration: {NAME} valuemust be numeric.
Invalid value: {VALUE}

ERROR A required configuration parameter
must be numeric and it is not.

D Top

DB Processes still not running.. restart attempt
failed.

ERROR The database server process has
stopped while ETL is running. ETL
will has attempted to restart the
process but failed to do so. ETL
cannot continue. Try starting the
database server process manually
using startDB.ovpl

DBSPACE {DBSPACE}, FILE {FILE}: Cannot
extend because there is no reserve space left.

WARN The database needs to be extended
but cannot because there is no disk
space available. You should free
existing disk space or add new
disks before your database runs out
of space.

DBSPACE {DBSPACE}, FILE {FILE}: Cannot
extend {PATH} because there is insufficient disk
space left on file system.

WARN The database needs to be extended
but cannot because there is no disk
space available. You should free
existing disk space or add new
disks before your database runs out
of space.

Database Processes not running! WARN The database server has stopped
while ETL is running

Dropping connection_id {CONNECTION_ID} WARN The specified connection is being
dropped. This is normally a
transparent operation for report
users.

E Top

Error - Unable to remove the nnm actions for iSPI
for Performance

WARN Check NNM is running. You can
also remove actions from the NNMi
console.

Error running dbisql: {DB_ERROR} ({SQL}) WARN The described SQL error occurred.
Check for other messages
associated with this one.

Expected PRSPI_NNMDIR of form
/net/hostname/var... or //hostname/PerfSpi

WARN On a dedicated server install the
NNM directory path should be one
of the forms shown.
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Message Type Cause/Suggested Actions

Extension Pack {EXTENSION_PACK}: process
not running. Restarting

WARN An ETL process had to be restarted.

F Top

Failed archiving logfile PerfSPI_Diagnostic_
Metrics.log

WARN The log archive process failed.

Failed archiving logfile prspi.log WARN The log archive process failed.

Failed building extensionPack for new or updated
NNMmetadata: {METADATA}

ERROR This should not be encountered by
customers.

Failed chdir to {DIR}: {OS_ERROR} ERROR Failed changing directory to the
specified directory, the OS error
may givemore information
(directory does not exist,
permissions etc.)

Failed command:copy({FILE_LIST}):{OS_
ERROR}

WARN Failed copying the specified files,
the OS error may givemore
information (directory does not
exist, permissions etc.)

Failed command:copy({FILE_LIST}):{OS_
ERROR}

ERROR Failed copying the specified files,
the OS error may givemore
information (directory does not
exist, permissions etc..) The
program immediately exits.

Failed command:fork():{OS_ERROR} ERROR Failed forking (creating a new
process), the OS error may give
more information (lack of system
resource, etc..) The program
immediately exits.

Failed command:mkpath({PATH_LIST}):{OS_
ERROR}

ERROR Failed creating the specified
directories, the OS error may give
more information (directory does not
exist, permissions etc..) The
program immediately exits.

Failed command:mkpath({PATH_LIST}):{OS_
ERROR}

WARN Failed creating the specified
directories, the OS error may give
more information (directory does not
exist, permissions etc..)

Failed command:move({FILE_LIST}):{OS_
ERROR}

ERROR Failedmoving the specified files,
the OS error may givemore
information (directory does not
exist, permissions etc..) The
program immediately exits.
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Message Type Cause/Suggested Actions

Failed command:move({FILE_LIST}):{OS_
ERROR}

WARN Failedmoving the specified files,
the OS error may givemore
information (directory does not
exist, permissions etc..)

Failed command:open({HANDLE},{ARGS}):{OS_
ERROR}

ERROR Failed opening the specified file, the
arguments andOS error may give
more information (directory does not
exist, permissions etc..) The
program immediately exits.

Failed
command:open({HANDLE},{FLAG},{ARGS}):{OS_
ERROR}

ERROR Failed opening the specified file, the
arguments andOS error may give
more information (directory does not
exist, permissions etc..) The
program immediately exits.

Failed command:opendir(DIR,{DIR Configuration:
{NAME} not defined.NAME}):{OS_ERROR}

WARN Failed opening the specified
directory, the OS error may give
more information (directory does not
exist, permissions etc..)

Failed command:system({COMMAND}:{CHILD_
ERROR})

WARN Failed running the specified system
command, the OS error may give
more information (lack of system
resources etc..)

Failed command:system({COMMAND}):{CHILD_
ERROR}

ERROR Failed running the specified system
command, the OS error may give
more information (lack of system
resources etc..) The program
immediately exits.

Failed command:unlink({FILE_LIST}):{OS_
ERROR}

ERROR Failed removing the specified files,
the OS error may givemore
information (directory does not
exist, permissions etc..) The
program immediately exits.

Failed command:unlink({FILE_LIST}):{OS_
ERROR}

WARN Failed removing the specified files,
the OS error may givemore
information (directory does not
exist, permissions etc..)

ERROR Failed copying file from specified
source to destination, the OS error
may givemore information
(directory does not exist,
permissions etc..)

Failed copying {SRC} to {DEST}: {OS_ERROR} ERROR
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Message Type Cause/Suggested Actions

Failed creating {FILE}: {OS_ERROR} ERROR Failed creating the specified file, the
OS error may givemore information
(directory does not exist,
permissions etc..)

General Warnings Top

<Package name> WARN This warning can appear for any one
of the following reasons:

l There is no data in the topology
tables for the displayed package.

l The topology filters chosen will
result in empty reports.

l The topology filters chosen are
not appropriate for the selected
package and will be dropped.

The system is currently running with
demonstration data!

WARN The system is currently running with
demonstration data.

Problem: Reports Take Too Long to Display
Do you think any of the following caused the problem?

Diagnosis Step 1 Did NNMi experience a recent topology reset?

Diagnosis Step 2 Were one or more interface groups recently added to performancemonitoring?

Diagnosis Step 3 Are a large number of users logged in to the system?

Diagnosis Step 4 Are the hardware resources over-utilized?

General Resolution Tips
l Create a report view with the required prompts and schedule this report view to run on a regular

basis. Then view the scheduled output, or bookmark a URL to view the scheduled output. For
more information on scheduling reports, see Schedule Report Delivery.

l Filters can improve report performance. A report on a specific node group is generally faster than
a report on All Nodes/Interfaces; the same logic applies to the time dimension. For more
information on report filters, see the following topics:
n Set Topology Filters

n Change TimeControls

l Run the same report again. Data caching, which took place the first time you ran the report, will
decrease the run time the next time you run the same report.
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Problem: User Needs to Re-Login while Navigating from
NNMi to a NNM iSPI Performance Report

This problemmay occur if you launched the NNM console using the IP address of the NNMi
system and not the NNM's fully-qualified domain name (FQDN).

Resolution
Always use the FQDN of the NNMi system to log into NNMi Console.

Explanation
Whenever youmove from NNMi to the a report, account information is passed between your NNM
login session and the NPS using cookies in your browser. A function known as Single Sign-On
(SSO)makes it possible for you tomove from NNM to a report without having to log in a second
time.

For SSO to operate, the following conditions must bemet:

l The NNMi system and the NPS systemmust be configured with fully qualified domain names.

l Youmust use the fully-qualified domain in your browser (not "localhost" or themachine name
minus the domain) when you launch the NNMi console.

A fully-qualified domain name (FQDN) has this format:

http://fully_qualified_domain_name:port/nnm

If NNMi and the NPS are installed on the samemachine, the SSO function will operate if you use
either of these:

l NNM's FQDN

l NNM's IP address

The NPS is responsible for configuring use of NNMi's IP address; this step takes place
automatically, when the NPS is installed.

Problem: NNMi Console Action Menu Has No Link to
Reporting – Report menu

The NNMi console does not display theReporting-Report menu item in theActionmenu if you
do not completely (and successfully) run the enablement script. Follow the Installation Guide to run
the enablement script (nnmenableperfspi.ovpl) on the NNMi management server.

Error: NNMi Is Not Polling One or More Objects for
Performance Data

Do you think any of the following caused the problem?
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Diagnosis Step 1 Is NNMi polling the specified device, or devices, for performance data?

Diagnosis Step 2 Can NNMi synchronize the topology information with NPS?

Problem: Leaving a Report Open Requires Re-Login
The NPS requires you to re-login to view a report under the following circumstances:

l You are trying to access the NPS without being authenticated by NNMi.

l You pointed your browser at the NPS without logging into NNMi first.

l Your browser session has expired.

Resolution
Log in again to return to the NPS.

Problem: Leaving the Browser Open for a While Prevents
Re-Login

The inactivity timeout setting for the NPS is one hour. If your browser is inactive for an hour, your
session will expire. If your session expires, the NPS requires you to log in again. The login window
requires the administrator username and password.

Resolution
1. Close the timeout login window.

2. Log into the NNMi console using the standard URL:
http://fully-qualified-hostname:port;/nnm

3. Navigate to the NNM iSPI Performance report that you were using.

Problem: Exception Counts Are Missing from Reports
Before you can resolve this problem, follow this navigation path to diagnose the cause of the error:

Diagnosis
Did you define thresholds in NNMi?

Resolution
Setting up thresholds in NNMi requires administrator privileges. Follow these steps to locate
applicable help topics:

1. Launch the NNMi console.

2. Click Help→Help for Administrators.

3. Select Configure Threshold Monitoring for Nodes

Immediately after thresholds are set, exceptions will begin to register in reports.

Problem: The NPS Stops Functioning and Does Not Show
Any Report

Before you can resolve this problem, follow this step to diagnose the cause of the error:
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Diagnosis
Did you change the address or hostname of the NPS Server?

Resolution
Change the IP address, hostname, or MAC address of the NPS server, after following these steps:

1. On the NPS server, run the following command:

OnWindows:
%NPSInstallDir%\NNMPerformanceSPI\bin\stopAll.ovpl

On Linux:
/opt/OV/NNMPerformanceSPI/bin/stopALL.ovpl

2. Open the BI Server configuration GUI with the following command:

OnWindows:
%NPSInstallDir%\NNMPerformanceSPI\bin\runBIConfigGUI.ovpl

On Linux:
/opt/OV/NNMPerformanceSPI/bin/runBIConfigGUI.ovpl

3. Click File > Export As.

4. Specify a location and a file name in the dialog box, and then click Save.The configuration data
is saved in the XML format.

5. Delete the following directories manually:

OnWindows:
%NPSInstallDir%\nonOV\cognos\c8\configuration\signkeypair

%NPSInstallDir%\nonOV\cognos\c8\configuration\encryptkeypair

On Linux:
/opt/OV/nonOV/cognos/c8/configuration/signkeypair

/opt/OV/nonOV/cognos/c8/configuration/encryptkeypair

6. Copy the XML file saved in step 3 to the following directory:

OnWindows:
%NPSInstallDir%\nonOV\cognos\c8\configuration

On Linux:
/opt/OV/nonOV/cognos/c8/configuration

Finding More Information about Polling
Performance polling has an impact on NNMi and it also has an impact on your network. If you
enable additional performance polling, NNMi needs to allocate a portion of its resources to handle
the additional polling, and your network will have to accommodate an increase in SNMP traffic. To

HP Network NodeManager iSPI Performance for Metrics Software (9.10)Page 86 of 89

Online Help
Troubleshooting Tips

../../../../../Content/Trouble_Shooting_Tips/PerfSpi_TSG_12101.htm
../../../../../Content/Trouble_Shooting_Tips/PerfSpi_TSG_12101.htm
../../../../../Content/Trouble_Shooting_Tips/PerfSpi_TSG_12101.htm
../../../../../Content/Trouble_Shooting_Tips/PerfSpi_TSG_12101.htm
../../../../../Content/Trouble_Shooting_Tips/PerfSpi_TSG_12101.htm
../../../../../Content/Trouble_Shooting_Tips/PerfSpi_TSG_12101.htm
../../../../../Content/Trouble_Shooting_Tips/PerfSpi_TSG_12101.htm
../../../../../Content/Trouble_Shooting_Tips/PerfSpi_TSG_12101.htm
../../../../../Content/Trouble_Shooting_Tips/PerfSpi_TSG_12101.htm
../../../../../Content/Trouble_Shooting_Tips/PerfSpi_TSG_12101.htm
../../../../../Content/Trouble_Shooting_Tips/PerfSpi_TSG_12101.htm


ensure that the performance polling does not cause in wasted resources, it is important to limit
performance polling to the important devices.

You need NNMi administrator privileges to enable performance polling. Follow these steps to locate
applicable help topics:

1. Launch the NNM console.

2. Click Help→Help for Administrators.

3. SelectMonitoring Configuration.

Finding More Information about Creating New Node Groups
Creating a new node group involves setting device-level filters. After you create the new node
group, youmay want to use the group as a way to filter NNMi views, and youmight also want to
add the node group as a filter to the iSPI element selection tree.

Creating node groups, and using the filter options, are NNMi administrator tasks. Follow these
steps to locate applicable help topics:

1. Launch the NNMi console.

2. Click Help→Help for Administrators.

3. SelectMonitoring.
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Self Diagnostics
The Self Diagnostics extension pack monitors the health of the processes which function within the
NPS.

Some of the tasks that these reports enable you to perform, are:

l Investigate how the processes within the NPS are performing by looking at Self Diagnostic
reports.

l Analyze if themetrics measuring NPS performance are within the acceptable (normal) range.

l Compare the performances of various NPS processes for selected time range.

l Analyze the performance of various NPS processes during the busiest tome of the day.

Monitor the Health of the NPS and Extension Packs
The reports generated by the Self Diagnostic extension pack helps youmonitor the health and
performance of the processes that build up the core functionality of the NPS. The reports also help
youmonitor the performance of different extension packs available on the NPS system.

The Self Diagnostic extension pack identifies every process on the NPS system as a task. Every
task is grouped under relevant task type, task category, and extension pack in the following order:

Task Categories

The NPS uses two broad categories to group all processes—ETL and Report Generation.

Task Types

Under the ETL category, the NPS groups relevant process under the following task types:
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l build_groupcache_from_db

l build_topcache_from_db

l checkAggregates

l process_group_dump_file

l process_metricsfiles

l process_metricsfiles->bulkload archive table

l process_metricsfiles->bulkload live table

l process_metricsfiles->prepare_baselining

l process_metricsfiles->Sorting CSV files

l process_metricsfiles->preprocessing

l process_retention->aggregate table

l process_retention->live table

l process_retention->archive table

l process_retention->timeDimension table

l process_summary->Summary Child Proc

l process_summary->Summary Parent Proc

l process_topodump_file

Tasks

The NPS monitors and administers essential processes as tasks running on the NPS system. All
such processes are introduced by different extension packs on the system. The processes are
named in the following format:

extension_pack_name>.<task_category>.<task_type>

Metrics

Some of themetrics that you can use in the Self Diagnostics reports are as follows:

l Process Time (time in seconds for the task to complete)

l Number of Rows (applies to select tasks, such as ETL bulk loads, and so on)

l Available SystemMemory – shows freememory (on Linux, free and cached) enabling you to see
if your system’s memory usage is increasing, causing available memory to decrease. Low
available memory can cause system performance to degrade.

l Available Disk Space – enables you tomonitor your disk usage in the ‘Data Directory’ file
system. By plotting the Available Disk trend over time, you can see if your disk usage has
reached a steady state, or if you are on a trajectory to run out of disk space.

Calendar Report
The Calendar Report uses a traditional, calendar-style layout to show hourly statistics for two
metrics in a single, extended graph spanning over multiple days.

To change the TimeControls defaults, see Change TimeControls.
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To change the Topology Filters defaults, see Set Topology Filters.

To change the Report Options defaults, see Change Report Options.

Features and Defaults

The Calendar Report defaults to:

l Task Categories, Task Types, and Task Names= All

l Dates/Times = Last 31 days

l Metric(s) Shown on Y1 Axis = Process Time (secs)(avg)

l Metric(s) Shown on Y2 Axis = Process Time (secs)(min)

The default view shows data for the current month. Depending on how long the NPS has been
collecting data, youmay have the option of looking at data for the previous 70 days if you use the
option Until Now.

Use Case

Use this report to observe:

l gradual trends over time

l isolated spikes

l to verify that an abnormal condition has returned to normal

l to make comparisons

This report also reveals:

l Day of week patterns

l Hour of day patterns

Chart Detail Report
The Chart Detail report enables you to perform a trend analysis for the NPS process health and
performance based on historical performance data.

The Chart Detail report displays a comparative analysis of the selectedmetrics for each time unit.

For example, if you need to compare how the average Threshold Exception Rate was affected by
variance in the average Process Time permillisecond for the past one week, you can generate the
Weekly Performance Diagnostics report for the selected node group.

You can also select two or more task type, task name, extension pack, etc to generate Chart Detail
report.

Using this report you can:

l Analyze the trend of network health and performance for multiple task type, task name,
extension pack, etc based on one unit of time. Each unit of time is called as a Display Grain .
Each Display Grain is measured as follows:
n Fiveminutes for Hourly report

n One hour for daily report
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n One day for weekly report

n One day for monthly report

l Identify any ups and downs in the health and performance of the NPS processes.

l Compare the health and performance of more than two task type, task name, extension pack,
etc based on historical health and performance data.

The following are the available filters in the TimeControls pane for Chart Detail Report:

l Start Date/Time

l TimeRange

l Display Grain

l Hour of day

l Day of Week

To change the TimeControls defaults, see Change TimeControls.

To change the Topology Filters defaults, see Set Topology Filters.

To change the Report Options defaults, see Change Report Options.

Features and Defaults

The graph on this report tracks up tometrics over the selected time period. Unless youmodify the
defaults, Chart Detail defaults to the following:

l Task Categories, Task Types, and Task Names = All

l Primary metric = Process Time (secs)(avg)

l Secondary metric = Process Time (secs)(min)

To add another primary or secondary metric, click Options and then click .

To remove a primary or secondary metric that you have already added, click Options and then click

The Chart Detail report enables you to view the data in the tabular format as well. To view the table,
click Options, and then select Table. The Table appears instead of the chart. To view both the
chart and the table, click Options, and then select Chart and Table.

Heat Chart Report
The Heat Chart Report tracks the hourly performance of a single metric. The default metric is
Process Time (secs) (avg). The default time period is the last 24 hours. Performance is color-
coded, making it easy to spot a condition that is gradually worsening andmaking it easy to
distinguish satisfactory performance from unsatisfactory performance.

The following are the available filters in the TimeControls pane for Heat Chart Detail:

l Start Date/Time

l TimeRange

l Display Grain
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l Auto Refresh

l Hours of Day

l Day of Week

To change the TimeControls defaults, see Change TimeControls.

To change the Topology Filters defaults, see Set Topology Filters.

To change the Report Options defaults, see Change Report Options.

Features and Defaults

The legend at the top of the report ties a range of normalized performance values to a particular
color. Any value within that range will get that color. Beneath the legend, each day of themonth is
listed left to right, day 1 through 31. Down the side of the report is each hour of the day. Each cell
inside the table is color-coded and each cell inside the table indicates a specific value. You can
move themouse pointer on a cell to view raw data.

The Heat Chart defaults to:

l Time Period = Last 24 hours

l Hour of Day = All

l Day of Week = All

l Metric = Process Time (secs) (avg)

Managed Inventory Report
Use theManaged Inventory Report to view the list of available topology attributes. You can use the
available attributes to filter the data of your interest and create a report that represents only the
elements of your interest. The report presents the list of attributes in the form of a table; the Count
column of the table indicates the number of entries for each attribute.

For the topology item Extension Pack, the Count column indicates the number of available
extension packs on the NPS system.

For the topology item Task Category, the Count column indicates the number of task categories
created by the NPS.

To change the TimeControls defaults, see Change TimeControls.

To change the Topology Filters defaults, see Set Topology Filters.

Most Changed Report
This report compares performance for two different (consecutive) time periods and ranks processes
by the amount of change. The sort order is most-changed to least-changed.

To change the TimeControls defaults, see Change TimeControls.

To change the Topology Filters defaults, see Set Topology Filters.

To change the Report Options defaults, see Change Report Options.

Features and Defaults

This report contains one table and provides data for onemetric only.
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Following are the columns in the table:

l Performance for the previous time period

l Performance for the selected time period

l Growth, expressed as a percentage increase

l Change

TheMost Changed report defaults to:

l Dates/Times = Last Day (and the day before)

l Hour of Day = All

l Day of Week = All

l Rank Metric = Process Time (secs)(avg))

l Top N Option = Top 10

If you select amonth, the report will compare twomonths (themonth you selected and the prior
month); if you select a week, the report will compare two weeks (the week you selected and the
prior week).

Self Diagnostics Peak Period Report
The Self Diagnostics Peak Period Report ranks the performance of an NPS processes during the
busiest time of the selected time range.

Using this report, you can:

l Identify the performance and utilization of the selectedmetrics during the peak period.

l Identify the NPS processes that have the highest or lowest performances during the peak
period.

l Compare the performance for multiple NPS processes during the peak period using this report.

Self Diagnostics Peak Period Report Options

l Top / Bottom N1

l Metric2

l Grouping by Time Period3

This report tracks up to six metrics over the selected time period.

To add another metric, click Options and then click

To remove ametric that you have already added, click Options and then click .

1Select a rank between top or bottom five, ten, 25, 50, 100, all descending, and all ascending for the
selected component.
2Select themetric based on which you want to generate the report. Themetric that you select is
used to rank the report data.
3Enables you to group the report data based on a specific time grain. Click Add New Grouping icon
to add a new group.
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To select a range of value for themetric, click and select a range of metric value that the report
should consider.

For example if you want to see the top five interfaces with the averagememory utilization between
10% and 90%, select 10 as Lowest value and 90 as theHighest value.

By default, the report groups data by Time Period. You can select multiple grouping attributes by

using the (Add New Grouping) button. Use the (Remove Grouping) button to remove a
grouping attribute.

Tip:

l Use this report to identify the period when the NPS processes performance was the lowest.

l Check this report once a day to see which NPS processes may need special attention.

To change the TimeControls defaults, see Change TimeControls.

To change the Topology Filters defaults, see Set Topology Filters.

To change the Report Options defaults, see Change Report Options.

Top 10 Task Duration Report
The Self Diagnostics extension pack monitors the health of all the ETL and report generation
processes on the NPS system. You can easily investigate how the ETL processes and reports are
performing by using the Top 10 Task Duration Report.

This report monitors the Top 10 ETL and report generation processes and tracks the time taken by
each process during the selected time range.

To change the TimeControls defaults, see Change TimeControls.

Top N Report
This report ranks the NPS processes by themetric you select. Use this report to spot the process
that performed at the extremes. You can use this report to analyze the historical data for the
processes that are exhibiting unusual performance levels.

Some of the topology filters that you can use to generate this report are as follows:

l Extension Pack

l Task Category

l Task Type

l Task Name

Using this report you can:

l Rank the performance of the extension packs and tasks running on your Performance iSPI
server.

l Detect the underlying reason of a persistent problem with a process. You can compare the
performance for multiple tasks using this report.
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Example

Some of the processes in your network are performing poorly. Using this report, you can group the
processes reporting highest processing time. The process reporting the highest processing time is
ranked first.

Performance SPI Top N Reports Options

The Top N report displays the following options:

l Top/Bottom 'N '1

l
Metric2

l Display Time Series Chart3

l
Grouping By4

This report tracks up to six metrics for eachmetric type over the selected time period.

To add another metric, click Options and then click .

To remove ametric that you have already added, click Options and then click .

To select a range of value for themetric, click and select a range of metric value that the report
should consider. For example if you want to see the average process time for the Self Diagnostics
extension pack between the range of 100 and 500 seconds, select 100 as minimum value and 500
as themaximum value.

By default, the report groups data by Extension Pack. You can select multiple grouping attributes

by using the (Add New Grouping) button. Use the (Remove Grouping) button to remove a
grouping attribute.

Tip :

l By default, Top N Report is displayed without Time Series Chart. Click Display Time Series
Chart to view the chart with the detail table.

l Check this report once a day to see which extension pack or process may need special
attention.

1Select a rank between top or bottom five, ten, 25, 50, 100, all descending, and all ascending for the
selected NPS processes.
2Select themetric based on which you want to generate the report. Themetric that you select is
used to rank the report.
3Select Yes to view the detail chart with the table. Select No to hide the chart and display only the
table. The created Top N Report displays the graphical representation of themetric values for the
NPS processes over the selected time range.
4E Enables you to group the report data based on a specific parameter. Click to add a subgroup.
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l Check this report periodically throughout the day to see which extension packs or processes are
performing at the extremes andmay need special attention.

To change the TimeControls defaults, see Change TimeControls.

To change the Topology Filters defaults, see Set Topology Filters.

To change the Report Options defaults, see Change Report Options.

Self Diagnostics Top N Chart
Like the Top N report, this report also ranks the NPS processes by themetric you select.

Using this report, you can:

l Spot the NPS processes that performed at the extremes.

l Detect the NPS processes having a performance problem.

Self Diagnostics Top N Chart Options

The Top N Chart displays the following options:

l Top / Bottom N1

l Metric2

l Grouping By3

This report tracks up to six metrics over the selected time period.

To add another metric, click Options and then click

To remove ametric that you have already added, click Options and then click .

To select a range of value for themetric, click . and select a range of metric value that the report
should consider.

For example if you want to see the top five interfaces with the average availability between 10%
and 90%, select 10 as Lowest value and 90 as theHighest value.

By default, the report groups data by Extension Pack. You can select multiple grouping attributes

by using the (Add New Grouping) button. Use the (Remove Grouping) button to remove
a grouping attribute.

Tip :

Check this report once a day to see which NPS processes may need special attention.

To change the TimeControls defaults, see Change TimeControls.

1Select a rank between top or bottom five, ten, 25, 50, 100, all descending, and all ascending for the
selected component.
2Select themetric based on which you want to generate the report. Themetric that you select is
used to rank the report data.
3Organize the report data based on a specific parameter. Click Add New Grouping icon to add a
new group.
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To change the Topology Filters defaults, see Set Topology Filters.

To change the Report Options defaults, see Change Report Options.

NNM iSPI Performance for Metrics Reportlets
In a large enterprise network theNNM iSPI Performance products1may produce a large amount
of data and large cardinality. This means that these networks often have a very large amount of
unique IP addresses, source nodes and destination nodes, interfaces, and components each
producing large amount of data. Generating reports using such large data volumemay be time
consuming.

Reportlets enable you to generate quick impressions of the larger reports using the NNM iSPI
Performance for Metrics Dashboards.

Viewing NNM iSPI Performance for Metrics Reportlets
To display the reportlets:

1. Log in to NPS HomePage.

2. On the left navigation panel, select Dashboard Reportlets.

3. Select an extension pack and then select a reportlet.

You can also create custom dashboards using the reportlets. See Creating Custom Dashboards
Using BI Server Portal for information on the procedure to create the custom dashboards.

Calendar
Displays a comparative study of the selectedPrimary Metric2 andSecondary Metric3

The default display grain is set to one hour. You cannot change the display grain of this reportlet.

Enables you tomonitor the following:

l Daily system resource utilization by the NPS processes

l Volume of data processed by the NPS processes for the selected time range

l Performance of the NPS processes for the selected time range

This reportlet supports twometrics.

Gauge
Evaluates themetric for the selected point of time.

Enables you to:

1NNM iSPI Performance for Metrics, NNM iSPI Performance for Quality Assurance, and NNM
iSPI Performance for Traffic
2Enables you to select themainmetric based on which you want to generate the report. The
primary metric that you select is displayed on the left Y axis of the report.
3Enables you to select themetric that would overlay the primary metric. The secondary metric that
you select is displayed on the right Y axis of the report.
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l Measure the daily performance of the selectedmetric.

l Detect any abnormal or unexpected performance level.

This reportlet supports onemetric.

Heat Chart
Grades the performance of the selectedmetric for the selected time range.

Themetric performance is aggregated based on an hourly display grain.

Enables you to perform the following tasks:

l View how the NPS process performance gets affected by a varyingmetric.

l Compare the hourly performance of the selectedmetric.

l Detect the time range when the NPS process performance was affected adversely because of
the fluctuatingmetric value.

This reportlet supports onemetric.

Metric Snapshot
Displays themetric performance for the selected time range.

Enables you to:

l Build a performance history for the selectedmetric and analyze how themetric performance
changes over time.

Such history may help you to decide the baseline value for themetric

l Compare the performance for multiple metrics over a specified time range.

Though you can generate snapshot report for a single metric, you can save the snapshot report
for various metrics and compare the performance of eachmetric over a time range.

This reportlet supports onemetric.

Most Changed
Compares themetric performance between yesterday and today.

Aggregates the daily metric utilization and ranks the performance in a descending order.

Enables you to:

l Measure the performance fluctuations for the NPS processes.

l Detect the top N NPS processes having a common performance or utilization problem.

You can enhance the report usability using the following features:

l Top N

l Grouping By1

1Organize the report data based on a specific parameter. Click Add New Grouping icon to add a
new group.
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This reportlet supports onemetric.

Multimetric Chart
Analyzes the utilization trend for the selectedmetrics for the selected time range.

Enables you to perform the following tasks:

l Perform comparative analysis of the selectedmetrics for each display grain.

The default display grain is one hour.

l Analyze the reason for any ups and downs in the NPS process performance.

l Detect any persistent problem in the NPS process performance.

This reportlet supports up to six metrics.

Simple Bar and Line Chart
Displays the trend of NPS process performance for the selected time range using the following
values:

l Primary Metric1 on the bar chart

l Secondary Metric2 on the line chart

Enables you to:

l Compare the performance trends of multiple metrics.

l Analyze how the value of the secondary metric increases or decreases based on the increase or
decrease in the value of the primary metric.

This reportlet supports twometrics.

Simple Bar Chart
Compares the performance of twometrics for the selected time range.

Enables you to:

l Compare the performance trends of multiple metrics.

l Analyze how the value of the secondary metric increases or decreases based on the increase or
decrease in the value of the primary metric.

This reportlet supports twometrics.

Simple Chart
Analyzes the utilization trend for the selectedmetrics for the selected time range.

Enables you to:

1Enables you to select themainmetric based on which you want to generate the report. The
primary metric that you select is displayed on the left Y axis of the report.
2Enables you to select themetric that would overlay the primary metric. The secondary metric that
you select is displayed on the right Y axis of the report.

HP Network NodeManager iSPI Performance for Metrics Software (9.10)Page 12 of 16

NNM iSPI Performance for Metrics
Self Diagnostics



l Perform comparative analysis of the selectedmetrics for each display grain.

The default display grain is one hour.

l Analyze the reason for any ups and downs in the NPS process performance.

l Detect any persistent problem in the NPS process performance.

This reportlet supports twometrics.

Simple Table
Analyzes the utilization trend for the selectedmetrics for the selected time range.

The default display grain is one hour.

Enables you to:

l Analyze the hourly performance of themetrics.

l Detect any abnormal or unexpected NPS process performance.

l Analyze how the value of the secondary metric increases or decreases based on the increase or
decrease in the value of the primary metric.

This reportlet supports twometrics.

Sparkline
Evaluates the trend of how the selectedmetric value has changed for the selected time range.

Enables you to perform the following tasks:

l Analyze the variations in the performance for the selectedmetric.

l Decide whether the expected behavior for the selectedmetric should be reassessed.

This reportlet supports onemetric.

Top N Chart
Ranks the individual contribution of eachmetric for the NPS process performance for the selected
time range.

The performance of the NPS process is aggregated on hourly basis.

Enables you to:

l Spot the NPS processes for which the performancemetrics present extreme values.

l Investigate the aggregated data for the NPS processes that are exhibiting unusual utilization
levels.

l Select themetric based on which you want to generate the report. Themetric that you select is
used to rank the NPS processes.

l Group the report data based on a specific parameter. Click Add Group to add a subgroup.

This reportlet supports onemetric.

Top N Line Chart
Ranks the utilization trend for the selectedmetrics for the selected time range.
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The performance of the NPS process is aggregated on hourly basis.

Enables you to:

l Spot the NPS processes for which the performancemetrics present extreme values.

l Investigate the aggregated data for the NPS processes that are exhibiting unusual utilization
levels.

l Select themetric based on which you want to generate the report. Themetric that you select is
used to rank the NPS processes.

l Group the report data based on a specific parameter. Click Add Group to add a subgroup.

This reportlet supports onemetric.

Top N Stacked Chart
Ranks the individual contribution of each NPS process based on the selectedmetrics.

The performance of each NPS process is aggregated for the default display grain of one hour.

Enables you to:

l Spot the NPS processes for which the performancemetrics present extreme values.

l Investigate the aggregated data for the NPS processes that are exhibiting unusual utilization
levels.

This reportlet supports onemetric.

Top N Table
Ranks the NPS processes based on the selectedmetric.

Enables you to:

l Spot the NPS processes for which the performancemetrics present extreme values.

l Investigate the aggregated data for the NPS processes that are exhibiting unusual utilization
levels.

l Select themetric based on which you want to generate the report. Themetric that you select is
used to rank the NPS processes.

l Group the report data based on a specific parameter. Click Add Group to add a subgroup.

This reportlet supports onemetric.

Top N Table With Bars
Ranks the NPS processes based on the selectedmetric and displays a horizontal bar to depict the
aggregatedmetric value.

Enables you to:

l Spot the NPS processes for which the performancemetrics present extreme values.

l Investigate the aggregated data for the NPS processes that are exhibiting unusual utilization
levels.
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l Select themetric based on which you want to generate the report. Themetric that you select is
used to rank the NPS processes.

l Group the report data based on a specific parameter. Click Add Group to add a subgroup.

This reportlet supports onemetric.
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Welcome to the iSPI Performance for Metrics
The iSPI Performance for Metrics enables the combination of NNMi and iSPI Performance to
produce rich and insightful reports from the network performance data collected by NNMi. With the
introduction of extension packs that add definitions to generate reports, the iSPI Performance for
Metrics presents you with ready-to-use report templates that offer meaningful representation of the
aggregated data gathered from NNMi.

The iSPI Performance for Metrics introduces the following extension packs:

l Interface Health: Creates reports that help you examine theMIB II interface statistics.

l Component Health: Creates reports that examinememory, CPU, and buffer utilization.

l Path Health: Uses data from the other two sources—Interface Health and Component Health—
to create reports on network paths built with a combination of nodes and interfaces.

The iSPI Performance for Metrics removes most of the labor required to detect a network problem
and pinpoint the cause. The iSPI Performance for Metrics automates the following chores:

l Exception reporting

l Ranking

l Trending

Exception reporting highlights threshold conditions, providing an easy way to spot abnormal
performance. Ranking sorts elements by themetric of your choice and allows you to identify
network elements with unusually high or unusually low values. If an element in the network is
experiencing unusual or extreme performance, ranking will make that element easy to spot.
Trending looks at a period of time and lets you see whether performance is stable, getting worse, or
improving.

In addition to reporting exceptions, ranking elements, and displaying trends, the iSPI Performance
for Metrics lets you drill down on any aggregate of data until you isolate the node, interface, or
component responsible for the condition you are investigating. After you locate the element, you
can drill down on the time dimension as well and find out precisely when the condition started.

iSPI Performance for Metrics query features let youmodify a report by applying filters to the
network dimension and the time dimension. Use the network topology filter to modify the report on a
particular node group or a particular node. Use time dimension filter to select a particular day, week,
or month. In addition, you can also filter data by day-of-week and by hour-of-day. Some reports let
you replace the primary and secondary metric with any metrics you choose, and some reports let
youmodify the scope and direction of ranking. For example, you can specify that you want to look
at the Top 25 elements instead of the default Top 10, and you can specify that you want to look at
the Bottom 5 elements instead of the Top 5.
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Component Health Reports
The Component Health reports show the performance data for network components in your
environment. Graphs and charts on Component Health reports reflect the details related to the
following elements of devices:

l CPU

l Memory

l Buffer

l SNMP response time

Use Component Health reports to determine if a component is over-utilized or if it needs an
upgrade.

Opening Reports from NNMi
From the NNMi Console, you have these options:

l Click theReporting - Report Menu option under theActions menu; launch reports from the
Report Menu.

l Launching Pre-Filtered iSPI Reports Directly from NNMi

If you are interested in a particular component, launch a pre-filtered report from NNMi; otherwise,
open a workspace view from NNMi, move to the iSPI, and begin your investigation from the
Report Menu. Tomove from NNMi to the iSPI:

a. Log in to the NNMi Console.

b. Select a workspace.

c. Open a view (nodes, interfaces, components, or incidents).

d. Select Actions > Reporting - Report Menu page

Glossary of Metrics
Memory Utilization

Percentage of memory in use compared to the total amount of memory available.

Buffer Utilization

Percentage of buffer space in use compared to the total amount of buffer space available.

Buffer Miss Rate

A counter measures the number of buffers available in the buffer pool. An exception is recorded
when the number of buffers drops below aminimum number. Themiss rate percentage shows how
the number of below-minimum samples compares to total samples.
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Buffer Failure Rate

A counter measures the number of times buffer creation fails due to insufficient memory. An
exception occurs when the number of failures crosses a threshold. The buffer failure rate is a
percentage that shows how the number of buffer creation failures compares to the total number of
buffer creations.

CPU Utilization

Percentage of CPU utilization in use compared to the total amount of CPU capacity available. (This
metric maps to the CPU 1m utilization value from NNM.)

CPU 5-Second Utilization

This metric averages CPU utilization over a 5-second period, providing a snapshot of the past 5-
seconds at the time of polling. Available from Cisco devices only.

CPU 1-Minute Utilization

This metric averages CPU utilization over a 1-minute period, providing a snapshot of the previous
minute at the time of polling. Available from Cisco and Nortel Passport devices.

CPU 5-Minute Utilization

This metric averages utilization over a 5-minute period, providing a snapshot of the previous 5
minutes at the time of polling. Available from Cisco devices only.

Response Time

The time it takes a node to respond to an SNMP request from NNMi

SampleCount

The number of samples. Some nodes do not support the full range of metrics. To avoid skewing the
averages, separate counts are kept for eachmetric received.

NodeCount

The number of nodes polled.

ComponentCount

The number of components polled.

Glossary for Polling Metrics

Metric Name Description

Target Error (avg) Generated if the target component returns any of the following
SNMP error responses:

l Authentication error

l No such name
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l No such object.

Reboot (avg) Generated if the target component was restarted during the poll and
no data could be retrieved from the component.

NNMi checks the sysUptimemetric to determine whether the
component was restarted during the last poll.

Invalid Data (avg) Generated when NNMi has successfully polled data from the
target, but has determined that the data is invalid. For example,
this metric is calculated when the number of packets is greater
than the number of octets.

Unresponsive Target (avg) Generated when the SNMP agent did not respond when collecting
metrics for a particular polling policy.

Glossary for Backplane Utilization Metrics
Backplane utilization provides indication on how much traffic is flowing through the switches
available in a network.

Metric Name Description

Backplane Utilization (avg) Average rate of network traffic flowing through
the components available in the network

Backplane Utilization (min) Minimum rate of traffic flowing through the
components available in the network

Backplane Utilization (max) Maximum rate of traffic flowing through the
components available in the network

Backplane Utilization - Threshold Exception
Count (sum)

Total number of times the backplane
utilization for the switches available in the
network crossed the threshold level.

Indicates that the data being transmitted over
a switch's backplane is excessive.

Backplane Utilization - Threshold Exception
Rate (avg)

Rate of the backplane utilization exceptions
for the switches available in the network
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Glossary for Disk Space Utilization Metrics

Metric Name Description

Disk Space Utilization - Threshold Exception
Count (sum)

Total number of times the disk space utilization
has crossed the threshold level

Disk Space Utilization - Threshold Exception
Rate (avg)

Rate of disk space utilization exceptions for the
available hosts in a network

Disk Space Total - MB (avg) Average amount of disk space allocated by all
the selected hosts

Disk Space Total - MB (min) Minimum amount of disk space allocated by all
the selected hosts

Disk Space Total - MB (max) Maximum amount of disk space allocated by all
the selected hosts

Disk Space Used - MB (avg) Average amount of host disk space used by the
selected components

Disk Space Used - MB (min) Minimum amount of host disk space used by
the selected components

Disk Space Used - MB (max) Maximum amount of host disk space used by
the selected components

Disk Space Free - MB (avg) Average amount of free host disk space
available for the selected components

Disk Space Free - MB (min) Minimum amount of free host disk space
available for the selected components
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Glossary for Node Availability Metrics

Metric Name Description

Node Availability

l Average

l Maximum

l Minimum

The amount of time the node was available for polling.

The node availability depends on the sysUpTime1 of the
node.

Calculating the node availability.

Node Reachability

l Average

l Maximum

l Minimum

The amount of time the node's management address was
available to the ICMP polls performed by NNMi.

Calculating the node reachability.

.ICMP ResponseTime
(Milliseconds)

l Average

l Maximum

l Minimum

l Baseline Average

l Average Baseline Deviation

l Average Slope

l Maximum Upper Normal Value

l Minimum Lower Normal Value

l Minimum Days to Threshold

l Average Forecast Baseline (for
four weeks)

l Average Forecast Baseline (for
eight weeks)

l Maximum Forecast Upper
Normal value (for 12 weeks)

l Minimum Forecast Lower
Normal value (for 12 weeks)

l Sum of Baseline Exception
Count

ICMP response time as milliseconds.

If NNMi poll does not receive any responses from the
node's management address, NPS considers this value to
be NULL.

1NNMi uses the sysUptime to detect a system reboot. Any time a system reboot is detected,
NNMi resets the sysUpTime value to zero.
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Metric Name Description

l Average Baseline Exception
Rate

l Average Baseline Intercept
Component

l Average Baseline Trend
Component

l Average Baseline Seasonal
Component

l Maximum value for Anomaly
Sample Flags Window

l Average Baseline Linear
Samples Used

l Average Baseline Seasonal
Samples Used

l Maximum value for the Upper
Threshold

l Minimum value for the Lower
Threshold

l Sum of Threshold Exception
Count

l Average Threshold Exception
Rate
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Metric Name DescriptionComponent Health Baseline Sleeve Report
This report analyzes how close themetric performance value is to the threshold levels. In other
words, this report enables you to analyze when themetric will reach the threshold.

Using this report, you can:

l Analyze if the component utilization is within the expected (normal) range for the selected time
range.

l Detect if themetric performance is about to cross the high and low thresholds.

For example, if you generate the Baseline Sleeve Chart report for the baselinemetric Memory
Utilization, the chart displays the how close the baseline buffer utilization is to the high and low
threshold.

l Savemultiple Baseline Sleeve Reports for a specific metric for different time ranges, and
analyze themetric performance trend.

This report supports onemetric.

l To change the TimeControls defaults, see Change TimeControls in theUsing Reports >
Change Default Settings section.

l To change the Topology Filters defaults, see Set Topology Filters in theUsing Reports >
Change Default Settings section.

l To change the Report Options defaults, see Change Report Options in theUsing Reports >
Change Default Settings section.

Component HealthCalendar Report
The Calendar Report uses a traditional, calendar-style layout to show hourly statistics for two
metrics in a single, extended graph spanning over multiple days.

Features and Defaults

The Calendar Report defaults to:

l Nodes/Components = All

l Dates/Times =Last 31 days

l Metric(s) Shown on Y1 Axis = Memory Utilization (avg)

l Metric(s) Shown on Y2 Axis = CPU 5min Utilization – Exception Rate (max)

The default view shows the data for the current month. Depending on how long the iSPI has been
collecting data from NNM, youmay have the option of looking at data for the previous twomonths
as well as last 31 days.

Note: If you set the TimeRange below 24 hours, the followingmessage appears:
This report is not designed to operate with a time range of less than

24 hours. Please modify your time selections.

You can use the following TimeControls parameters:
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l Start Date/Time

l TimeRange

l Auto Refresh

Use Cases

Use this report to observe:

l gradual trends over time

l to spot isolated spikes

l to verify that an abnormal condition has returned to normal

l to make comparisons

For example, to compare the data of the last 31 days, or to compare data for last month to data for
the precedingmonth.

This report also reveals:

l Day of week patterns

l Hour of day patterns

For example, if utilization is spiking on Tuesdays, or if response time issues are occurring daily at
11:00 a.m., the report will highlight these events.

l To change the TimeControls defaults, see Change TimeControls in theUsing Reports >
Change Default Settings section.

l To change the TimeControls defaults, see Change TimeControls in theUsing Reports >
Change Default Settings section.

l To change the TimeControls defaults, see Change TimeControls in theUsing Reports >
Change Default Settings section.

Component HealthChart Detail Report
[[[Undefined variable PerfSPIVariables.CompHealth]]] Chart Detail report enables you to perform a
trend analysis for the network health and performance based on historical component health data.

The Chart Detail report displays a comparative analysis of the selectedmetrics for each time unit.

For example, if you need to compare how the average Threshold Exception Rate was affected by
variance in the average SNMP Response Time permillisecond for the past one week, you can
generate theWeekly Component Health report for the selected node group.

You can also select two or more component or component groups to generate Chart Detail report.

Using this report you can:

l Analyze the trend of network health and performance for multiple components or component
groups based on one unit of time. Each unit of time is called as a Display Grain . Each Display
Grain is measured as follows:
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n Fiveminutes for Hourly report

n One hour for daily report

n One day for weekly report

n One day for monthly report

l Analyze the reason for any ups and downs in the network health and performance.

l Detect any persistent problem in the network health and performance.

l Compare network health and performance of more than two components or component groups
based on historical component health data.

Component Health Chart Detail Reports Options

The Chart Detail report displays the following options:

l Metric(s) Shown on Y1 Axis:1

l Metric(s) Shown on Y2 Axis: 2

l Chart or Table3

This report tracks up to six metrics for each axis for the selected time period. This report displays
the selectedmetrics using two Y axis.

l The left Y axis (also known as the Y1 axis) displays the performance of themainmetric based
on which you want to generate the report.

l The right Y axis (also known as the Y2 axis) displays the performance of themetric that should
overlay themain (primary) metric.

To add another metric, click Options and then click (Add new metric).

To remove ametric that you have already added, click Options and then click (Remove
metric).

l To change the TimeControls defaults, see Change TimeControls in theUsing Reports >
Change Default Settings section.

l To change the Topology Filters defaults, see Set Topology Filters in theUsing Reports >
Change Default Settings section.

l To change the Report Options defaults, see Change Report Options in theUsing Reports >
Change Default Settings section.

1The default selection is Memory Utilization (avg)
2The default selection is CPU 5min Utilization - Exception Rate (max)
3The Chart Detail report enables you to view the data in the tabular format as well. To view the
table, click Options, and then select Table. To view both the chart and the table, click Options,
and then select Chart and Table.
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Component Health Dashboard
The Dashboard report provides an overview of the components available on your network using a
combination of gauges, heat charts, and ordered Top 5 lists. The report displays the threshold
violations for volume, error, and availability. Threshold violations can point to a network-related
problem ormay indicate that your thresholds within NNMi need to be changed.

To group the data within the dashboard:

1. Click Options.

2. In the Grouping By: field, select a topology filter to group the dashboard data.

For example: if you use a grouping option of Node Name, all Availability exceptions that fall
within the time and topology constraints are grouped by Node Name and displayed as a
percentage of the total samples in the left gauge.

Dashboard Sections

Gauge

The gauges provide the following exception count statistics:

l Memory Utilization Exceptions (% samples)

l Buffer Utilization Exceptions (% samples)

l Buffer Miss Rate Exceptions (% samples)

l CPU Utilization Exceptions (% samples)

When the NPS database has no data, the needle icons on the gauges on the Dashboard report do
not appear.

Top 5 Lists

The top-5 lists displays nodes responsible for the exceptions showing up in the gauges:

l Top 5Qualified Component Names by Memory Utilization Exceptions

l Top 5Qualified Component Names by CPU Utilization Exceptions

Top 5Qualified Component Names by Buffer Utilization Exceptions and Buffer Utilization Heat
Chart

Using the heat chart, you can:

l Analyze the pattern of buffer utilization exception for past one hour.

l Compare the buffer utilization performance of different components.

l Detect the time range in the past one hour when the buffer utilization performance was the
lowest.

Example
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If the gauges are showing few or no exceptions, this means that none of your nodes, including the
nodes in the top 5 lists, are experiencing problems with memory, buffer, or CPU utilization.

For example, your network is divided into groups that represent regions or strategic locations for
your enterprise. With the grouping option set to NodeGroup name, the report lists each of your
strategic NodeGroups (as defined within NNMi) and provides the current statistics for exceptions
within each group.

If an unexpected change in exception counts is noted, you can click the appropriate gauge needle or
NodeGroup within the Top 5 lists, and then launch another report (such as Chart Detail) to
investigate trends or changes within the network as they are occurring.

The thresholds that create exceptions are set from NNMi, not from the iSPI. If you want to set or
modify thresholds, refer to the online help for NNMi administrators.

l To change the TimeControls defaults, see Change TimeControls in theUsing Reports >
Change Default Settings section.

l To change the Topology Filters defaults, see Set Topology Filters in theUsing Reports >
Change Default Settings section.

l To change the Report Options defaults, see Change Report Options in theUsing Reports >
Change Default Settings section.

Component Health Executive Report
The Executive Report provides a broad view of component performance for the selected time
range, using the following graphs:

l AverageMemory Utilization and Exception Percentage

l Average Backplane Utilization and Exception Percentage

l Average Buffer Utilization and Exception Percentage

l Maximum Rate of Buffer Miss, Buffer Failure, and NoMemory Exceptions

l Average 1minute CPU Utilization and Exception Percentage

l Average Disk Space Utilization and Exception Percentage

This report enables you to:

l View every aspect of performance at once.

l View trends and verify that performance is meeting expectations.

l Identify isolated aberration in the graphs and detect any unexpected performance trend.

The Executive report does not provide options to create graphs based on other metrics.

The default display grain for the Executive report is one hour.

This report shows the data for exceptions only if thresholds for performancemetrics are set in
NNMi.
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l To change the TimeControls defaults, see Change TimeControls in theUsing Reports >
Change Default Settings section.

l To change the Topology Filters defaults, see Set Topology Filters in theUsing Reports >
Change Default Settings section.

Component Health Executive Report
The Executive Report provides a broad view of component performance for the selected time
range, using the following graphs:

l AverageMemory Utilization and Exception Percentage

l Average Backplane Utilization and Exception Percentage

l Average Buffer Utilization and Exception Percentage

l Maximum Rate of Buffer Miss, Buffer Failure, and NoMemory Exceptions

l Average 1minute CPU Utilization and Exception Percentage

l Average Disk Space Utilization and Exception Percentage

This report enables you to:

l View every aspect of performance at once.

l View trends and verify that performance is meeting expectations.

l Identify isolated aberration in the graphs and detect any unexpected performance trend.

The Executive report does not provide options to create graphs based on other metrics.

The default display grain for the Executive report is one hour.

This report shows the data for exceptions only if thresholds for performancemetrics are set in
NNMi.

l To change the TimeControls defaults, see Change TimeControls in theUsing Reports >
Change Default Settings section.

l To change the Topology Filters defaults, see Set Topology Filters in theUsing Reports >
Change Default Settings section.

Component HealthHeat Chart Report
The Heat Chart Report tracks the hourly performance of a single metric. The default metric is
Memory Utilization (avg). The default time period is the last 31 days. Performance is color-coded,
making it easy to spot a condition that is gradually worsening andmaking it easy to distinguish
satisfactory performance from unsatisfactory performance.

Features and Defaults

The legend at the top of the report maps a range of normalized performance values to a particular
color.

Beneath the legend, a table represents the normalized values of a performancemetric (rows of the
table represent hours of the day; columns of the table represent days).
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Each cell inside the table is color-coded and each cell inside the table indicates a specific value of
themetric. You can also hover themouse pointer on the cell to see the absolute metric value of
each hour.

The Heat Chart defaults to:

l Nodes/Components = All

l Time Period = Last 31 days

l Hour of Day = All

l Day of Week = All

l Metric = Memory Utilization (avg)

While selecting the TimeControls parameters, you can choose the following values:

l A specific day other than Last Day

l A specific week this month (or partial week)

l A specific week in a previous month (or partial week)

l Last 31 days

l A previous month

Note: If you set the TimeRange below 24 hours, the followingmessage appears:
This report is not designed to operate with a time range of less than

24 hours. Please modify your time selections.

This report tracks percentages. If you open Heat Chart from a report that is using a non-supported
metric (for example, Sample Count or Response Time), you will be told to open the report controls
window and select an alternatemetric.

Use Case

Use the Heat Chart to identify:

l gradual shifts from one range of performance to another range

l to spot an isolated instance of poor performance that affected the results for one day

l to spot day-of-week or hour of day patterns

l to verify that an abnormal condition returned to normal after a problem was corrected

l To change the TimeControls defaults, see Change TimeControls in theUsing Reports >
Change Default Settings section.

l To change the TimeControls defaults, see Change TimeControls in theUsing Reports >
Change Default Settings section.

l To change the TimeControls defaults, see Change TimeControls in theUsing Reports >
Change Default Settings section.
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Component Health Managed Inventory Report
Use theManaged Inventory Report to view the number of instances of each topology attribute seen
in the collected data within the selected time range. For example, if the report is run for ‘Last 1
Hour,’ you will see the number of unique values for each attribute seen in the data collected over the
last hour. This report can be useful for checking, for example, the number of nodes polled over any
given time range.

You can use the available attributes to filter the data of your interest and create a report that
represents only the elements of your interest. The report presents the list of attributes in the form of
a table; the Count column of the table indicates the number of entries for each attribute. For
example, count 5 for the topology item Node Locationmeans all nodes on your network can be
grouped based on 5 different locations that host the nodes.

You can use the following topology attributes with the Component Health reports:

l Qualified Component Name

l Component Name

l Component Type

l Component ID

l Component UUID

l Node Name

l Node Contact

l Node Location

l Node Family

l Node Vendor

l Node ID

l Node UUID

l To change the TimeControls defaults, see Change TimeControls in theUsing Reports >
Change Default Settings section.

l To change the TimeControls defaults, see Change TimeControls in theUsing Reports >
Change Default Settings section.

TheManaged Inventory report may take significant time to build if you select a time range greater
than one day.

Component HealthMost Changed Report
This report compares performance of the components for two different (consecutive) time periods
and ranks components by the amount of change. The sort order is most-changed to least-changed.

Features and Defaults

This report contains one table and provides data for onemetric only.

The table presents the following columns:
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l Component

l Performance for the previous time period

l Performance for the selected time period

l Growth, expressed as a percentage increase

l Change

TheMost Changed report defaults to:

l Grouping by Elements = Qualified Component Name

l Start Date/Time = Depends on default Time Range and data available in the database

l TimeRange = Last 1 hour

l Hour of Day = All

l Day of Week = All

l Rank Metric = Memory Utilization (Avg%)

l Top N Option = Top 10

By default, the report groups data by Qualified Component Name. You can select multiple grouping

attributes by using the (Add New Grouping) button. Use the (Remove Grouping) button
to remove a grouping attribute.

Use Case

Use this report to identify components that saw significant change from one time period to the next.
Significant change could point to a developing problem. The report shows the rate of change in the
Growth Rate column. You can change the rankingmetric and you can change how many elements
are listed.

l To change the TimeControls defaults, see Change TimeControls in theUsing Reports >
Change Default Settings section.

l To change the TimeControls defaults, see Change TimeControls in theUsing Reports >
Change Default Settings section.

l To change the TimeControls defaults, see Change TimeControls in theUsing Reports >
Change Default Settings section.

Component Health Overview Report
TheOverview Report displays the utilization and performance of themost commonly monitored
metrics in Component Health extension pack.

Using this report, you can:

l Monitor the daily utilization and performance of a set of pre-definedmetrics.

l Identify the components with unusual performance or utilization and drill down to other reports to
analyze the problem.

l Rank the components based on their utilization levels.
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l Identify themetrics that are close to the threshold. Use the following sections to identify such
components:
n Top 10 CPU Forecasts

n Top 10Memory Forecasts

The default display grain for this report is one hour. To select a different time grain or time range,
use the TimeControls tab in the navigation panel.

To change the TimeControls defaults, see Change TimeControls in theUsing Reports > Change
Default Settings section.

To change the topology filters, use the Topology Filters tab in the navigation panel.

To change the Topology Filters defaults, see Set Topology Filters in theUsing Reports > Change
Default Settings section.

You cannot select themetrics for this report.

Component Health Peak Period Report
The Component Health Peak Period Report ranks the utilization and performance of a component
during the busiest time of the selected time range.

Using this report, you can:

l Identify the performance and utilization of the selectedmetrics during the peak period.

l Identify the components that have the highest or lowest performances or utilization levels during
the peak period.

l Compare the performance for multiple components during the peak period using this report.

Use Case

Use this report to:

l Identify a group of components or nodes having a common network performance problem.

l Identify the component that is suffering from a persistent performance problem.

Component Health Peak Period Report Options

l Top / Bottom N1

l Select Metric(s)2

l Grouping by Time Period3

This report tracks up to six metrics over the selected time period.

To add another metric, click Options and then click

1Select a rank between top or bottom five, ten, 25, 50, 100, all descending, and all ascending for the
selected component.
2Select themetrics based on which you want to generate the report.
3Enables you to group the report data based on a specific time grain. Click Add New Grouping icon
to add a new group.
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To remove ametric that you have already added, click Options and then click .

To select a range of value for themetric, click , click , and select a range of metric value that
the report should consider.

While specifying the range for a percentagemetric, make sure that the ranges are any of the
following formats:

l Decimal multiplier (for example, 1 to specify 100%, 0.5 to specify 50%, etc)

l Range with the% (Percentage) symbol (for example, 100%, 50%, etc)

For example if you want to see the top five CPUs with the averagememory utilization between 10%
and 90% type the following ranges:

l 0.1 or 10% as Lowest Value

l 0.9 or 90% as theHighest Value

By default, the report groups data by Qualified Component Name. You can select multiple grouping

attributes by using the (Add New Grouping) button. Use the (Remove Grouping) button
to remove a grouping attribute.

Tip:

l Use this report to identify the period when the component utilization was the highest.

l Check this report once a day to see which component may need special attention.

l Check this report periodically throughout the day to see which component is performing at the
extremes andmay need special attention.

l To change the TimeControls defaults, see Change TimeControls in theUsing Reports >
Change Default Settings section.

l To change the Topology Filters defaults, see Set Topology Filters in theUsing Reports >
Change Default Settings section.

l To change the Report Options defaults, see Change Report Options in theUsing Reports >
Change Default Settings section.

Component Health Threshold Sleeve Report
This report analyzes how close themetric performance value is to the threshold levels. In other
words, this report enables you to analyze when themetric will reach the threshold.

Using this report, you can:

l Forecast over-utilization or under-utilization of the selected component.

l Detect if themetric performance is about to cross the high and low thresholds.

For example, if you generate the Threshold Sleeve Chart report for Buffer Utilization (avg), the
chart displays the how close the average buffer utilization is to the high and low threshold.
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l Savemultiple Threshold Sleeve Reports for a specific metric for different time ranges, and
analyze themetric performance trend.

This report supports onemetric.

l To change the TimeControls defaults, see Change TimeControls in theUsing Reports >
Change Default Settings section.

l To change the Topology Filters defaults, see Set Topology Filters in theUsing Reports >
Change Default Settings section.

l To change the Report Options defaults, see Change Report Options in theUsing Reports >
Change Default Settings section.

Component HealthTop N Report
This report ranks network elements by themetric you select.

Use this report to spot the element that performed at the extremes. You can use this report to
analyze the historical data for elements that are exhibiting unusual utilization levels.

Using this report you can:

l Detect the component having a health or performance problem.

l Analyze the utilization of the NNMi managed network components based on a specific time
range.

l Detect the over-utilized and under-utilized components in the network.

l Compare the performance for multiple network components using this report.

Example

Some of the routers in your network are performing poorly. Using this report, you can group the
routers reporting highest average response time. The router reporting the highest response time is
ranked first.

Component Health Top N Reports Options

The Top N report displays the following options:

l Top / Bottom N1

l Select Metric(s)2: The report ranks the selected nodes or components based on the value of the
first metric listed in the Select Metric(s) field.

1Select a rank between top or bottom five, ten, 25, 50, 100, all descending, and all ascending for the
selected component.
2Select themetrics based on which you want to generate the report.
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l Display Time Series Chart1

l Grouping By2

This report tracks up to six metrics for eachmetric type for the selected time period. The report
supports the followingmetric types:

l The main metric:Also known as the primary metric. The report is generated based on this
metric.

l The secondary metric:Displays the performance of themetric that should overlay themain
(primary) metric.

To add a new metric, click Options and then click (Add new metric).

To remove ametric that you have already added, click Options and then click (Remove
metric).

To select a range of value for themetric, click (Apply Filter), and select a range of metric value
that the report should consider.

While specifying the range for a percentagemetric, make sure that the ranges are any of the
following formats:

l Decimal multiplier (for example, 1 to specify 100%, 0.5 to specify 50%, etc)

l Range with the% (Percentage) symbol (for example, 100%, 50%, etc)

For example if you want to see the top five CPUs with the averagememory utilization between 10%
and 90% type the following ranges:

l 0.1 or 10% as Lowest Value

l 0.9 or 90% as theHighest Value

By default, the report groups data by Qualified Component Name. You can select multiple grouping

attributes by using the (Add New Grouping) button. Use the (Remove Grouping) button
to remove a grouping attribute.

The Time Series Chart report displays the selectedmetrics using two Y axis.

l The left Y axis (also known as the Y1 axis) displays the performance of the primary metric.

l The right Y axis (also known as the Y2 axis) displays the performance of the secondary metric.

Tip :

l By default, Top N Report does not display the Time Series Chart. To view the chart with the
detail table,perform any of the following steps:

1Select Yes to view the detail chart with the table. Select No to hide the chart and display only the
table. The created Top N Report displays the graphical representation of themetric values for the
components over the selected time range.
2Organize the report data based on a specific parameter. Click Add New Grouping icon to add a
new group.
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n Select Options > Display Time Series Chart > Confirm Selection.

n Click Show Chart link below the detail table.

l Check this report once a day to see which network component may need special attention.

l Check this report periodically throughout the day to see which network components are
performing at the extremes andmay need special attention.

l To change the TimeControls defaults, see Change TimeControls in theUsing Reports >
Change Default Settings section.

l To change the Topology Filters defaults, see Set Topology Filters in theUsing Reports >
Change Default Settings section.

l To change the Report Options defaults, see Change Report Options in theUsing Reports >
Change Default Settings section.

Component HealthTop N Chart Report
Like the Top N report, this report also ranks the components by themetric you select. Moreover, the
Top N Chart report displays an individual chart for each topology filter andmetric selected for the
report.

Using this report, you can:

l Spot the component that performed at the extremes.

l Analyze the historical data for components that are exhibiting unusual utilization levels.

l Detect the component having a health or performance problem.

l Analyze the utilization of the NNMi managed components based on a specific time range.

l Detect the over-utilized and under-utilized components in the network.

l Detect the underlying reason of a persistent problem with a component. You can compare the
performance for multiple components using this report.

Example

Some of the routers in your network are performing poorly. Using this report, you can group the
routers reporting highest average response time. The router reporting the highest response time is
ranked first.

Component Health Top N Chart Reports Options

The Top N report displays the following options:

l Top / Bottom N1

l Select Metric(s)2

1Select a rank between top or bottom five, ten, 25, 50, 100, all descending, and all ascending for the
selected component.
2Select themetrics based on which you want to generate the report.
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l Grouping By1

This report tracks up to six metrics for each axis for the selected time period. This report displays
the selectedmetrics using two Y axis.

l The left Y axis (also known as the Y1 axis) displays the performance of themainmetric based
on which you want to generate the report.

l The right Y axis (also known as the Y2 axis) displays the performance of themetric that should
overlay themain (primary) metric.

To add another metric, click Options and then click (Add new metric).

To remove ametric that you have already added, click Options and then click (Remove
metric).

To select a range of value for themetric, click (Apply Filter), and select a range of metric value
that the report should consider.

While specifying the range for a percentagemetric, make sure that the ranges are any of the
following formats:

l Decimal multiplier (for example, 1 to specify 100%, 0.5 to specify 50%, etc)

l Range with the% (Percentage) symbol (for example, 100%, 50%, etc)

For example if you want to see the top five CPUs with the averagememory utilization between 10%
and 90% type the following ranges:

l 0.1 or 10% as Lowest Value

l 0.9 or 90% as theHighest Value

By default, the report groups data by Qualified Component Name. You can select multiple grouping

attributes by using the (Add New Grouping) button. Use the (Remove Grouping) button
to remove a grouping attribute.

l To change the TimeControls defaults, see Change TimeControls in theUsing Reports >
Change Default Settings section.

l To change the Topology Filters defaults, see Set Topology Filters in theUsing Reports >
Change Default Settings section.

l To change the Report Options defaults, see Change Report Options in theUsing Reports >
Change Default Settings section.

iSPI for Performance Reportlets
In a large enterprise network theNNM iSPI Performance products2may produce a large amount
of data and large cardinality. This means that these networks often have a very large amount of

1Organize the report data based on a specific parameter. Click Add New Grouping icon to add a
new group.
2NNM iSPI Performance for Metrics, NNM iSPI Performance for Quality Assurance, and NNM
iSPI Perforance for Traffic
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unique IP addresses, source nodes and destination nodes, interfaces, and components each
producing large amount of data. Generating reports using such large data volumemay be time
consuming.

Reportlets enable you to generate quick impressions of the larger reports using the iSPI for
Performance Dashboards.

Viewing iSPI for Performance Reportlets
To display the reportlets:

1. Log in to Network Performance Server (NPS) Home Page.

2. On the left navigation panel, select Dashboard Reportlets.

3. Select an extension pack and then select a reportlet.

You can also create custom dashboards using the reportlets. See Creating Custom Dashboards
Using BI Server Portal for information on the procedure to create the custom dashboards.

Baseline Metric Snapshot with Range
Displays the aggregatedmetric performance for the selected time range.

Enables you to:

l Build a performance history for the selected baselinemetric and analyze how themetric
performance changes over time.

Such history may help you to select an expected performance level for themetric

l Compare the performance for multiple metrics over a specified time range.

Though you can generate snapshot report for a single metric, you can save the snapshot report
for various metrics and compare the performance of eachmetric over a time range.

This reportlet supports onemetric.

Baseline Sleeve Chart
Analyzes how close themetric performance value is to the threshold levels.

Enables you to:

l Detect if themetric performance is about to cross the high and low thresholds.

For example, if you generate the Baseline Sleeve Chart reportlet for Utilization (avg), the chart
displays how many exceptions are raised on average utilization in the past one day,

l Savemultiple Sleeve Reports for a time range, and for analyze the trend of performance for the
metric.

This reportlet supports onemetric.

Baseline Sparkline
Evaluates the trend of how the selected baselinemetric value has changed for the selected time
range.

Enables you to:
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l Analyze the variations in the performance for the selectedmetric.

l Decide whether the expected behavior for the selectedmetric should be reassessed.

This reportlet supports onemetric.

Baseline Sparkline with Range
Evaluates the trend of how the selected baselinemetric value has changed for the selected time
range.

Enables you to:

l Evaluate the performance trend of the selectedmetric for the selected time range.

l Compare the present performance trend with the normal (expected) performance range.

l Measure the performance of past one day in percentage.

This reportlet supports onemetric.

Calendar
Displays a comparative study of the selectedPrimary Metric1 andSecondary Metric2

The default display grain is set to one hour. You cannot change the display grain of this reportlet.

Enables you tomonitor the following:

l Daily component utilization

l Volume of data passed through the component for past one day

l Performance of the component for past one day

This reportlet supports twometrics.

Gauge
Evaluates themetric for the selected point of time.

Select only themetrics that displays the percentage values.

Enables you to:

l Measure the daily performance of the selectedmetric.

l Detect any abnormal or unexpected performance level.

This reportlet supports onemetric.

When the NPS database has no data, the needle icon on the gauge does not appear.

Heat Chart
Grades the performance of the selectedmetric for the selected time range.

1Enables you to select themainmetric based on which you want to generate the report. The
primary metric that you select is displayed on the left Y axis of the report.
2Enables you to select themetric that would overlay the primary metric. The secondary metric that
you select is displayed on the right Y axis of the report.
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Themetric performance is aggregated based on an hourly display grain.

Enables you to:

l View how the component performance gets affected by a varyingmetric.

l Compare the hourly performance of the selectedmetric.

l Detect the time range when the component performance was affected adversely because of the
fluctuatingmetric value.

This reportlet supports onemetric.

Metric Snapshot
Displays themetric performance for the selected time range.

Enables you to:

l Build a performance history for the selectedmetric and analyze how themetric performance
changes over time.

Such history may help you to decide the baseline value for themetric

l Compare the performance for multiple metrics over a specified time range.

Though you can generate snapshot report for a single metric, you can save the snapshot report
for various metrics and compare the performance of eachmetric over a time range.

This reportlet supports onemetric.

Most Changed
Compares themetric performance between the following:

l Selected time range

l Period preceding the selected time range

Aggregates themetric utilization and ranks the performance in a descending order.

Enables you to:

l Measure the performance fluctuations for the components.

l Detect the top N components having a common performance or utilization problem.

You can enhance the report usability using the following features:

l Top / Bottom N1

l Grouping By2

This reportlet supports onemetric.

1Select a rank between top or bottom five, ten, 25, 50, 100, all descending, and all ascending for the
selected component.
2Organize the report data based on a specific parameter. Click Add New Grouping icon to add a
new group.
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Multimetric Chart
Analyzes the performance trend for the selectedmetrics for the selected time range.

Enables you to:

l Perform comparative analysis of the selectedmetrics for each display grain.

The default display grain is one hour.

l Analyze the reason for any ups and downs in the component performance.

l Detect any persistent problem in the component performance.

This reportlet supports up to six metrics.

Simple Bar and Line Chart
Displays the trend of component performance for past one day using the following values:

l Primary Metric1 on the bar chart

l Secondary Metric2 on the line chart

Enables you to:

l Compare the performance trends of multiple metrics.

l Analyze how the value of the secondary metric increases or decreases based on the increase or
decrease in the value of the primary metric.

This reportlet supports twometrics.

Simple Bar Chart
Compares the performance of twometrics for the selected time range.

Enables you to:

l Compare the performance trends of multiple metrics.

l Analyze how the value of the secondary metric increases or decreases based on the increase or
decrease in the value of the primary metric.

This reportlet supports twometrics.

To select a new metric for your reportlet, see Change Reportlet Options in theUsing Reports >
Change Default Settings section.

Simple Chart
Analyzes the utilization trend for the selectedmetrics for the selected time range.

Enables you to:

1Enables you to select themainmetric based on which you want to generate the report. The
primary metric that you select is displayed on the left Y axis of the report.
2Enables you to select themetric that would overlay the primary metric. The secondary metric that
you select is displayed on the right Y axis of the report.
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l Perform comparative analysis of the selectedmetrics for each display grain.

The default display grain is one hour.

l Analyze the reason for any ups and downs in the component performance.

l Detect any persistent problem in the component performance.

This reportlet supports twometrics.

Simple Table
Analyzes the utilization trend for the selectedmetrics for the selected time range.

The default display grain is one hour.

Enables you to:

l Analyze the hourly performance of themetrics.

l Detect any abnormal or unexpected component performance.

l Analyze how the value of the secondary metric increases or decreases based on the increase or
decrease in the value of the primary metric.

This reportlet supports up to six metrics.

Sparkline
Evaluates the trend of how the selectedmetric value has changed for the selected time range.

Enables you to:

l Analyze the variations in the performance for the selectedmetric.

l Decide whether the expected behavior for the selectedmetric should be reassessed.

This reportlet supports onemetric.

Threshold Sleeve Chart
Analyzes how close themetric performance value is to the threshold levels.

Enables you to:

l Detect if themetric performance is about to cross the high and low thresholds.

For example, if you generate the Exception Sleeve Chart reportlet for Utilization (avg), the chart
displays how many exceptions are raised on average utilization in the past one day,

l Savemultiple Sleeve Reports for a time range, and analyze the trend of performance for the
metric.

This reportlet supports onemetric.

Top N Chart
Ranks the individual contribution of eachmetric for the component performance for the selected
time range.

The performance of the component is aggregated on hourly basis.

Enables you to:
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l Spot the components for which the performancemetrics present extreme values.

l Investigate the aggregated data for the components that are exhibiting unusual utilization levels.

l Select themetric based on which you want to generate the report. Themetric that you select is
used to rank the components.

l Group the report data based on a specific parameter. Click Add Group to add a subgroup.

This reportlet supports onemetric.

Top N Line Chart
Ranks the utilization trend for the selectedmetrics for the selected time range.

The performance of the component is aggregated on hourly basis.

Enables you to:

l Spot the components for which the performancemetrics present extreme values.

l Investigate the aggregated data for the components that are exhibiting unusual utilization levels.

l Select themetric based on which you want to generate the report. Themetric that you select is
used to rank the components.

l Group the report data based on a specific parameter. Click Add Group to add a subgroup.

This reportlet supports onemetric.

Top N Stacked Chart
Ranks the individual contribution of each component based on the selectedmetrics.

The performance of each component is aggregated for the default display grain of one hour.

Enables you to:

l Spot the components for which the performancemetrics present extreme values.

l Investigate the aggregated data for the components that are exhibiting unusual utilization levels.

l Detect the network path having a common network performance problem.

This reportlet supports up to six metrics.

Top N Table
Ranks the components based on the selectedmetric.

Enables you to:

l Spot the components for which the performancemetrics present extreme values.

l Investigate the aggregated data for the components that are exhibiting unusual utilization levels.

l Select themetric based on which you want to generate the report. Themetric that you select is
used to rank the components.

l Group the report data based on a specific parameter. Click Add Group to add a subgroup.

This reportlet supports up to six metrics.
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Top N Table With Bars
Ranks the components based on the selectedmetric and displays a horizontal bar to depict the
aggregatedmetric value.

Enables you to:

l Spot the components for which the performancemetrics present extreme values.

l Investigate the aggregated data for the components that are exhibiting unusual utilization levels.

l Select themetric based on which you want to generate the report. Themetric that you select is
used to rank the components.

l Group the report data based on a specific parameter. Click Add Group to add a subgroup.

This reportlet supports up to six metrics.
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Interface Health Reports
The Interface Health reports show the performance data for network interfaces. Graphs and
charts on Interface Health reports reflect the details that help you identify the following:

l Interface utilization

l Errors in interfaces

l Interface discard rate

l Availability of interfaces

Use Interface Health reports to determine the status of the interfaces on your network.

Opening Reports from NNMi
From the NNMi Console, you have the following options to open reports:

l Move from NNMi to the iSPI, and launch reports from the Report Menu.

l Launch pre-filtered reports directly from NNMi.

If you are interested in a particular node group, node, or interface, you will probably want to launch
a pre-filtered report from NNMi; otherwise, open a workspace view from NNM, move to the iSPI,
and begin your investigation from Report Menu. Tomove from NNM to the iSPI:

1. Log on to the NNMi console.

2. Select a workspace.

3. Open a view of nodes, interfaces, or incidents.

4. Select Actions > Reporting - Report Menu

Related Topics

Glossary of Metrics

iSPI for Performance Metrics Types
The Interface Health extension pack provides you with the following types of metrics:

l Gauge:1

l Percent:2

1Metrics with single non-cumulative values. For example: SNMP Response Time, Throughput
(bps). The iSPI Performance for Metrics calculates the average, minimum, andmaximum values
while aggregating the values of gaugemetrics.
2Metrics with single non-cumulative percentage values. For example: Discards Rate, Error Rate.
The iSPI Performance for Metrics calculates the average, minimum, andmaximum values while
aggregating the values of percent metrics.
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l Counter:1

l Exceptions:2

1Metrics that have incremental values. For example: Volume - Bytes, Volume - Packets. The
iSPI Performance for Metrics calculates the sum while aggregating the values of counter metrics.
2The exceptions metrics indicate the count or percentage of samples that are out of the threshold
boundary defined in NNMi. If you want to use exceptionmetrics, youmust set the thresholds in
NNMi by following the instructions in the Configure ThresholdMonitoring for Interfaces section in
NNMi Help for Administrators. The Exception (sum)metrics indicate the count of samples that
are outside the threshold boundary (depends on the polling interval); the Exception (Avg%, Max%,
Min%)metrics indicate the percentage of sample outside the threshold boundary (independent of
the polling interval).

Page 2 of 51



PerfiSPI (8.13) Online Help: Interface Health
Interface Health Reports

Page 3 of 51



PerfiSPI (8.13) Online Help: Interface Health
Interface Health Reports

Glossary for the Basic iSPI for Performance Metrics

Metric Name Description

Discards Packets

l Discards Packets (sum)

l Discards Packets In (sum)

l Discards Packets Out (sum)

Total number of discarded packets, in and out combined,
followed by the number of discarded incoming packets and
the number of discarded outbound packets.

Discard Rate

l Discard Rate (avg, min, and
max)

l Discard Rate In (avg, min,
andmax)

l Discard Rate Out (avg, min,
andmax)

Total number of packets with discards as a percentage of
total packets (minimum, maximum, and average); followed
by the number of discarded packets incoming, as a
percentage of total incoming packets (minimum, maximum,
and average), and the number of discarded packets
outbound, as a percentage of total outbound packets
(minimum, maximum, and average).

Errors

l Errors - Packets (sum)

l Errors - Packets In (sum)

l Errors - Packets Out (sum)

Total number of packets with errors, in and out combined;
number of incoming packets with errors; number of
outbound packets with errors.

Error Rate

l Error Rate (avg)

l Error Rate (min)

l Error Rate (max)

l Error Rate In (avg)

l Error Rate In (min)

l Error Rate In (max)

l Error Rate Out (avg)

l Error Rate Out (min)

l Error Rate Out (max)

Total number of packets with errors as a percentage of total
packets; followed by number of packets with errors received
as a percentage of total packets received, and number of
packets with errors transmitted, as a percentage of total
packets transmitted.

Throughput (bps) l Total throughput on the interface (in bits-per-second):
n Throughput (bps) (avg)

n Throughput (bps) (min)

n Throughput (bps) (max)
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l Incoming throughput on the interface (in bits-per-
second):
n Throughput In (bps) (avg)

n Throughput In (bps) (min)

n Throughput In (bps) (max)

l Outgoing throughput on the interface (in bits-per-second):
n Throughput Out (bps) (avg)

n Throughput Out (bps) (min)

n Throughput Out (bps) (max)

Utilization Exceptions

l Utilization Exceptions (sum)

l Utilization Exceptions
(%samples)

Number of exceptions; percentage of samples above or
below the threshold range set in NNMi.

Discard Exceptions

l Discard Exceptions (sum)

l Discard Exceptions
(%samples)

Number of packet discard exceptions; percentage of
samples above the discard exception threshold.

Error Exceptions

l Error Exceptions (#samples)

l Error Exceptions (%samples)

Number of packet error exceptions; percentage of samples
above the error exception threshold.

SNMP Response Time SNMP Response Time (msec) (avg, min, max): time for
interface/device to respond to polling request

Sample Count Sample count = number of polled samples.

Utilization - avg%

l Utilization (avg)

l Utilization In (avg)

l Utilization Out (avg)

Average utilization from any sample

Utilization - max%

l Utilization (max)

l Utilization In (max)

l Utilization Out (max)

maximum utilization in (the largest value from any sample);
maximum utilization out (the largest value from any sample)
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Utilization - min%

l Utilization (min)

l Utilization In (min)

l Utilization Out (min)

minimum utilization in (the smallest value from any sample);
minimum utilization out (the smallest value from any
sample)

Volume
l Volume - Packets (sum)

l Volume - Packets In (sum)

l Volume - Packets Out (sum)

l Volume -Bytes (sum)

l Volume - Bytes In (sum)

l Volume - Bytes Out (sum)

Total number of data packets or bytes passing through the
network

Period - Length (secs) (sum) The duration (in seconds) between consecutive polling
cycles of NNMi.

countDistinct Metrics The Interface Health extension pack provides you with an
additional set of metrics—the countDistinct metrics. The
countDistinct metrics are the counter metrics that help you
track the number of interfaces over a period of time. You can
use a countDistinct metric on a report with a topology filter
selection to track the number of interfaces that belong to the
selected topology group.

For example, if you select the Qualified Interface Name
metric with the topology filter selection of a particular
Interface Group, you can track the number of interfaces that
belong to the selected group from the generated report.

Some of the available countDistinct metrics are:

l Qualified Interface Name

l Interface Name

l Interface Alias

l Interface Descr

l Interface Index

l Interface Type

l Interface Physical address

l Interface Speed (In:Out)

l Interface ID

l Interface UUID
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l Node Name

l Node Contact

l Node Location

l Node Family

l Node Vendor

l Node ID

l Node UUID

Glossary for Polling Metrics

Metric Name Description

Target Error (avg) Generated if the target interface returns any of the following
SNMP error responses:

l Authentication error

l No such name

l No such object.

Reboot (avg) Generated if the target interface was restarted during the
poll and no data could be retrieved from the interface.

NNMi checks the sysUptimemetric to determine whether
the interface was restarted during the last poll.

Invalid Data (avg) Generated when NNMi has successfully polled data from
the target, but has determined that the data is invalid. For
example, this metric is calculated when the number of
packets is greater than the number of octets.

Unresponsive Target (avg) Generated when the SNMP agent did not respond when
collectingmetrics for a particular polling policy.
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Glossary for Packet Type Counts Metrics

Metric Name Description

NonUnicast - Packets (sum) Total number of packets received and sent
by the interfaces using the non-unicast
protocol

NonUnicast - Packets In (sum) Total number of packets received by the
interfaces using the non-unicast protocol

NonUnicast - Packets Out (sum) Total number of packets sent by the
interfaces using the non-unicast protocol

Multicast - Packets (sum) Total number of packets received and sent
by the interfaces using themulticast
protocol

Multicast - Packets In (sum) Total number of packets received by the
interfaces using themulticast protocol

Multicast - Packets Out (sum) Total number of packets sent by the
interfaces available using themulticast
protocol

Unicast - Packets (sum) Total number of packets received and sent
by the interfaces using the unicast protocol

Unicast - Packets In (sum) Total number of packets received by the
interfaces using the unicast protocol

Unicast - Packets Out (sum) Total number of packets sent by the
interfaces using the unicast protocol

Broadcast - Packets (sum) Total number of packets received and sent
by the interfaces using the broadcast
protocol

Broadcast - Packets In (sum) Total number of packets received by the
interfaces using the broadcast protocol

Broadcast - Packets Out (sum) Total number of packets sent by the
interfaces using the broadcast protocol

Unknown Protocol - Packets (sum) Total number of packets received and sent
by the interfaces using any protocol other
than the following ones:

l Unicast

l Non-unicast

l Multicast
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l Broadcast

Average Packet Size - Bytes (avg) Average number of bytes received and
transmitted by the selected interface for the
selected time range.

Calculated using the followingmethod:

Volume - Bytes (sum) / Volume -

Packets (sum)

Average Packet Size - Bytes In (avg) Average number of bytes received by the
selected interface for the selected time
range.

Calculated using the followingmethod:

Volume - Bytes In (sum) /

Volume - Packets In (sum)

Average Packet Size - Bytes Out (avg) Average number of bytes transmitted by the
selected interface for the selected time
range.

Calculated using the followingmethod:

Volume - Bytes Out (sum) /

Volume - Packets Out (sum)

Glossary for LAN Metrics
Available for any of the followingMIB:

l ETHERLIKE -MIB

l OLD-CISCO-INTERFACES-MIB

1Number of output collisions detected on the selected interface for the selected time range
1Number of packets that higher-level protocols requested be transmitted, and which were not
addressed to amulticast or broadcast address at the sub-layer for the selected interface. These
include those packets that were discarded or not sent.
1Number of packets transmitted to amulticast address per second during the selected time range
1Number of packets transmitted to a broadcast address per second during the selected time
range
1Number of packets that higher-level protocols requested be transmitted, and which were not
addressed to amulticast or broadcast address at the sub-layer for the selected interface. These
include those packets that were discarded or not sent.
1Number of packets that higher-level protocols requested be transmitted to a non-unicast (i.e., a
subnet roadcast or subnet multicast) address. These include the packets that were discarded or
not sent.
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Metric Name Description

LAN FCS Error Count

l Sum

l Average

l Minimum

l Maximum

l Baseline Average (avg)

l Baseline Deviation (avg)

l Slope (avg)

l Upper Normal (max)

l Lower Normal (min)

l Days To Threshold (min)

l Baseline Exception Count
(sum)

l Baseline Exception Rate
(avg)

l Baseline Intercept
Component (avg)

l Baseline Trend Component
(avg)

l Baseline Seasonal
Component (avg)

l Anomaly Sample Flags
Window (sum)

Number of frames received on the selected interface that
consist of the necessary number of octets in length but do not
pass the FCS check.

This count does not include the frames received with any of
the following errors:

l frame-too-long

l frame-too-short

The count of LAN FCS error increases when theMAC service
returns a frameCheckError to the LLC or another MAC user.

NNMi enables you to define an upper and a lower thresholds
for the count of FCSWLAN Errors.

See HP Network NodeManager i SoftwareOnline Help for
Administrators for information about how to define thresholds
using the Threshold Configuration form.

1Number of output collisions detected on the selected interface for the selected time range
1Number of packets that higher-level protocols requested be transmitted, and which were not
addressed to amulticast or broadcast address at the sub-layer for the selected interface. These
include those packets that were discarded or not sent.
1Number of packets transmitted to amulticast address per second during the selected time range
1Number of packets transmitted to a broadcast address per second during the selected time
range
1Number of packets that higher-level protocols requested be transmitted, and which were not
addressed to amulticast or broadcast address at the sub-layer for the selected interface. These
include those packets that were discarded or not sent.
1Number of packets that higher-level protocols requested be transmitted to a non-unicast (i.e., a
subnet roadcast or subnet multicast) address. These include the packets that were discarded or
not sent.

Page 10 of 51



PerfiSPI (8.13) Online Help: Interface Health
Interface Health Reports

Metric Name Description

l Baseline Linear Samples
Used (avg)

l Baseline Seasonal
Samples Used (avg)

l Upper Threshold (max)

l Lower Threshold (min)

l Threshold Exception Count
(sum)

l Threshold Exception Rate
(avg)

LAN Collision Count (sum) Number of output collisions detected on the selected interface
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Metric Name Description

LAN Collision Rate

l Average

l Minimum

l Maximum

Percentage of output collisions detected on the selected
interface for the selected time range

Calculated using any of the followingmethods based on the
interface type:

l ((100.0 * collisonsOut1) /

(ifHCOutUcastPkts1 +

ifHCOutMulticastPkts1 +

ifHCOutBroadcastPkts1)

l
((100.0 * collisonsOut) /

(ifOutUcastPkts1 + ifOutNUcastPkts1)

l
((100.0 * collisonsOut) / (ifOutUcastPkts

+ ifOutMulticastPkts + ifOutBroadcastPkts)

LAN Deferred Frames (sum) Total number of frames for which the first transmission
attempt on the selected interface is delayed because the
medium is busy

The count does not include the following:

l Frames involved in collisions

l Interfaces that are operating in full-duplex mode

l Frames delayed because of discontinuities in the
management system

LAN Alignment Errors (sum) Total number of input packets that had cyclic redundancy
checksum errors

1Number of output collisions detected on the selected interface for the selected time range
1Number of packets that higher-level protocols requested be transmitted, and which were not
addressed to amulticast or broadcast address at the sub-layer for the selected interface. These
include those packets that were discarded or not sent.
1Number of packets transmitted to amulticast address per second during the selected time range
1Number of packets transmitted to a broadcast address per second during the selected time
range
1Number of packets that higher-level protocols requested be transmitted, and which were not
addressed to amulticast or broadcast address at the sub-layer for the selected interface. These
include those packets that were discarded or not sent.
1Number of packets that higher-level protocols requested be transmitted to a non-unicast (i.e., a
subnet roadcast or subnet multicast) address. These include the packets that were discarded or
not sent.
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Metric Name Description

Input Queue Drops

l Sum

l Baseline Average (avg)

l Baseline Deviation (avg)

l Baseline Slope (avg)

l Upper Normal (max)

l Lower Normal (min)

l Days To Threshold (min)

l Baseline Exception Count
(sum)

l Baseline Exception Rate
(avg)

l Baseline Intercept
Component (avg)

l Baseline Trend Component
(avg)

l Baseline Seasonal
Component (avg)

l Anomaly Sample Flags
Window (sum)

l Baseline Linear Samples
Used (avg)

l Baseline Seasonal
Samples Used (avg)

l Upper Threshold (max)

l Lower Threshold (min)

l Threshold Exception Count
(sum)

l Threshold Exception Rate
(avg)

Number of packets the selected interface dropped because
the input queue was full

NNMi enables you to define an upper and a lower thresholds
for the count of input queue drops.

See HP Network NodeManager i SoftwareOnline Help for
Administrators for information about how to define thresholds
using the Threshold Configuration form.
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Metric Name Description

Output Queue Drops

l Sum

l Baseline Average (avg)

l Baseline Deviation (avg)

l Baseline Slope (avg)

l Upper Normal (max)

l Lower Normal (min)

l Days To Threshold (min)

l Baseline Exception Count
(sum)

l Baseline Exception Rate
(avg)

l Baseline Intercept
Component (avg)

l Baseline Trend Component
(avg)

l Baseline Seasonal
Component (avg)

l Anomaly Sample Flags
Window (sum)

l Baseline Linear Samples
Used (avg)

l Baseline Seasonal
Samples Used (avg)

l Upper Threshold (max)

l Lower Threshold (min)

l Threshold Exception Count
(sum)

l Threshold Exception Rate
(avg)

Number of packets the selected interface dropped because
the output queue was full

NNMi enables you to define an upper and a lower thresholds
for the count of output queue drops.

See HP Network NodeManager i SoftwareOnline Help for
Administrators for information about how to define thresholds
using the Threshold Configuration form.

Note:The ETHERLIKE-MIB polling policies override the OLD-CISCO-INTERFACES-MIB polling
policies, if the selected interface supports both ETHERLIKE-MIB andOLD-CISCO-
INTERFACES-MIB, and thus both State Poller policies.

Glossary for Wireless LAN Metrics
Available only onWLAN interfaces – Following IEEE802dot11 performance policy
1Clear to Send
1Request to Send
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Metric Name Description

SuccessfulRetryCount (sum) Total number of times theMSDU is successfully
transmitted after one or more re-transmissions.

RTSSuccessCount (sum) Total number of CTS1 received in response to anRTS1.

TransmittedFragmentCount
(sum)

Total number of acknowledgedMPDU with an individual
address in the address 1 field or anMPDU with amulticast
address in the address 1 field of type Data or
Management."

MaxedOutTransmitAttempts
(sum)

Total number of times theMSDU is not transmitted
successfully due to the number of transmit attempts
exceeding either the dot11ShortRetryLimit or
dot11LongRetryLimit.

ReceivedFragmentCount (sum) Total number of successfully receivedMPDU of type Data
or Management.

UndecryptableFrames (sum) Total number of frames received with theWEP subfield of
the FrameControl field set to one and theWEPOn value for
the key mapped to the TA's MAC address indicates that
the frame should not have been encrypted or that frame is
discarded due to the receiving STA not implementing the
privacy option.

RTSFailureCount (sum) Total number of CTS signals failed to be sent in response
to an RTS.

ACKFailureCount (sum) Total number of times the ACK was not received when
expected.

FrameDuplicateCount (sum) Total number of frames received that the Sequence Control
field indicates is a duplicate.

FCSErrorCount (sum) Total number of FCS errors detected in receivedMPDU.

Glossary for Wireless LAN Metrics
Available only onWLAN interfaces supporting CISCO-DOT11-ASSOCIATION-MIB

Metric Name Description

NumActiveWirelessClients Number of wireless clients currently associating with the
selected device on the selected interface

You can select the device and interface using the NPS

1Clear to Send
1Request to Send
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l Average

l Minimum

l Maximum

 Topology Selector.

NPS calculates themetric to display average, minimum,
andmaximum number of wireless clients associated to the
selected interface.

NumActiveBridges

l Average

l Minimum

l Maximum

Number of bridges currently associating with this device on
the selected interface.

You can select the device and interface using the NPS
 Topology Selector.

NPS calculates themetric to display average, minimum,
andmaximum number of bridges associated to the
selected interface.

NumActiveRepeaters

l Average

l Minimum

l Maximum

Number of repeaters currently associating with this device
on the selected interface.

You can select the device and interface using the NPS
 Topology Selector.

NPS calculates themetric to display average, minimum,
andmaximum number of repeaters associated to the
selected interface.

StationsAssociated (sum) Total number of stations associated with this device on the
selected interface.

Displays the number of stations associated to the interface
since the device re-started.

StationsAuthenticated (sum) Total number of stations authenticated with this device on
the selected interface.

Displays the number of stations authenticated on the
interface since the device re-started.

StationsRoamedIn (sum) Total number of stations roamed (transferred) from another
device to this device on the selected interface

Displays the number of stations transferred to the selected
interface since the device re-started.

StationsRoamedAway (sum) Total number of stations roamed (transferred) away from
this device on the selected interface

Displays the number of stations transferred from the
selected interface since the device re-started.

StationsDeauthenticated (sum) Total number of stations de-authenticated with this device
on the selected interface

Displays the number of stations for which the
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authentication were removed from the selected interface
since the device re-started.

StationsDisassociated (sum) Total number of stations disassociated with this device on
the selected interface

Displays the number of stations that were disassociated
from the selected interface since the device re-started.

Glossary for SDH DS1 Metrics
Available only for DS1 Interfaces

Metric Name Description

DSx1SESs
Rate

l Average

l Minimum

l Maximum

Rate of Severely Errored Seconds encountered by the selected DS1 interface
in one second.

The object returns the total number of Severely Errored Seconds encountered
by the interface in past 15minutes.

NPS calculates the rate of Severely Errored Seconds per second.

NPS calculates themetric to display average, minimum, andmaximum rate of
Severely Errored Seconds encountered by the selected interface.

DSx1SEFSs
Rate

l Average

l Minimum

l Maximum

Rate of Severely Errored Framing Seconds encountered by the selected DS1
interface in one second.

The object returns the total number of Severely Errored Framing Seconds
encountered by the interface in past 15minutes.

NPS calculates the rate of Severely Errored Framing Seconds per second.

NPS calculates themetric to display average, minimum, andmaximum rate of
Severely Errored Framing Seconds encountered by the selected interface.

DSx1ESs Rate

l Average

l Minimum

l Maximum

Rate of Errored Seconds encountered by the selected DS1 interface in one
second.

The object returns the total number of Errored Seconds encountered by the
interface in past 15minutes.

NPS calculates the rate of Errored Seconds per second.

NPS calculates themetric to display average, minimum, andmaximum rate of
Errored Seconds encountered by the selected interface.

DSx1UASs
Rate

l Average

l Minimum

l Maximum

Rate of Unavailable Seconds encountered by the selected DS1 interface in
one second.

The object returns the total number of Errored Seconds encountered by the
interface in past 15minutes.

NPS calculates the rate of Errored Seconds per second.
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Metric Name Description

NPS calculates themetric to display average, minimum, andmaximum rate of
Errored Seconds encountered by the selected interface.

DSx1PCVs/sec

l Average

l Minimum

l Maximum

Rate of Path Coding Violations encountered by the selected DS1 interface in
one second.

The object returns the total number of Path Coding Violations encountered by
the interface in past 15minutes.

NPS calculates the rate of Path Coding Violations per second.

NPS calculates themetric to display average, minimum, andmaximum rate of
Path Coding Violations encountered by the selected interface.

DSx1DMs Rate

l Average

l Minimum

l Maximum

Rate of DegradedMinutes encountered by the selected DS1 interface in one
second.

The object returns the total number of DegradedMinutes encountered by the
interface in past 15minutes.

NPS calculates the rate of DegradedMinutes per second.

NPS calculates themetric to display average, minimum, andmaximum rate of
DegradedMinutes encountered by the selected interface.

DSx1BESs
Rate

l Average

l Minimum

l Maximum

Rate of Bursty Errored Seconds encountered by the selected DS1 interface in
one second.

The object returns the total number of Bursty Errored Seconds encountered by
the interface in past 15minutes.

NPS calculates the rate of Bursty Errored Seconds per second.

NPS calculates themetric to display average, minimum, andmaximum rate of
Bursty Errored Seconds encountered by the selected interface.

DSx1LESs
Rate

l Average

l Minimum

l Maximum

Rate of Line Errored Seconds encountered by the selected DS1 interface in
one second.

The object returns the total number of Line Errored Seconds encountered by
the interface in past 15minutes.

NPS calculates the rate of Line Errored Seconds per second.

NPS calculates themetric to display average, minimum, andmaximum rate of
Line Errored Seconds encountered by the selected interface.
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Metric Name Description

DSx1LCVs/sec

l Average

l Minimum

l Maximum

Rate of Line Coding Violations encountered by the selected DS1 interface in
one second.

The object returns the total number of Line Coding Violations encountered by
the interface in past 15minutes.

NPS calculates the rate of Line Coding Violations per second.

NPS calculates themetric to display average, minimum, andmaximum rate of
Line Coding Violations encountered by the selected interface.

DSx1CSSs
Rate

l Average

l Minimum

l Maximum

Rate of Controlled Slip Seconds encountered by the selected DS1 interface in
one second.

The object returns the total number of Controlled Slip Seconds encountered by
the interface in past 15minutes.

NPS calculates the rate of Controlled Slip Seconds per second.

NPS calculates themetric to display average, minimum, andmaximum rate of
Controlled Slip Seconds encountered by the selected interface.

Glossary for SDH DS3 Metrics
Available only for DS3 Interfaces

Metric Name Description

DSx3PCVs/sec

l Average

l Minimum

l Maximum

Count of Path Coding Violations encountered by the selected DS3 interface
in one second.

The object returns the total number of Path Coding Violations encountered
by the interface in past 15minutes.

NPS calculates the total number of Path Coding Violations per second.

NPS calculates themetric to display average, minimum, andmaximum
number of Path Coding Violations encountered by the selected interface.

DSx3LESs
Rate

l Average

l Minimum

l Maximum

Rate of Line Errored Seconds encountered by the selected DS3 interface in
one second.

The object returns the total number of Line Errored Seconds encountered by
the interface in past 15minutes.

NPS calculates the percentage of Line Errored Seconds per second.

NPS calculates themetric to display average, minimum, andmaximum rate
of Line Errored Seconds encountered by the selected interface.
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Metric Name Description

DSx3LCVs/sec

l Average

l Minimum

l Maximum

Count of Line Coding Violations encountered by the selected DS3 interface
in one second.

The object returns the total number of Line Coding Violations encountered by
the interface in past 15minutes.

NPS calculates the total number of Line Coding Violations per second.

NPS calculates themetric to display average, minimum, andmaximum
number of Line Coding Violations encountered by the selected interface.

DSx3CCVs/sec

l Average

l Minimum

l Maximum

Count of C-bit Coding Violations encountered by the selected DS3 interface
in one second.

The object returns the total number of C-bit Coding Violations encountered
by the interface in past 15minutes.

NPS calculates the number of C-bit Coding Violations per second.

NPS calculates themetric to display average, minimum, andmaximum
number of C-bit Coding Violations encountered by the selected interface.

DSx3SEFSs
Rate

l Average

l Minimum

l Maximum

Rate of Severely Errored Framing Seconds encountered by the selected
DS3 interface in one second.

The object returns the total number of Severely Errored Framing Seconds
encountered by the interface in past 15minutes.

NPS calculates the percentage of Severely Errored Framing Seconds per
second.

NPS calculates themetric to display average, minimum, andmaximum rate
of Severely Errored Framing Seconds encountered by the selected interface.

DSx3CSESs
Rate

l Average

l Minimum

l Maximum

Rate of C-bit Severely Errored Seconds encountered by the selected DS3
interface in one second.

The object returns the total number of C-bit Severely Errored Seconds
encountered by the interface in past 15minutes.

NPS calculates the percentage of C-bit Severely Errored Seconds per
second.

NPS calculates themetric to display average, minimum, andmaximum rate
of C-bit Severely Errored Seconds encountered by the selected interface.
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Metric Name Description

DSx3PESs
Rate

l Average

l Minimum

l Maximum

Rate of P-bit Errored Seconds encountered by the selected DS3 interface in
one second.

The object returns the total number of P-bit Errored Seconds encountered by
the interface in past 15minutes.

NPS calculates the percentage of P-bit Errored Seconds per second.

NPS calculates themetric to display average, minimum, andmaximum rate
of P-bit Errored Seconds encountered by the selected interface.

DSx3PSESs
Rate

l Average

l Minimum

l Maximum

Rate of P-bit Severely Errored Seconds encountered by the selected DS3
interface in one second.

The object returns the total number of P-bit Severely Errored Seconds
encountered by the interface in past 15minutes.

NPS calculates the percentage of P-bit Severely Errored Seconds per
second.

NPS calculates themetric to display average, minimum, andmaximum rate
of P-bit Severely Errored Seconds encountered by the selected interface.

DSx3UASs
Rate

l Average

l Minimum

l Maximum

Rate of Unavailable Seconds encountered by the selected DS3 interface in
one second.

The object returns the total number of Errored Seconds encountered by the
interface in past 15minutes.

NPS calculates the percentage of Errored Seconds per second.

NPS calculates themetric to display average, minimum, andmaximum rate
of Errored Seconds encountered by the selected interface.

DSx3CESs
Rate

l Average

l Minimum

l Maximum

Rate of C-bit Errored Seconds encountered by the selected DS3 interface in
one second.

The object returns the total number of C-bit Errored Seconds encountered by
the interface in past 15minutes.

NPS calculates the percentage of C-bit Errored Seconds per second.

NPS calculates themetric to display average, minimum, andmaximum rate
of C-bit Errored Seconds encountered by the selected interface.

Glossary for SONET/SDH Metrics
Available only for SONET/SDH Interfaces
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Metric Name Description

SonetSectionESs Rate

l Average

l Minimum

l Maximum

Rate of Errored Seconds encountered by the selected
SONET/SDH Section interface in one second.

The object returns the total number of Errored Seconds
encountered by the SONET/SDH Section interface in past 15
minutes.

NPS calculates the rate of Errored Seconds per second.

NPS calculates themetric to display average, minimum, and
maximum rate of Errored Seconds encountered by the selected
SONET/SDH Section interface.

SonetSectionSESs Rate

l Average

l Minimum

l Maximum

Rate of Severely Errored Seconds encountered by the selected
SONET/SDH Section interface in one second.

The object returns the total number of Severely Errored Seconds
encountered by the SONET/SDH Section interface in past 15
minutes.

NPS calculates the rate of Severely Errored Seconds per second.

NPS calculates themetric to display average, minimum, and
maximum rate of Severely Errored Seconds encountered by the
selected SONET/SDH Section interface.

SonetSectionSEFSs Rate

l Average

l Minimum

l Maximum

Rate of Severely Errored Framing Seconds encountered by the
selected SONET/SDH Section interface in one second.

The object returns the total number of Severely Errored Framing
Seconds encountered by the SONET/SDH Section interface in
past 15minutes.

NPS calculates the rate of Severely Errored Framing Seconds per
second.

NPS calculates themetric to display average, minimum, and
maximum rate of Severely Errored Framing Seconds encountered
by the selected SONET/SDH Section interface.

SonetSectionCVs/sec

l Average

l Minimum

l Maximum

Rate of Coding Violations encountered by the selected
SONET/SDH Section interface in one second.

The object returns the total number of Coding Violations
encountered by the SONET/SDH Section interface in past 15
minutes.

NPS calculates the rate of Coding Violations per second.

NPS calculates themetric to display average, minimum, and
maximum rate of Coding Violations encountered by the selected
SONET/SDH Section interface.
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Metric Name Description

SonetLineESs Rate

l Average

l Minimum

l Maximum

Rate of Errored Seconds encountered by the selected
SONET/SDH Line interface in one second.

The object returns the total number of Errored Seconds
encountered by the SONET/SDH Line interface in past 15
minutes.

NPS calculates the rate of Errored Seconds per second.

NPS calculates themetric to display average, minimum, and
maximum rate of Errored Seconds encountered by the selected
SONET/SDH Line interface.

SonetLineSESs Rate

l Average

l Minimum

l Maximum

Rate of Severely Errored Seconds encountered by the selected
SONET/SDH Line interface in one second.

The object returns the total number of Severely Errored Seconds
encountered by the SONET/SDH Line interface in past 15
minutes.

NPS calculates the rate of Severely Errored Seconds per second.

NPS calculates themetric to display average, minimum, and
maximum rate of Severely Errored Seconds encountered by the
selected SONET/SDH Line interface.

SonetLineUASs Rate

l Average

l Minimum

l Maximum

Rate of Unavailable Seconds encountered by the selected
SONET/SDH Line interface in one second.

The object returns the total number of Unavailable Seconds
encountered by the SONET/SDH Line interface in past 15
minutes.

NPS calculates the rate of Unavailable Seconds per second.

NPS calculates themetric to display average, minimum, and
maximum rate of Unavailable Seconds encountered by the
selected SONET/SDH Line interface.

SonetFarEndLineESs
Rate

l Average

l Minimum

l Maximum

Rate of Far End Errored Seconds encountered by the selected
SONET/SDH Medium/Section/Line interface in one second.

The object returns the total number of Far End Errored Seconds
encountered by the SONET/SDH Medium/Section/Line interface
in past 15minutes.

NPS calculates the rate of Far End Errored Seconds per second.

NPS calculates themetric to display average, minimum, and
maximum rate of Far End Errored Seconds encountered by the
selected SONET/SDH Medium/Section/Line interface.
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Metric Name Description

SonetFarEndLineSESs
Rate

l Average

l Minimum

l Maximum

Rate of Far End Severely Errored Seconds encountered by the
selected SONET/SDH Medium/Section/Line interface in one
second.

The object returns the total number of Far End Severely Errored
Seconds encountered by the SONET/SDH Medium/Section/Line
interface in past 15minutes.

NPS calculates the rate of Far End Severely Errored Seconds per
second.

NPS calculates themetric to display average, minimum, and
maximum rate of Far End Severely Errored Seconds encountered
by the selected SONET/SDH Medium/Section/Line interface.

SonetFarEndLineCVs/sec

l Average

l Minimum

l Maximum

Rate of Far End Coding Violations encountered by the selected
SONET/SDH Medium/Section/Line interface in one second.

The object returns the total number of Far End Coding Violations
encountered by the SONET/SDH Medium/Section/Line interface
in past 15minutes.

NPS calculates the rate of Far End Coding Violations per second.

NPS calculates themetric to display average, minimum, and
maximum rate of Far End Coding Violations encountered by the
selected SONET/SDH Medium/Section/Line interface.

SonetFarEndLineUASs
Rate

l Average

l Minimum

l Maximum

Rate of Far End Unavailable Seconds encountered by the
selected SONET/SDH Medium/Section/Line interface in one
second.

The object returns the total number of Far End Unavailable
Seconds encountered by the SONET/SDH Medium/Section/Line
interface in past 15minutes.

NPS calculates the rate of Far End Unavailable Seconds per
second.

NPS calculates themetric to display average, minimum, and
maximum rate of Far End Unavailable Seconds encountered by
the selected SONET/SDH Medium/Section/Line interface.
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Metric Name Description

SonetPathESs Rate

l Average

l Minimum

l Maximum

Rate of Errored Seconds encountered by the selected
SONET/SDH Path interface in one second.

The object returns the total number of Errored Seconds
encountered by the SONET/SDH Path interface in past 15
minutes.

NPS calculates the rate of Errored Seconds per second.

NPS calculates themetric to display average, minimum, and
maximum rate of Errored Seconds encountered by the selected
SONET/SDH Path interface.

SonetPathSESs Rate

l Average

l Minimum

l Maximum

Rate of Severely Errored Seconds encountered by the selected
SONET/SDH Path interface in one second.

The object returns the total number of Severely Errored Seconds
encountered by the SONET/SDH Path interface in past 15
minutes.

NPS calculates the rate of Severely Errored Seconds per second.

NPS calculates themetric to display average, minimum, and
maximum rate of Severely Errored Seconds encountered by the
selected SONET/SDH Path interface.

SonetPathCVs/sec

l Average

l Minimum

l Maximum

Rate of Coding Violations encountered by the selected
SONET/SDH Path interface in one second.

The object returns the total number of Coding Violations
encountered by the SONET/SDH Path interface in past 15
minutes.

NPS calculates the rate of Coding Violations per second.

NPS calculates themetric to display average, minimum, and
maximum rate of Coding Violations encountered by the selected
SONET/SDH Path interface.

SonetPathUASs Rate

l Average

l Minimum

l Maximum

Rate of Unavailable Seconds encountered by the selected
SONET/SDH Path interface in one second.

The object returns the total number of Unavailable Seconds
encountered by the SONET/SDH Path interface in past 15
minutes.

NPS calculates the rate of Unavailable Seconds per second.

NPS calculates themetric to display average, minimum, and
maximum rate of Unavailable Seconds encountered by the
selected SONET/SDH Path interface.
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Metric Name Description

SonetFarEndPathESs
Rate

l Average

l Minimum

l Maximum

Rate of Far End Errored Seconds encountered by the selected
SONET/SDH Path interface in one second.

The object returns the total number of Far End Errored Seconds
encountered by the SONET/SDH Path interface in past 15
minutes.

NPS calculates the rate of Far End Errored Seconds per second.

NPS calculates themetric to display average, minimum, and
maximum rate of Far End Errored Seconds encountered by the
selected SONET/SDH Path interface.

SonetFarEndPathSESs
Rate

l Average

l Minimum

l Maximum

Rate of Far End Severely Errored Seconds encountered by the
selected SONET/SDH Path interface in one second.

The object returns the total number of Far End Severely Errored
Seconds encountered by the SONET/SDH Path interface in past
15minutes.

NPS calculates the rate of Far End Severely Errored Seconds per
second.

NPS calculates themetric to display average, minimum, and
maximum rate of Far End Severely Errored Seconds encountered
by the selected SONET/SDH Path interface.

SonetFarEndPathCVs/sec

l Average

l Minimum

l Maximum

Rate of Far End Coding Violations encountered by the selected
SONET/SDH Path interface in one second.

The object returns the total number of Far End Coding Violations
encountered by the SONET/SDH Path interface in past 15
minutes.

NPS calculates the rate of Far End Coding Violations per second.

NPS calculates themetric to display average, minimum, and
maximum rate of Far End Coding Violations encountered by the
selected SONET/SDH Path interface.

SonetFarEndPathUASs
Rate

l Average

l Minimum

l Maximum

Rate of Unavailable Seconds encountered by the selected
SONET/SDH Path interface in one second.

The object returns the total number of Unavailable Seconds
encountered by the SONET/SDH Path interface in past 15
minutes.

NPS calculates the rate of Unavailable Seconds per second.

NPS calculates themetric to display average, minimum, and
maximum rate of Unavailable Seconds encountered by the
selected SONET/SDH Path interface.
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Interface Health Reports
The Interface Health reports show the performance data for network interfaces in your
environment.

Use Interface Health reports to determine if an interface is over-utilized or if it needs an upgrade.

Opening Reports from NNMi
From the NNMi Console, you have these options:

l Click theReporting - Report Menu option under theActions menu; launch reports from the
Report Menu.

l Launching Pre-Filtered iSPI Reports Directly from NNMi

If you are interested in a particular interface, launch a pre-filtered report from NNMi; otherwise,
open a workspace view from NNMi, move to the iSPI, and begin your investigation from the
Report Menu. Tomove from NNMi to the iSPI:

a. Log in to the NNMi Console.

b. Select a workspace.

c. Open a view (nodes, interfaces, components, or incidents).

d. Select Actions > Reporting - Report Menu page

Interface Health Baseline Sleeve Report
This report analyzes how close themetric performance value is to the threshold levels. In other
words, this report enables you to analyze when themetric will reach the threshold.

Using this report, you can:

l Analyze if the interface utilization or performance is within the expected (normal) range for the
selected time range.

l Detect if themetric performance is about to cross the high and low thresholds.

For example, if you generate the Baseline Sleeve Chart report for the baselinemetric
Utilization In, the chart displays the how close the interface utilization for incoming flow is to
the high and low threshold.

l Savemultiple Baseline Sleeve Reports for a specific metric for different time ranges, and
analyze themetric performance trend.

This report supports onemetric.

To change the TimeControls defaults, see Change TimeControls in theUsing Reports > Change
Default Settings section.

To change the Topology Filters defaults, see Set Topology Filters in theUsing Reports > Change
Default Settings section.
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To change the Report Options defaults, see Change Report Options in theUsing Reports >
Change Default Settings section.

Interface Health Calendar Report
The Calendar Report uses a traditional, calendar-style layout to show hourly statistics for two
metrics in a single, extended graph spanning over multiple days.

Features and Defaults

The Calendar Report defaults to:

l Interfaces = All

l Dates/Times = Last 31 days

l Metric(s) Shown on Y1 Axis (Primary Metric) = Volume Bytes (sum)

l Metric(s) Shown on Y2 Axis (Secondary Metric) = Utilization (avg)

The default view shows data for the current month. Depending on how long the iSPI has been
collecting data from NNMi, youmay have the option of looking at data for the previous 70 days if
you use the option Until Now.

Note: If you set the TimeRange below 24 hours, the followingmessage appears:
This report is not designed to operate with a time range of less than

24 hours. Please modify your time selections.

Use Case

Use this report to observe:

l gradual trends over time

l isolated spikes

l to verify that an abnormal condition has returned to normal

l to make comparisons

This report also reveals:

l Day of week patterns

l Hour of day patterns

For example, if utilization is spiking on Tuesdays, or if response time issues are occurring daily at
11:00 a.m., the report will highlight these events.

l To change the TimeControls defaults, see Change TimeControls in theUsing Reports >
Change Default Settings section.

l To change the Topology Filters defaults, see Set Topology Filters in theUsing Reports >
Change Default Settings section.

l To change the Report Options defaults, see Change Report Options in theUsing Reports >
Change Default Settings section.
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Interface Health Chart Detail Report
Chart Detail report enables you to perform a trend analysis for the network health and
performance based on historical interface health data.

The Chart Detail report displays a comparative analysis of the selectedmetrics for each time unit.

For example, if you need to compare how the average Threshold Exception Rate was affected by
variance in the average Response Time permillisecond for the past one week, you can generate
theWeekly Interface Health report for the selected node group.

You can also select two or more nodes, node groups, interfaces, or interface groups to generate
Chart Detail report.

Using this report you can:

l Analyze the trend of network health and performance for multiple nodes, node groups,
interfaces, or interface groups based on one unit of time. Each unit of time is called as a
Display Grain . Each Display Grain is measured as follows:
n Fiveminutes for Hourly report

n One hour for daily report

n One day for weekly report

n One day for monthly report

l Identify the interface that is causing any ups and downs in the network health and
performance.

l Detect any persistent problem in the interface health and performance.

l Compare network health and performance of more than two nodes, node groups, interfaces, or
interface groups based on historical interface health data.

The following are the available filters in the TimeControls pane for Chart Detail Report:

l Start Date/Time

l TimeRange

l Display Grain

l Hour of day

l Day of Week

Features and Defaults

The graph on this report tracks up to six metrics per axis over the selected time period. Unless
youmodify the defaults, Chart Detail defaults to the following:

l Interfaces = All

l Metric(s) Shown on Y1 Axis = Volume Bytes (sum)

l Metric(s) Shown on Y2 Axis = Availability - Utilization (avg)

The Chart Detail report displays the selectedmetrics using two Y axis.
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l The left Y axis (also known as the Y1 axis) displays the performance of themainmetric based
on which you want to generate the report.

l The right Y axis (also known as the Y2 axis) displays the performance of themetric that should
overlay themain (primary) metric.

To add another metric, click Options and then click .

To remove ametric that you have already added, click Options and then click .

The Chart Detail report enables you to view the data in the tabular format as well. To view the
table, click Options, and then select Table. The Table appears instead of the chart. To view both
the chart and the table, click Options, and then select Chart and Table.

l To change the TimeControls defaults, see Change TimeControls in theUsing Reports >
Change Default Settings section.

l To change the Topology Filters defaults, see Set Topology Filters in theUsing Reports >
Change Default Settings section.

l To change the Report Options defaults, see Change Report Options in theUsing Reports >
Change Default Settings section.

Interface Health Dashboard
The Dashboard report provides an overview of the interfaces available on your network using a
combination of gauges, heat charts, and ordered Top 5 lists. The report displays the threshold
violations for volume, error, and availability. Threshold violations can point to a network-related
problem ormay indicate that your thresholds within NNMi need to be changed.

To group the data within the dashboard:

1. Click Options.

2. In the Grouping By: field, select a topology filter to group the dashboard data.

For example: if you use a grouping option of Node Name, all Availability exceptions that fall
within the time and topology constraints are grouped by Node Name and displayed as a
percentage of the total samples in the left gauge.

Dashboard Sections

Gauge

The gauges provide the following exception count statistics:

l Availability Exceptions (% samples)

l Utilization Exceptions (% samples)

l Discard Rate Exceptions (% samples)

l Error Rate Exceptions (% samples)

When the NPS database has no data, the needle icons on the gauges on the Dashboard report do
not appear.
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Top 5 Lists

The top-5 lists displays nodes responsible for the exceptions showing up in the gauges:

l Top 5Qualified Interface Names by Utilization Exceptions

l Top 5Qualified Interface Names by Availability Exceptions

Top 5Qualified Interface Names by Discard Exceptions Heat Chart

Using the heat chart, you can:

l Analyze the pattern of discard exception for past one hour.

l Compare the discard performance of different interfaces.

l Detect the time range in the past one hour when the discard rates were the highest.

Example
If the gauges are showing few or no exceptions, this means that none of your interfaces, including
the interfaces in the top 5 lists, are experiencing problems with utilization or availability.

For example, your network is divided into groups that represent regions or strategic locations for
your enterprise. With the grouping option set to NodeGroup name, the report lists each of your
strategic NodeGroups (as defined within NNMi) and provides the current statistics for exceptions
within each group.

If an unexpected change in exception counts is noted, you can click the appropriate gauge needle
or NodeGroup within the Top 5 lists, and then launch another report (such as Chart Detail) to
investigate trends or changes within the network as they are occurring.

The thresholds that create exceptions are set from NNMi, not from the iSPI. If you want to set or
modify thresholds, refer to the online help for NNMi administrators.

l To change the TimeControls defaults, see Change TimeControls in theUsing Reports >
Change Default Settings section.

l To change the Topology Filters defaults, see Set Topology Filters in theUsing Reports >
Change Default Settings section.

l To change the Report Options defaults, see Change Report Options in theUsing Reports >
Change Default Settings section.

Interface Health Headline Report
The Headline Report provides a broad view of interface performance for past one day, using the
following graphs:

l Volume of data passed through the interface (in MB)

l Average percentage of interface availability
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l Average andmaximum interface utilization percentage

l Threshold and baseline utilization exception rates

l Maximum throughput per second (in bps)

l Total number of data packets transmitted or received using unknown protocol

l Maximum percentage of discard rate

l Total number of discard rate exceptions

l Maximum percentage of error rate

l Total number of error rate exceptions

This report enables you to:

l View every aspect of interface utilization and performance at once.

l View trends and verify that interface utilization and performance aremeeting expectations.

l Identify isolated aberration in the graphs and detect any unexpected utilization or performance
trend.

The Headline report does not provide options to create graphs based on other metrics.

This report shows the data for exceptions only if thresholds for performancemetrics are set in
NNMi.

l To change the TimeControls defaults, see Change TimeControls in theUsing Reports >
Change Default Settings section.

l To change the Topology Filters defaults, see Set Topology Filters in theUsing Reports >
Change Default Settings section.

l To change the Report Options defaults, see Change Report Options in theUsing Reports >
Change Default Settings section.

Interface Health Executive Report
The Executive Report provides a broad view of interface performance for the selected time range,
using the following graphs:

l Volume of data passed through the interface (in GB)

l Average percentage of interface availability

l Average andmaximum interface utilization percentage

l Threshold and baseline utilization exception rates

l Volume of data aggregated based on the following:
n Volume of data passed through the node groups

n Volume of data passed for each hour of the for the selected time range

l Average percentage of interface utilization for the node groups for the selected time range
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l Average number of threshold and baseline exception faced by the node groups for the selected
time range

This report enables you to:

l View every aspect of interface utilization and performance at once.

l View trends and verify that interface utilization and performance aremeeting expectations.

l Identify isolated aberration in the graphs and detect any unexpected utilization or performance
trend.

l View the trend of utilization for the node groups for the selected time range

The Executive report does not provide options to create graphs based on other metrics.

The default display grain for the Executive report is one hour.

This report shows the data for exceptions only if thresholds for performancemetrics are set in
NNMi.

l To change the TimeControls defaults, see Change TimeControls in theUsing Reports >
Change Default Settings section.

l To change the Topology Filters defaults, see Set Topology Filters in theUsing Reports >
Change Default Settings section.

Interface Health Headline - Wireless LAN Report
Available only on WLAN interfaces – Following IEEE802dot11 performance policy

The Headline -Wireless LAN Report provides a performance overview of the wireless LAN
 interfaces available in your network. The report displays interface availability and performance for
past 24 hours, using the following graphs:

l Total number of fragmented packets the interfaces have transmitted (sent and received)
successfully

l Total number of successful RTS1 compared to the total number of failed RTS

l Average andmaximum number of wireless clients using the interface

l Maximum number of active bridges and repeaters available in the network for past 24 hours

l Total number of wireless stations available in the network. The graph displays total number of
associated, authenticated, roamed in and roamed away stations available in the network.

l Total number of ACK2 failures occurred in the wireless LAN for past 24 hours

l Total number of duplicate frames transmitted by the wireless LAN

1Request To Send: A message sent from a device seeking access to a wireless network.
2Acknowledgement code: A transmission control character used to indicate that a transmitted
message was received uncorrupted, without errors or that the receiving station is ready to accept
transmissions. The receiving station sends this code to the sender to indicate that it has accepted
the transmission.
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l Total number of maxed out transmission attempts made by wireless LAN

l Total number of undecryptable frames received by wireless LAN in past 24 hours

l Total number of FCS1 error occurred in the wireless LAN for past 24 hours

This report enables you to:

l View every aspect of the wireless LAN interface utilization and performance at once.

l View trends and verify that the utilization and performances of the wireless LAN interfaces are
meeting expectations.

l Identify isolated aberration in the graphs and detect any unexpected utilization or performance
trend.

The Headline -Wireless LAN report does not provide options to create graphs based on other
metrics.

This report shows the data for exceptions only if thresholds for performancemetrics are set in
NNMi.

l To change the TimeControls defaults, see Change TimeControls in theUsing Reports >
Change Default Settings section.

l To change the Topology Filters defaults, see Set Topology Filters in theUsing Reports >
Change Default Settings section.

l To change the Report Options defaults, see Change Report Options in theUsing Reports >
Change Default Settings section.

Interface Health Heat Chart Report
The Heat Chart tracks the hourly performance of a single metric. The default metric is Volume -
Bytes (sum). The default time period is the last 31 days. Performance is color-coded, making it
easy to see whether performance has been satisfactory or unsatisfactory.

Features and Defaults

The legend at the top of the report maps a range of normalized performance values to a particular
color.

Beneath the legend, a table represents the normalized values of a performancemetric (rows of the
table represent hours of the day; columns of the table represent days).

Each cell inside the table is color-coded and each cell inside the table indicates a specific value of
themetric. You can also hover themouse pointer on the cell to see the absolute metric value of
each hour.

The default topology filters for the Heat Chart are as follows:

1FrameCheck Sequence: Each PPP packet has a checksum attached to ensure that the data
being received is the data being sent. If the FCS of an incoming packet is incorrect, the packet is
dropped and the FCS error count is increased.
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l Interfaces = All

l Time Period = Last 31 days

l Hour of Day = All

l Day of Week = All

l Metric = Volume - Bytes (sum)

Time range options are any period that is not less than 24 hours.

Use Case

Use the Heat Chart to identify gradual shifts from one range of performance to another range, to
spot an isolated instance of poor performance that affected the results for past 24 hours, to spot
day-of-week patterns, and to verify that an abnormal condition returned to normal after a problem
was corrected.

l To change the TimeControls defaults, see Change TimeControls in theUsing Reports >
Change Default Settings section.

l To change the Topology Filters defaults, see Set Topology Filters in theUsing Reports >
Change Default Settings section.

l To change the Report Options defaults, see Change Report Options in theUsing Reports >
Change Default Settings section.

Interface Health Managed Inventory Report
Use theManaged Inventory Report to view the number of instances of each topology attribute
seen in the collected data within the selected time range. For example, if the report is run for ‘Last
1 Hour,’ you will see the number of unique values for each attribute seen in the data collected over
the last hour. This report can be useful for checking, for example, the number of nodes polled over
any given time range.

You can use the available attributes to filter the data of your interest and create a report that
represents only the elements of your interest. The report presents the list of attributes in the form
of a table; the Count column of the table indicates the number of entries for each attribute. For
example, count 5 for the topology item Node Locationmeans all nodes on your network can be
grouped based on 5 different locations that host the nodes.

You can use the following topology attributes with the Interface Health reports:

l Qualified Interface Name

l Interface Name

l Interface Alias

l Interface Descr

l Interface Index

l Interface Type

l Interface Physical Address
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l Interface Speed (In:Out)

l Interface ID

l Interface UUID

l Node Name

l Node Contact

l Node Location

l Node Family

l Node Vendor

l Node ID

l Node UUID

l Interface ODBID

l NodeODBID

l Tenant Name

l Tenant UUID

l SecGroup Name

l SecGroup UUID )

l To change the TimeControls defaults, see Change TimeControls in theUsing Reports >
Change Default Settings section.

l To change the Topology Filters defaults, see Set Topology Filters in theUsing Reports >
Change Default Settings section.

TheManaged Inventory report may take significant time to build if you select a time range
greater than 24 hours.

TheManaged Inventory report may take significant time to build if you select a time range greater
than 24 hours.

Interface Health Most Changed Report
This report compares performance the components for two different (consecutive) time periods
and ranks components by the amount of change. The sort order is most-changed to least-
changed.

Features and Defaults

This report contains one table. The table provides data for onemetric only.

The table columns are:

l Grouping by levels; one to five columns, each displaying a level

l Performance for the previous time period
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l Performance for the current time period

l Growth, expressed as a percentage increase

l Change

The default filters for theMost Changed report defaults to:

l Grouping by Elements = Qualified Interface Name

l Start Date/Time = depends on default Time Range and data available in database

l Hour of Day (HOD) = All

l Day of Week (DOW) = All

l RankingMetric = Volume - Bytes (sum)

l Top N Option = Top 10

You can select multiple grouping attributes by using the (Add New Grouping) button. Use

the (Remove Grouping) button to remove a grouping attribute.

Use Case

Use this report to spot objects at selected grouping level that saw significant growth from the
previous selected time period to the selected time period. Significant growth could point to a
developing problem you need to know about. You can change the rankingmetric and you can
change how many elements are listed.

l To change the TimeControls defaults, see Change TimeControls in theUsing Reports >
Change Default Settings section.

l To change the Topology Filters defaults, see Set Topology Filters in theUsing Reports >
Change Default Settings section.

l To change the Report Options defaults, see Change Report Options in theUsing Reports >
Change Default Settings section.

Interface Health Overview Report
TheOverview Report displays the utilization and performance of themost commonly monitored
metrics in Interface Health extension pack.

Using this report, you can:

l Monitor the daily utilization and performance of a set of pre-definedmetrics.

l Identify the interfaces with unusual performance or utilization and drill down to other reports to
analyze the problem.

l Rank the interfaces based on their utilization levels.

l Identify themetrics that are close to the threshold. Use the following sections to identify such
interfaces:
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n 12Weeks Utilization In Forecasts

n 12Weeks Utilization Out Forecasts

The default display grain for this report is one hour. To select a different time grain or time range,
use the TimeControls tab in the navigation panel.

To change the TimeControls defaults, see Change TimeControls in theUsing Reports > Change
Default Settings section.

To change the topology filters, use the Topology Filters tab in the navigation panel.

To change the Topology Filters defaults, see Set Topology Filters in theUsing Reports > Change
Default Settings section.

You cannot select themetrics for this report.

Interface Health Peak Period Report
The Interface Health Peak Period Report ranks the utilization and performance of an interface
during the busiest time of the selected time range.

Using this report, you can:

l Identify the performance and utilization of the selectedmetrics during the peak period.

l Identify the interfaces that have the highest or lowest performances or utilization levels during
the peak period.

l Compare the performance for multiple interfaces during the peak period using this report.

Use Case

Use this report to:

l Identify a group of interfaces having a common network performance problem.

l Identify the interface that is suffering from a persistent performance problem.

Interface Health Peak Period Report Options

l Top / Bottom N1

l Metric

l Grouping by Time Period2

This report tracks up to six metrics over the selected time period.

To add another metric, click Options and then click

To remove ametric that you have already added, click Options and then click .

1Select a rank between top or bottom five, ten, 25, 50, 100, all descending, and all ascending for
the selected component.
2Enables you to group the report data based on a specific time grain. Click Add New Grouping
icon to add a new group.
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To select a range of value for themetric, click , click , and type a range of metric value that
the report should consider.

While specifying the range for a percentagemetric, make sure that the ranges are any of the
following formats:

l Decimal multiplier (for example, 1 to specify 100%, 0.5 to specify 50%, etc)

l Range with the% (Percentage) symbol (for example, 100%, 50%, etc)

For example if you want to see the top five interfaces for the node 15.2.103.112 with the average
utilization between 10% and 90% type the following ranges:

l 0.1 or 10% as Lowest Value

l 0.9 or 90% as theHighest Value

By default, the report groups data by Qualified Interface Name. You can select multiple grouping

attributes by using the (Add New Grouping) button. Use the (Remove Grouping) button
to remove a grouping attribute.

Tip:

l Use this report to identify the period when the interface utilization was the highest.

l Check this report once a day to see which interfacemay need special attention.

l Check this report periodically throughout the day to see which interface is performing at the
extremes andmay need special attention.

To change the TimeControls defaults, see Change TimeControls in theUsing Reports > Change
Default Settings section.

To change the Topology Filters defaults, see Set Topology Filters in theUsing Reports > Change
Default Settings section.

To change the Report Options defaults, see Change Report Options in theUsing Reports >
Change Default Settings section.

Interface Health Threshold Sleeve Report
This report analyzes how close themetric performance value is to the threshold levels. In other
words, this report enables you to analyze when themetric will reach the threshold.

Using this report, you can:

l Forecast over-utilization or under-utilization of the selected interface.

l Detect if themetric performance is about to cross the high and low thresholds.

For example, if you generate the Threshold Sleeve Chart report for Availability (avg), the chart
displays the how close the average interface availability is to the high and low threshold.

l Savemultiple Threshold Sleeve Reports for a specific metric for different time ranges, and
analyze themetric performance trend.

This report supports onemetric.
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l To change the TimeControls defaults, see Change TimeControls in theUsing Reports >
Change Default Settings section.

l To change the Topology Filters defaults, see Set Topology Filters in theUsing Reports >
Change Default Settings section.

l To change the Report Options defaults, see Change Report Options in theUsing Reports >
Change Default Settings section.

Interface Health Top N Report
This report ranks network elements by themetric that you select. Use this report to spot the
element that performed at the extremes. You can use this report to analyze the historical data for
elements that are exhibiting unusual utilization levels.

Using this report you can:

l Detect the network interface having a health or performance problem.

l Analyze the utilization of the NNMi managed network interfaces based on a specific time
range.

l Detect the over-utilized and under-utilized network interfaces in the network.

l Compare the performance of multiple network interfaces for a single node or multiple nodes
using this report.

Example

One of the routers in your network are performing poorly. Using this report, you can group the
router interfaces reporting highest average error rate. The interface reporting the highest average
error rate is ranked first.

Interface Health Top N Reports Options

The Top N report displays the following options:

l Top / Bottom N1

l Select Metric(s)2: The report ranks the selected interfaces based on the value of the first
metric listed in the Select Metric(s) field.

l Display Time Series Chart3

l Grouping By4

1Select a rank between top or bottom five, ten, 25, 50, 100, all descending, and all ascending for
the selected component.
2Select themetric based on which you want to generate the report. Themetric that you select is
used to rank the report data.
3elect Yes to view the detail chart with the table. Select No to hide the chart and display only the
table. The created Top N Report displays the graphical representation of themetric values for the
components over the selected time range.
4Organize the report data based on a specific parameter. Click Add New Grouping icon to add a
new group.
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This report tracks up to six metrics for eachmetric type over the selected time period.

To add another metric, click Options and then click .

To remove ametric that you have already added, click Options and then click .

To select a range of value for themetric, click , click , and select a range of metric value that
the report should consider.

While specifying the range for a percentagemetric, make sure that the ranges are any of the
following formats:

l Decimal multiplier (for example, 1 to specify 100%, 0.5 to specify 50%, etc)

l Range with the% (Percentage) symbol (for example, 100%, 50%, etc)

For example if you want to see the top five interfaces for the node 15.2.103.112 where the
average utilization between 10% and 90% type the following ranges:

l 0.1 or 10% as Lowest Value

l 0.9 or 90% as theHighest Value

By default, the report groups data by Qualified Interface Name. You can select multiple grouping

attributes by using the (Add New Grouping) button. Use the (Remove Grouping) button
to remove a grouping attribute.

The Time Series Chart report displays the selectedmetrics using two Y axis.

l The left Y axis (also known as the Y1 axis) displays the performance of themainmetric based
on which you want to generate the report.

l The right Y axis (also known as the Y2 axis) displays the performance of themetric that should
overlay themain (primary) metric.

Tip :

l By default, Top N Report does not display the Time Series Chart. To view the chart with the
detail table,perform any of the following steps:
n Select Options > Display Time Series Chart > Confirm Selection.

n Click Show Chart link below the detail table.

l Check this report once a day to see which network interfacemay need special attention.

l Check this report periodically throughout the day to see which network interfaces are
performing at the extremes andmay need special attention.

To change the TimeControls defaults, see Change TimeControls in theUsing Reports > Change
Default Settings section.

To change the Topology Filters defaults, see Set Topology Filters in theUsing Reports > Change
Default Settings section.

To change the Report Options defaults, see Change Report Options in theUsing Reports >
Change Default Settings section.
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Interface Health Top N Chart
Like the Top N report, this report also ranks the interfaces by themetric you select.

Using this report, you can:

l Spot the interface that performed at the extremes.

l Analyze the historical data for interfaces that are exhibiting unusual utilization levels.

l Detect the interface having a health or performance problem.

l Analyze the utilization of the NNMi managed interfaces based on a specific time range.

l Detect the over-utilized and under-utilized interfaces in the network.

l Detect the underlying reason of a persistent problem with a interface. You can compare the
performance for multiple interfaces using this report.

Interface Health Top N Chart Options

The Top N Chart displays the following options:

l Top / Bottom N1

l Metric

l Grouping By2

This report tracks up to six metrics over the selected time period.

To add another metric, click Options and then click .

To remove ametric that you have already added, click Options and then click .

To select a range of value for themetric, click , click , and select a range of metric value that
the report should consider.

While specifying the range for a percentagemetric, make sure that the ranges are any of the
following formats:

l Decimal multiplier (for example, 1 to specify 100%, 0.5 to specify 50%, etc)

l Range with the% (Percentage) symbol (for example, 100%, 50%, etc)

For example if you want to see the top five interfaces for the node 15.2.103.112 with the average
utilization between 10% and 90% type the following ranges:

l 0.1 or 10% as Lowest Value

l 0.9 or 90% as theHighest Value

1Select a rank between top or bottom five, ten, 25, 50, 100, all descending, and all ascending for
the selected component.
2Organize the report data based on a specific parameter. Click Add New Grouping icon to add a
new group.
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By default, the report groups data by Qualified Interface Name. You can select multiple grouping

attributes by using the (Add New Grouping) button. Use the (Remove Grouping) button
to remove a grouping attribute.

The Top N Chart report displays the selectedmetrics using two Y axis.

l The left Y axis (also known as the Y1 axis) displays the performance of themainmetric based
on which you want to generate the report.

l The right Y axis (also known as the Y2 axis) displays the performance of themetric that should
overlay themain (primary) metric.

Tip :

l Check this report once a day to see which interfacemay need special attention.

l Check this report periodically throughout the day to see which interfaces are performing at the
extremes andmay need special attention.

l To change the TimeControls defaults, see Change TimeControls in theUsing Reports >
Change Default Settings section.

l To change the Topology Filters defaults, see Set Topology Filters in theUsing Reports >
Change Default Settings section.

l To change the Report Options defaults, see Change Report Options in theUsing Reports >
Change Default Settings section.

iSPI for Performance Reportlets
In a large enterprise network theNNM iSPI Performance products1may produce a large
amount of data and large cardinality. This means that these networks often have a very large
amount of unique IP addresses, source nodes and destination nodes, interfaces, and components
each producing large amount of data. Generating reports using such large data volumemay be
time consuming.

Reportlets enable you to generate quick impressions of the larger reports using the iSPI for
Performance Dashboards.

Viewing iSPI for Performance Reportlets
To display the reportlets:

1. Log in to Network Performance Server (NPS) Home Page.

2. On the left navigation panel, select Dashboard Reportlets.

3. Select an extension pack and then select a reportlet.

You can also create custom dashboards using the reportlets. See Creating Custom Dashboards
Using BI Server Portal for information on the procedure to create the custom dashboards.

1NNM iSPI Performance for Metrics, NNM iSPI Performance for Quality Assurance, and NNM
iSPI Perforance for Traffic
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Baseline Metric Snapshot with Range
Displays the aggregatedmetric performance for the selected time range.

Enables you to:

l Build a performance history for the selected baselinemetric and analyze how themetric
performance changes over time.

Such history may help you to select an expected performance level for themetric

l Compare the performance for multiple metrics over a specified time range.

Though you can generate snapshot report for a single metric, you can save the snapshot report
for various metrics and compare the performance of eachmetric over a time range.

This reportlet supports onemetric.

To select a new metric for your reportlet, see Change Reportlet Options in theUsing Reports >
Change Default Settings section.

Baseline Sleeve Chart
Analyzes how close themetric performance value is to the threshold levels.

Enables you to:

l Detect if themetric performance is about to cross the high and low thresholds.

For example, if you generate the Baseline Sleeve Chart reportlet for Utilization (avg), the chart
displays how many exceptions are raised on average utilization in the past 24 hours,

l Savemultiple Sleeve Reports for a time range, and for analyze the trend of performance for the
metric.

This reportlet supports onemetric.

To select a new metric for your reportlet, see Change Reportlet Options in theUsing Reports >
Change Default Settings section.

Baseline Sparkline
Evaluates the trend of how the selected baselinemetric value has changed for the selected time
range.

Enables you to:

l Analyze the variations in the performance for the selectedmetric.

l Decide whether the expected behavior for the selectedmetric should be reassessed.

This reportlet supports onemetric.

To select a new metric for your reportlet, see Change Reportlet Options in theUsing Reports >
Change Default Settings section.
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Baseline Sparkline with Range
Evaluates the trend of how the selected baselinemetric value has changed for the selected time
range.

Enables you to:

l Evaluate the performance trend of the selectedmetric for the selected time range.

l Compare the present performance trend with the normal (expected) performance range.

l Measure the performance of past 24 hours in percentage.

This reportlet supports onemetric.

To select a new metric for your reportlet, see Change Reportlet Options in theUsing Reports >
Change Default Settings section.

Calendar
Displays a comparative study of the selectedPrimary Metric1 andSecondary Metric2

The default display grain is set to one hour. You cannot change the display grain of this reportlet.

Enables you tomonitor the following:

l Daily interface utilization

l Volume of data passed through the interface for past 24 hours

l Performance of the interface for past 24 hours

This reportlet supports twometrics.

To select a new metric for your reportlet, see Change Reportlet Options in theUsing Reports >
Change Default Settings section.

Gauge
Evaluates themetric for the selected point of time.

Select only themetrics that displays the percentage values.

Enables you to:

l Measure the daily performance of the selectedmetric.

l Detect any abnormal or unexpected performance level.

This reportlet supports onemetric.

When the NPS database has no data, the needle icon on the gauge does not appear.

1Enables you to select themainmetric based on which you want to generate the report. The
primary metric that you select is displayed on the left Y axis of the report.
2Enables you to select themetric that would overlay the primary metric. The secondary metric
that you select is displayed on the right Y axis of the report.
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To select a new metric for your reportlet, see Change Reportlet Options in theUsing Reports >
Change Default Settings section.

Heat Chart
Grades the performance of the selectedmetric for the selected time range.

Themetric performance is aggregated based on an hourly display grain.

Enables you to:

l View how the interface performance gets affected by a varyingmetric.

l Compare the hourly performance of the selectedmetric.

l Detect the time range when the interface performance was affected adversely because of the
fluctuatingmetric value.

This reportlet supports onemetric.

To select a new metric for your reportlet, see Change Reportlet Options in theUsing Reports >
Change Default Settings section.

Metric Snapshot
Displays themetric performance for the selected time range.

Enables you to:

l Build a performance history for the selectedmetric and analyze how themetric performance
changes over time.

Such history may help you to decide the baseline value for themetric

l Compare the performance for multiple metrics over a specified time range.

Though you can generate snapshot report for a single metric, you can save the snapshot report
for various metrics and compare the performance of eachmetric over a time range.

This reportlet supports onemetric.

To select a new metric for your reportlet, see Change Reportlet Options in theUsing Reports >
Change Default Settings section.

Most Changed
Compares themetric performance between the following:

l Selected time range

l Period preceding the selected time range

Aggregates themetric utilization and ranks the performance in a descending order.

Enables you to:

l Measure the performance fluctuations for the interfaces.

l Detect the top N interfaces having a common performance or utilization problem.

You can enhance the reportlet usability using the following features:

Page 46 of 51



PerfiSPI (8.13) Online Help: Interface Health
Interface Health Reports

l Top / Bottom N1

l Grouping By2

This reportlet supports onemetric.

To select a new metric for your reportlet, see Change Reportlet Option in theUsing Reports >
Change Default Settings section..

Multimetric Chart
Analyzes the performance trend for the selectedmetrics for the selected time range.

Enables you to:

l Perform comparative analysis of the selectedmetrics for each display grain.

The default display grain is one hour.

l Analyze the reason for any ups and downs in the interface performance.

l Detect any persistent problem in the interface performance.

This reportlet supports up to six metrics.

To select a new metric for your reportlet, see Change Reportlet Options in theUsing Reports >
Change Default Settings section.

Simple Bar and Line Chart
Displays the trend of interface performance for past 24 hours using the following values:

l Primary Metric3 on the bar chart

l Secondary Metric4 on the line chart

Enables you to:

l Compare the performance trends of multiple metrics.

l Analyze how the value of the secondary metric increases or decreases based on the increase
or decrease in the value of the primary metric.

This reportlet supports twometrics.

To select a new metric for your reportlet, see Change Reportlet Options in theUsing Reports >
Change Default Settings section.

1Select a rank between top or bottom five, ten, 25, 50, 100, all descending, and all ascending for
the selected component.
2Organize the report data based on a specific parameter. Click Add New Grouping icon to add a
new group.
3Enables you to select themainmetric based on which you want to generate the report. The
primary metric that you select is displayed on the left Y axis of the report.
4Enables you to select themetric that would overlay the primary metric. The secondary metric
that you select is displayed on the right Y axis of the report.
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Simple Bar Chart
Compares the performance of twometrics for the selected time range.

Enables you to:

l Compare the performance trends of multiple metrics.

l Analyze how the value of the secondary metric increases or decreases based on the increase
or decrease in the value of the primary metric.

This reportlet supports twometrics.

To select a new metric for your reportlet, see Change Reportlet Options in theUsing Reports >
Change Default Settings section.

Simple Chart
Analyzes the utilization trend for the selectedmetrics for the selected time range.

Enables you to:

l Perform comparative analysis of the selectedmetrics for each display grain.

The default display grain is one hour.

l Analyze the reason for any ups and downs in the interface performance.

l Detect any persistent problem in the interface performance.

This reportlet supports twometrics.

To select a new metric for your reportlet, see Change Reportlet Options in theUsing Reports >
Change Default Settings section.

Simple Table
Analyzes the utilization trend for the selectedmetrics for the selected time range.

The default display grain is one hour.

Enables you to:

l Analyze the hourly performance of themetrics.

l Detect any abnormal or unexpected interface performance.

l Analyze how the value of the secondary metric increases or decreases based on the increase
or decrease in the value of the primary metric.

This reportlet supports up to six metrics.

To select a new metric for your reportlet, see Change Reportlet Options in theUsing Reports >
Change Default Settings section.

Sparkline
Evaluates the trend of how the selectedmetric value has changed for the selected time range.

Enables you to:
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l Analyze the variations in the performance for the selectedmetric.

l Decide whether the expected behavior for the selectedmetric should be reassessed.

This reportlet supports onemetric.

To select a new metric for your reportlet, see Change Reportlet Options in theUsing Reports >
Change Default Settings section.

Threshold Sleeve Chart
Analyzes how close themetric performance value is to the threshold levels.

Enables you to:

l Detect if themetric performance is about to cross the high and low thresholds.

For example, if you generate the Exception Sleeve Chart reportlet for Utilization (avg), the
chart displays how many exceptions are raised on average utilization in the past 24 hours,

l Savemultiple Sleeve Reports for a time range, and for analyze the trend of performance for the
metric.

This reportlet supports onemetric.

To select a new metric for your reportlet, see Change Reportlet Options in theUsing Reports >
Change Default Settings section.

Top N Chart
Ranks the individual contribution of eachmetric for the interface performance for the selected
time range.

The performance of the interface is aggregated on hourly basis.

Enables you to:

l Spot the interfaces for which the performancemetrics present extreme values.

l Investigate the aggregated data for the interfaces that are exhibiting unusual utilization levels.

l Select themetric based on which you want to generate the report. Themetric that you select is
used to rank the interfaces.

l Group the report data based on a specific parameter. Click Add Group to add a subgroup.

This reportlet supports onemetric.

To select a new metric for your reportlet, see Change Reportlet Options in theUsing Reports >
Change Default Settings section.

Top N Line Chart
Ranks the utilization trend for the selectedmetrics for the selected time range.

The performance of the interface is aggregated on hourly basis.

Enables you to:
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l Spot the interfaces for which the performancemetrics present extreme values.

l Investigate the aggregated data for the interfaces that are exhibiting unusual utilization levels.

l Select themetric based on which you want to generate the report. Themetric that you select is
used to rank the interfaces.

l Group the report data based on a specific parameter. Click Add Group to add a subgroup.

This reportlet supports onemetric.

To select a new metric for your reportlet, see Change Reportlet Options in theUsing Reports >
Change Default Settings section.

Top N Stacked Chart
Ranks the individual contribution of each interface based on the selectedmetrics.

The performance of each interface is aggregated for the default display grain of one hour.

Enables you to:

l Spot the interfaces for which the performancemetrics present extreme values.

l Investigate the aggregated data for the interfaces that are exhibiting unusual utilization levels.

l Detect the network path having a comm on network performance problem.

This reportlet supports up to six metrics.

To select a new metric for your reportlet, see Change Reportlet Options in theUsing Reports >
Change Default Settings section.

Top N Table
Ranks the interfaces based on the selectedmetric.

Enables you to:

l Spot the interfaces for which the performancemetrics present extreme values.

l Investigate the aggregated data for the interfaces that are exhibiting unusual utilization levels.

l Select themetric based on which you want to generate the report. Themetric that you select is
used to rank the interfaces.

l Group the report data based on a specific parameter. Click Add Group to add a subgroup.

This reportlet supports up to six metrics.

To select a new metric for your reportlet, see Change Reportlet Options in theUsing Reports >
Change Default Settings section.

Top N Table With Bars
Ranks the interfaces based on the selectedmetric and displays a horizontal bar to depict the
aggregatedmetric value.

Enables you to:
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l Spot the interfaces for which the performancemetrics present extreme values.

l Investigate the aggregated data for the interfaces that are exhibiting unusual utilization levels.

l Select themetric based on which you want to generate the report. Themetric that you select is
used to rank the interfaces.

l Group the report data based on a specific parameter. Click Add Group to add a subgroup.

This reportlet supports up to six metrics.

To select a new metric for your reportlet, see Change Reportlet Options in theUsing Reports >
Change Default Settings section.
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Path Health Overview
Path Health displays icons representing the nodes and interfaces in a path. A vertical chain of
nodes and interfaces represents the path from onemanaged element to another. Each step along
the path (node or interface) shows a series of small pie charts and trend lines depicting activity and
performance for that element over the previous six hours.

Path Health helps you analyze the following:

l Ratio of exceptions per metric over the last hour (one pie chart per metric)

l Metric values over the last six hours (one graph per metric)

Use them to view whether the values are:

l static

l rising steadily

l falling steadily

l fluctuating

1. From one of the NNMi inventory views, select two elements.

2. Select Action-->Path View from the NNMi console to view the Path View page.

Note: The only way to launch Path Health is from a Path View in NNMi.

2. From the Path View, select Actions-->Reporting - Path Health

ThePath View page opens with the following segment menus:

l Source Node: The first element of the selected path

l Destination Node: The last element of the selected path

3. Select Actions-->Reporting - Path Health to create the Path Health report.

If the Path View is showingmultiple paths between hops, NNMi will ask you to select a specific
path. Tomake the choice, click the appropriate connecting line within NNMi. The colors on the
screen will change when youmake the selection. The Path Health option under Actions does not
function until your selections are complete.

Launch Path Health Reports for Nodes with Multiple paths
NNMi consolemay often present more than one path between your source and destination nodes.
When you request the Path Health report using theActions > Reporting - Path Healthmenu, the
left-most icon on the path changes color if multiple paths exist between the source and destination
nodes. To launch a Path Health report, select a particular path by clicking every visible node on the
path, and then click Actions > Reporting - Path Health.

Features and Defaults

The Path Health report pulls data from the following extension packs:
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l Component Health

l Interface Health

From the Component Health collections, Path Health generates the following statistics for a node in
a path:

l CPU exceptions last hour / CPU utilization last six hours

l Memory exceptions last hour / Memory utilization last six hours

l Buffer exceptions last hour / Buffer utilization last six hours

From the Interface Health collections, Path Health generates the following statistics for an interface
in a path:

l Utilization exceptions last hour / Utilization over the last six hours

l Discard exceptions last hour / Number of discards per poll over the last six hours

l Error exceptions last hour / Number of errors per poll last six hours

The Path Health report pulls data from two Tables:

l Component Health Live Table

l Interface Health Live Table

Use Case

Use Path Health to monitor the fault conditions that are showing up in a Path View. The
performance data in Path Health can help you determine what is causing the fault condition you are
seeing in the Path View.

If a node, or interface, or component, in the Path Health report is showing exceptions, you can
easily findmore information about those by clicking the links for node, interface, or component.

For example, if a node is showing CPU exceptions, you could open Report Menu, select a
appropriate report, and then drill down on the node until you identify the specific component that is
reporting problems.

Related Topics

Path Health Report

Path Health Report
Path Health displays icons representing the nodes and interfaces in a path. A vertical chain of
nodes and interfaces represents the path from onemanaged element to another. Each step along
the path (node or interface) shows a series of small pie charts and trend lines depicting activity and
performance for that element over the previous six hours.

Path Health helps you analyze the following:

l Ratio of exceptions per metric over the last hour (one pie chart per metric)

l Metric values over the last six hours (one graph per metric)

The selected Path View displays as shown below.
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The pie chart enables you to view the comparison between the number of polls which are below or
above the set threshold. The data shown in the pie chart represents the samples collected within
the last hour.

The line graphs track sampled data over the previous six hours.

Unknown Items

Unknown icons (icons associated with the ? icon) appear in the Path Health report for a device or
interface that is not being polled for the required data. The Path Health report presents Component
Health data for each node and Interface Health data for each interface. It is possible that a node can
support the Interface Health collections (MIB-II), but not the Component Health collections. For this
reason, the report may display data regarding the inbound and outbound interfaces on a node but not
about the node itself.

Related Topics

Path Health Overview

HP Network NodeManager iSPI Performance for Metrics Software (9.10)Page 3 of 12

NNM iSPI Performance for Metrics
Path Health Overview



HP Network NodeManager iSPI Performance for Metrics Software (9.10)Page 4 of 12

NNM iSPI Performance for Metrics
Path Health Overview



Overview of Custom Poller Configuration
Available only with the NNM iSPI Performance for Metrics.

After the 30-day evaluation period, you can view reports based on Custom Poller collections only if
you obtain a license for the NNM iSPI Performance for Metrics.

NNMi's Custom Polling feature enables the NNMi administrator to take a proactive approach to
network management by gathering additional device information using SNMP MIB variables.

For example, an NNMi administrator might want NNMi tomonitor the Status of COM
(communication) ports on all of yourWindows servers.

Using Custom Poller, the NNMi administrator can also configure NNMi to do the following:

l Send incidents when certain MIB values are detected

l Map returnedMIB values to States and include these States as part of node Status calculations.

The NNMi Custom Poller feature enables network operators to:

l View the list of topology nodes for which additional information is being polled as well as the
name of the associated Policy.

l View the polling results. The first time the results for a specifiedMIB variable are discovered, the
results appear in a Polled Instance object. The Polled Instance object is updated whenever a
change in State is detected and includes themost current polled value that caused the State to
change.

l View incidents that are generated by Custom Poller for aMIB Poll Variable.

You can use the data collected by Custom Poller collections to construct and view reports if you
use the NNM iSPI Performance for Metrics.

Overview of Custom Poller Collections and Their Associated Policies
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Note: SeeNNMi online help for more information on Custom Poller.

Reports for Custom Poller Collections
If you use the Custom Poller feature of NNMi, you can configure the NNM iSPI Performance to
create reports based on the data collected by NNMi's Custom Poller. The Report Groups tab in the
Custom Poller Configuration form enables you to generate reports from themetrics obtained from
Custom Poller collections.

The NNM iSPI Performance creates new extension packs to display reports generated from the
data collected by Custom Poller collections.

Mechanism of Creating Additional Extension Packs

When you add a report group to the Report Groups tab, NNMi creates an extension pack for each
SNMP MIB table referenced in the Custom Poller collection. On the NPS HomePage, the
extension pack reflects the name of the SNMP MIB table. Multiple Custom Poller collections are
combined into a single extension pack if the collections useOIDs from the sameMIB table.

Create Extension Packs for Custom Poller Collections
To create an extension pack for a Custom Poller Collection, youmust create a report group for a
Custom Poller Collection from the NNMi console.

Prerequisite:Youmust log on to the NNMi console with the administrative privilege.

Task 1: Create a Custom Poller Collection
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Create a Custom Poller Collection in the Custom Poller Configuration form by following the
instructions inNNMi Help for Administrators.

Task 2: Create a Custom Poller policy

Create a Custom Poller policy in the Custom Poller Configuration form by following the instructions
inNNMi Help for Administrators.

Task 3: Create an extension pack for a Custom Poller Collection

1. Navigate to the Custom Poller Configuration form.

a. From the workspaces navigation pane, select the Configuration workspace.

b. Select Custom Poller Configuration.

2. In the Custom Poller Configuration form, go to the Report Groups tab.

3. Click New. The Report Group form opens.

4. In the Report Group form, specify a name for the extension pack in the Basics section. Do not
use spaces in the name.

5. In the Report Collections tab, click New. The Report Collections form opens.

6. To add a Custom Poller Collection to the report group, click (the Lookup icon):
n To specify a Custom Poller Collection, click Quick Find.

n To create a new Custom Poller Collection, click New.

7. Set the Report Data Type to one of the following values:
n Gauge:Represents single non-cumulative values. Examples of Gauge data types include

Response Time, Bit Rate, and Temperature. During aggregation, the NNM iSPI
Performance for Metrics calculates theminimum, maximum, and average values of gauge
metrics.

n Percent:Represents single non-cumulative values that are formatted with a percent sign
(%) and two decimal places. Examples of Percent data types include Utilization and
Discard Rate. During aggregation, the NNM iSPI Performance for Metrics calculates the
minimum, maximum, and average values of percent metrics.

n Counter:Represents incremental values. Examples of Counter data types include byte
counts, packet counts, and flow counts.

8. In the Report Collections form, click Save and Close.

9. In the Report Group form, click Save and Close. The NNM iSPI Performance for Metrics
creates a new extension pack and adds a new tab on the Report Menu page.

Guidelines to Create Custom Poller Extension Pack

l You can associate a Custom Poller Collection to only one report group.

l If you associate more than one Custom Poller Collection with the sameReport Group, make
sure the combination of Collections generates ameaningful report. As a general guideline, select
Collections whoseMIB Variables represent the same index value across Custom Poller
Collections.
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l Avoid using keyboard symbols while naming the Custom Poller collection and customPoll OID.
If you still use the following symbols <,>,”,’,&,\, they are replaced by a ! character in the
report.

l Reports are not created if the # symbol is used in a customPoll name.

Remove Custom Poller Extension Packs
If you want, you can remove the extension packs. The NNM iSPI Performance provides you with
command line tools to remove Custom Poller extension packs.

To remove Custom Poller extension packs:

1. Log on with the administrative or root privileges to the system where the NNM iSPI
Performance is installed.

2. Go to the following directory:
n OnWindows: %NPSInstallDir%\NNMPerformanceSPI\bin

n OnUNIX or Linux: /opt/OV/NNMPerformanceSPI/bin

3. Run the following command to view the list of extension packs:
uninstallExtensionPack.ovpl

4. Run the following command:
uninstallExtensionPack.ovpl -p <extension_pack_name>

Note:You cannot recover the data associated with an extension pack if you inadvertently delete it.
Make sure to type the correct extension pack namewith the command. Do not delete the
following default NNM iSPI Performance for Metrics extension packs unless you want to
remove iSPI Performance for Metrics reports: Interface_Health, Component_
Health. If you delete the PerfSPI_Diagnostics.extension pack, you will not be able
tomonitor the health of the NPS processes.

Custom Poller Report Controls
You can use the standard report control links to access Time Controls, Topology Filter, Report
Options andAdjust Time Range filters. You can search using any of the available attributes and
set filters to create a report based on themodification.

Time Control

On the navigation panel of NPS Home Page, click the TimeControl tab to change the default time
filters for a report.

Filter Usage

Click the drop-down calendar box and select the appropriate date.

By default, the date is automatically set to the current date when you select the Time
Range.

Time Control Filters
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Filter Usage

To set the timemanually, select the Hour/Minutes/Meridian options separately, and
then select the value by clicking the arrow.

By default, the time is automatically set to the current time when you select the Time
Range.

Time
Range

Click the drop-downmenu to display the list of time ranges, and then select the
appropriate time.

If you select a time range that is beyond theStart Date and Time, the following
message appears:

Your start date/time is out of range. It will be adjusted.

Click OK to adjust accordingly.

Auto
Refresh

Click the drop-downmenu, and then select the desired time to recreate the reports
based on the set interval.

By default, the Auto refresh is OFF.

The Auto Refresh option appears on the TimeControls page only after the first report
is generated.

Topology Filters

On the navigation panel of NPS Home Page, click the Topology Filters tab to launch the Topology
Selector.

The Topology Filter enables you to quickly find or select an element from the topology table using
selectionmechanisms appropriate for the attribute type.

Attribute
Parameter

Node
Group
Name

Contains the list of the available Node groups in the network.

Node
Name

Contains the list of the available Node name in the network.

Node
Contact

Contains the list of the available Node Contact in the network.

Node
Location

Contains the list of the available Node Location in the network

Node
Family

Contains the list of the available Node Families in the network.

Attributes and Related Parameters Available for the Topology Filters
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Attribute
Parameter

Node
Vendor

Contains the list of the available Vendors in the network.

Node ID Contains the list of the available Nodes ID in the network.

Node
UUID

Contains the list of the available Node UUID in the network.

Index Contains the list of the available Index in the network. This field contains the SNMP
index OID values that identify specific MIB table instances polled by Custom Poller
policies; if you want, you can use these SNMP index OID values to filter Custom
Poller reports to show only specific instances from theMIB table (use in conjunction
with the NodeName filter).

Report Options

On the report, click on theOptions link to access the Report Options panel.

Report options provide a list of primary and secondary metrics for the selected Custom Poller
extension pack.

Note: Themetrics drop-down list differs according to the selected extension pack.
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Modifying Topology Attribute Values and Group
Memberships from NNMi

The topology attributes and groups help you filter the data and build the report with the data polled
from nodes and interfaces of your interest. The NPS retrieves the topology attribute details from
NNMi and other iSPIs. If youmakemodifications to topology attributes and groupmemberships
from NNMi, the changes are reflected in the NPS within about an hour.

Changes are not applied retroactively to the existing data. Changes are always forward-looking; the
NPS preserves the historical accuracy of the data ‘as it was’ when it was collected.

For example:

l If a new node is added to a group, it is only added for the new data collected going forward. The
NPS cannot assume that the node was amember of the group in the past.

l If an interface attribute changes—for example, ifSpeed is changed from old to new value, it is
only applied going forward. The NPS does not assume that the new speed applies to the
historical data.

If you delete or change amember of a topology attribute, the oldmember continues to appear in the
list of topology filters in NPS. The old attributemember continues to appear in the list of topology
filters. If you select the oldmember, the data that was collected beforemaking the change gets
sampled in the report.

Example

If youmodify the node group name A to B in the NNMi console, the new node name gets reflected in
NPS after at least an hour. Later on, the old node group name continues to appear in the list of Node
Groups in the Topology Filters section. However, when you select A, you cannot retrieved data
samples associated with A that are polled after changing the NodeGroup name to B.

For example, youmight have an interface group called “Oracle Server Ports” identifying switch
interfaces assigned to your Oracle Server cluster, but now you have a new server cluster available
online, and you want to transfer your Oracle applications to the new one, and re-purpose the old
servers to host theMicrosoft Exchange Server.

Therefore, you rename “Oracle Server Ports” to “Exchange Server ports” and create a new interface
group for “Oracle Server Ports” identifying the ports associated with the new servers. If you want to
run a report at the end of themonth to see the health of your “Oracle Server Ports” and your new
“Exchange Server Ports” over themonth, the NPS will define “Oracle Server ports" group to include
the data collected for the original ports up until the point youmade the change, and for the new ports
after that point.

Similarly, the NPS will define the “Exchange Server ports” group to only include the ports from the
point the group was renamed—it does not include the ports while they were still being used for
Oracle.
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Glossary

E

extension pack

Extension packs provide rules and
definitions to generate reports from the
data gathered from different sources. The
default, ready-to-use extension pack
available with the NPS—the Self
Diagnostics extension pack—helps you
view reports indicating the health and
performance of different components and
processes of the NPS.
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